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Safety and approval information

This Rosemount product complies with all applicable European directives when properly installed in accordance with the
instructions in this manual. Refer to the EU declaration of conformity for directives that apply to this product. The EU declaration
of conformity, with all applicable European directives, and the complete ATEX Installation Drawings and Instructions are available
on the internet at www.emerson.com or through your local Emerson support center.

Information affixed to equipment that complies with the Pressure Equipment Directive, can be found on the internet at http://
www.emerson.com.

For hazardous installations in Europe, refer to standard EN 60079-14 if national standards do not apply.

Other information

Full product specifications can be found in the product data sheet. Troubleshooting information can be found in the user manual.
Product data sheets and manuals are available from the Emerson website at http://www.emerson.com.

Return policy

Follow Emerson procedures when returning equipment. These procedures ensure legal compliance with government
transportation agencies and help provide a safe working environment for Emerson employees. Emerson will not accept your
returned equipment if you fail to follow Emerson procedures. Return procedures and forms are available on our web support site
at Emerson.com, or by phoning the Emerson Customer Service department.

Emerson Flow customer service

Email:

• Worldwide: http://flow.support@emerson.com

• Asia-Pacific: http://APflow.support@emerson.com

Telephone:

North and South America Europe and Middle East Asia Pacific

United States 800 522 6277 U.K. 0870 240 1978 Australia 800 158 727

Canada +1 303 527 5200 The Netherlands +31 (0) 704 136 666 New Zealand 099 128 804

Mexico +41 (0) 41 7686 111 France 0800 917 901 India 800 440 1468

Argentina +54 11 4837 7000 Germany 0800 182 5347 Pakistan 888 550 2682

Brazil +55 15 3413 8000 Italy 8008 77334 China +86 21 2892 9000

Central & Eastern +41 (0) 41 7686 111 Japan +81 3 5769 6803

Russia/CIS +7 495 981 9811 South Korea +82 2 3438 4600

Egypt 0800 000 0015 Singapore +65 6 777 8211

Oman 800 70101 Thailand 001 800 441 6426

Qatar 431 0044 Malaysia 800 814 008

Kuwait 663 299 01

South Africa 800 991 390

Saudi Arabia 800 844 9564

UAE 800 0444 0684
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1 Startup

1.1 Checklist
During meter startup, have the following equipment and information on hand:

Meter startup checklist

Site pipe and ID drawings with elevations

Site wiring diagrams

Rosemount Gas Ultrasonic Meter calibration data

Rosemount Gas Ultrasonic Meter manuals

Information and manuals for all other flow instrumentation - flow computers, pressure
and temperature transmitter data sheets, and wiring

Shutoff and control valve information, specifications, operation and setup data.

Ethernet (Cat 5 cables) or serial cables to link the laptop to the meter

Field service representative's telephone numbers for major components; valves, meter,
flow computer, communication gear, transmitters, site designers or integrators.

Check all ultrasonic meter wiring.

Check the settings of any bit switches on transmitter I/O cards.

Start MeterLink™

Establish flow in the meter (at lease 3 feet per second to ensure good thermal mixing)

Save the meter configuration file - your "As Found" record of the meter. In MeterLink™

select Tools → Edit/Compare Configuration.

Click the Read button and select File Save.

Open File → Program Settings and customize MeterLink™ user preferences.

Open Meter → Monitor and check the measurement paths or chords and that they agree
with each other to approximately 0.2%.

Check for alarms, open Meter → Monitor and click Check Status.

Check for good signal strength (usually shown as "SNR") or, Signal to Noise Ratio.

Check for reasonably correct flow profile

From the Logs/Reports menu, click Maintenance Logs/Reports, collect and save a
Maintenance Log to record the initial performance of your meter (this is your "as Found"
record).

From the Meter → Field Setup Wizard menu. Make any configuration adjustments, such
as setting the frequency output variable and frequency full scale.

Save another Maintenance Log (this is your "As Left" record).
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1.2 Cybersecurity and network communications
The 3410 electronics TCP/IP communications should be configured to mitigate
cybersecurity risks as follows:

1. MeterLink uses either FTP or HTTP protocols for Archive and Smart Meter
Verification log collection. It is recommended to disable the FTP protocol and leave
the HTTP protocol enabled. Both can be disabled for additional security, but log
collection will not be possible in this configuration.

2. Telnet port should be left disabled. This port is not required for any
communications to field devices or MeterLink.

3. Enabling the physical Write Protect switch will prevent metrology configuration
changes and firmware upgrades. It will also prevent enabling TCP/IP protocols such
as FTP, HTTP, and Telnet.

This transmitter:

1. Is not intended to be directly connected to an enterprise or to an internet facing-
network without a compensating control in place.

2. Should be installed following industry best practices for cybersecurity.
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2 Communications

2.1 Setup meter communications
After the installation of your Rosemount Ultrasonic Meter, install MeterLink™ on your PC or
laptop as described in the MeterLink Software for Gas and Liquid Ultrasonic Flow Meters Quick
Start Manual (00809-0100-7630) for your operating system ( Windows® 7 or Windows® 8,
Windows® 10), then configure the meter.

The MeterLink Software for Gas and Liquid Ultrasonic Flow Meters Quick Start Manual
(00809-0100-7630) is made available with the meter.

The MeterLink installation program is available for download from the Emerson website:
emerson.com/en-us/catalog/meterlink.

2.1.1 MeterLink utilities
MeterLink™ provides the following utilities to configure the meter's flow measurement
units, meter output parameters, communications settings, output tests and logs and
reports file management.

Field Setup Wizard

• Startup

• General

• Frequency/Digital Output Sources

• Frequency Outputs

• Meter Digital Outputs

• Analog Outputs

• HART® Outputs

• Meter Corrections

• Temperature and Pressure

• Gas Chromatograph Setup

• Gas Chromatograph Component Data

• AGA8

• Continuous Flow Analysis

• Alarm Limits

• Local Display

Tools

• Edit/Compare Configuration

• Waveform Viewer
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• SOS Calculator

• Outputs Test

• Transducer Swap-Out

• Transducer Type

• Velocity Estimation

• Locate Meter

• Baseline Wizard

• Program Download

• Warm Start Meter

• Communications Analyzer

Log/Reports

• Maintenance Logs and Reports

• Trend Maintenance Logs

• Meter Archive Logs

• Smart Meter Verification

• Create PDF from XML SMV Report

• Compare Excel® Meter Configurations

Calibration

• Analog Inputs Wizard

• Meter Factors

• Flow Calibration

• Zero Calibration

Setup the meter directory
Setup the connection properties for your meter. By default, the meter directory contains
only one record named New Meter, that is defaulted to connect to a Rosemount Gas
Ultrasonic meter configured as shipped from the factory.

Create a new meter record

Procedure

1. Select Insert, Insert Duplicate, or Add from the File pull-down menu to create a
new record.

2. Setup the record by entering a Meter Name, Short Desc, Meter Type, and select the
connection type(s) checkboxes Direct, Ethernet and Ethernet 2.

3. For each connection type selected, a button will be enabled at the bottom of the
dialog with the same name. Click these buttons to edit the connection properties
for that connection method. After choosing the connection properties, click OK
accept the changes or click Cancel to discard any changes and close the dialog.
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a) Direct connection - to connect to the meter directly through one of the serial
ports on the meter using one of the serial ports on your computer. Click
Direct to set the following parameters.

• Protocol: TCP/IP is a read-only field and is the only protocol MeterLink
uses.

Note
Rosemount Ultrasonic meters still support Modbus ASCII and Modbus
RTU when talking to other applications or devices.

• Comms Address: Enter the communication address that is configured in
the meter hardware. The default address for meters from the factory is
32. For Rosemount Ultrasonic meters the valid range is from 1 to 247.

• Port: Select the available driver from the list of those installed on your
machine.

Note
If using Windows® 7, you cannot use the Communications cable between
two computers at this time and must use the Rosemount Direct
Connection driver.

• Baud Rate: Select the serial port baud rate from the drop-down list for
which the meter hardware is configured. The default Baud Rates is 19200.

b) Ethernet connection - Set the following properties to configure the
Rosemount ultrasonic meter hardware for Ethernet connectivity.

NOTICE

It is strongly recommended that the meter be configured using an
independent (off- network) single host computer. After configuration of the
meter, the DHCP option should be disabled.

• IP Address: Enter the IP Address for the meter's Ethernet port.
The factory set IP Address is 172.16.17.200 for Rosemount Gas Ultrasonic
meters or you can use 192.168.135.100 if DHCP is enabled in the meter
(see DHCP below for more details).
Dynamic Host Configuration Protocol (DHCP): Business PCs are usually
configured to work in a network environment where a DHCP server
assigns an IP address to each computer when they connect to the
network.
If a PC is configured to obtain an IP address from a DHCP server and it is
going to connect through the Ethernet Cable (1-360-01-596) to a
Rosemount meter that is not connected to a network, then the DHCP
server in the meter must be enabled so it can assign an IP address to the
PC when it connects.
The DHCP server can be enabled on the meter by setting the DHCP switch
on the CPU module to the ON position.
When connecting to a meter with DHCP enabled, use the IP address of
192.168.135.100 to connect to the meter. In this mode you can create
just one Meter Directory record with this IP address to connect to all your
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meters with DHCP enabled. When the connection is made, select to use
the Meter Name in the meter instead of the Meter Directory Name in
order to keep all log files and configurations separate from each meter.
Click OK to accept the changes or click Cancel to discard any changes and
return to the Meter Directory dialog box.

Meter groups

This dialog, available from the Meter Directory dialog, allows you to manage meter groups
for filtering the list of meters in the Connect to Meter dialog, exporting to other
MeterLink™ users and for filtering the list of meters in MeterLink™ Net Monitor’s main
window. There is a predefined meter group for “All meters,” otherwise meters can be
grouped together in any way that is useful to you, e.g. meters for geographic regions, or
meters that require daily monitoring.

User-defined meter groups can be added, edited and deleted in the dialog. The left side
displays a list of meter groups. The right side displays all available meters (meter directory
records) in the currently selected group and allows meters to be added to or removed
from the currently selected group using a checkbox next to each meter.

Ethernet initial connection steps

Procedure

1. Power up the meter.

2. Shutdown the PC.

3. Plug the Ethernet adapter cable Phoenix end into the meter Field Connection Board
connector J8 and connect the RJ-45 end into the PC Ethernet connector.

4. Enable the Ethernet LAN connector DHCP server on the CPU Module by moving the
DHCP (switch-1) to the ON position (see direction arrow on the CPU Module label).

5. Power up (boot) the PC and log in to the initial Windows logon prompt.

6. Verify the Ethernet connection status by the CPU Module “LINK” LED which should
be on solid green.

7. Launch MeterLink and create a new meter record.

Import a meter record

Procedure

1. Select File → Import from the Meter Directory drop-down menu or click Import.

2. The Import Meter Directory File dialog which allows you to select a meter
directory .DAT file to import the file into the currently used meter directory file.

If an identical meter record already exists and a duplicate is trying to be imported,
MeterLink inserts the duplicate meter record. The Import button performs the
same operation.

Export a meter record

Use the Export command to save the current meter directory to file. Select File → Meter
Directory from the Meter Directory drop-down menu or click Export.
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Procedure

1. Enable the meter directory record checkbox you want to export or click Select All.

2. Click OK to begin exporting the meter record(s). Use the Export Meter Directory File
dialog to save the exported record to the default folder (C:\Ultrasonic Data) or enter
another location.

3. Click Save. If you have an existing METER_DIRECTORY_EXPORT.DAT file, you are
prompted to change the file name or replace the file. If changing the file name,
keep the .DAT extension to maintain functionality when importing the file to the
new machine.

4. Copy the exported file to the new machine.

5. Use the Import command to select this file and import it into the Meter directory.

Important
Due to limitations in the Microsoft® Dial-Up Networking, not all of the directory
information for Direct and Modem connection can be exported to the
METER_DIRECTORY.DAT file for Rosemount Ultrasonic meters. It will be able to
export the meter names, Comms Address, Interface, and Telephone numbers. It will
still be necessary to recheck the connection properties and verify the
communication parameters such as COM port, data bits, and parity are configured
correctly.

Connect to the meter

Procedure

1. From the menu bar, select Meter → Connect or click , the Connect icon, on the
toolbar.

2. The Connect to Meter dialog box displays a list of meters setup in MeterLink. Click
Direct, Ethernet next to the Meter Name to establish a connection with your
Rosemount Ultrasonic meter.

Collect “As Found” logs and reports
Use the MeterLink Logs/Reports menu and collect and save the logs and reports for a
historical record of the meter at several velocities within the operating range of the meter.
This will establish a baseline to be used for the trending of the meter diagnostics. Save the
following logs and reports for the "As Found" settings (factory default).

• Maintenance log

• System log

• Save your meter's configuration file

• Use the Tools → Edit/Compare Configuration menu to display the dialog. Enable the
View All or Metrology radio button and click Read.
The All View displays the meter's extended configuration parameters. Grayed out
values are read-only, but help describe the configuration. The Metrology View displays
the path dimensions, pipe diameter, transducer delay parameters, zero flow calibration
coefficients, and flow calibration coefficients.
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— Click the question mark icon, , for the data point to display additional information.

• Click Save to save the configuration file. By default, the file is saved to the Data Folder
setup in File → Program Settings.

Customize MeterLink settings
Open MeterLink and access File → Program Settings, then input the desired settings for
your meter. Your user name and company name is included on reports and logs generated
with MeterLink.

Figure 2-1: Program Settings

• User name

• Company name

• Data folder (where meter's data is stored)

• Select the checkbox to create a subfolder with the meter's name under Data folder for
saving and opening files for your meter

• Display units (of measurement); U.S. Customary or Metric for necessary unit
conversions read by the meter

• Meter volume units; gal, cubic feet, or bbl
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• Prompt to save meter config (configuration) prompts you to save a copy of the meter
configuration after writing changes to the meter

• Run Connect dialog automatically after connecting

• Run Meter Monitor automatically after connecting

• Run Meter Monitor summary or detailed view after connecting

• Use FTP passive mode (client - server port communications)

• Allow backup upgrade mode connection - used to download firmware to Rosemount
Ultrasonic meters

• Tab from spreadsheet to next control instead of next cell

• TCP/IP meter connection database timeout - amount of time MeterLink waits to
respond to a request for data from the meter database (default 13 seconds)

• Override system default printer - used to change printer

• Product type preference - meter type you will most often connect, gas or liquid

HTTP file transfer

• Use HTTP for file transfer if available in the meter.
— A checkbox is enabled when selected.

— MeterLink uses HTTP protocol for file transfer with meter if it is supported by
firmware.

— Rosemount 3410 Series Firmware v1.50 and later supports HTTP protocol for file
transfer for Program Download, Collect Archive Logs, Collect XML SMV Report and
cache database configuration XML file when connecting to meter for the first time.

— Alternatively, Rosemount 3410 Series Firmware also supports FTP protocol for file
transfer for Program Download, Collect Archive Logs, Collect XML SMV Report and
cache database configuration XML file when connecting to meter for the first time.

2.1.2 Setup Modbus communications
Rosemount 3410 Gas Ultrasonic Flow Meters support RS-232 or RS-485 4-wire or 2-wire
half duplex serial interface to an external system (e.g., flow computer) using Modbus ACSII
protocol with the following parameters:

Setting Value

Baud rate 19200

Data bits 7

Stop bits 1

Parity even

Protocol Modbus ACSII

Refer to your flow computer user manual to set I/O settings required to allow serial
communication with the Rosemount 3410 Gas Ultrasonic Flow Meters.

Operations Manual Communications
00809-1100-3104 April 2022

Rosemount 3410 Series Gas Ultrasonics Flow Meters 13



The Rosemount 3410 Gas Ultrasonic Flow Meters supports ASCII and RTU Modbus
communication. For ASCII Modbus, both 7E1 and 7O1 are supported. For RTU Modbus,
8N1 is supported. The communication ports provide automatic protocol detection - only
the baud rate and Modbus ID need to be specified. Also, refer to the Rosemount website
and select the Product page for the model of your meter:

emerson.com/en-us/automation/emerson

2.1.3 Setup HART® communications
Rosemount Ultrasonic Flow Meters are HART-capable devices utilizing the 4-20mA signal
Analog Output 1 on the CPU Module, in which the digital signal is sent from the field
device (Rosemount Ultrasonic Flow Meter) to the host (PC running AMS™ Device Manager
or a Field Communicator). An external 24V power supply is required for the analog signal
from the CPU Module.

The HART Device Description application provides dynamic variables, device-specific
commands, universal commands and common practice commands in accordance with
the HART Communication Foundation. The Device Description defines the
communication details from the device to the host (e.g. menus for the Field
Communicator, graphical displays for AMS Device Manager and the device parameters -
process variables, pressure, temperature, diagnostics and three status alert groups -
Failed, Maintenance and Advisory). Refer to the Rosemount 3410 Series Gas Ultrasonic
Meters HART Field Device Specification, (00825-0400-3240) for details.

Also see, the HART Communications Foundation, AMS Device Manager and 475/375 Field
Communicator websites:

• https://www.emerson.com/en-us/catalog/asset-reliability/ams-ams-device-manager

• https://www.emerson.com/documents/automation/user-s-manual-en-104978.pdf

2.1.4 Setup the meter in a DeltaV System
Rosemount 3410 Series Ultrasonic Flow Meters are compatible with DeltaV System
communications. The following are optional communications configurations of
Rosemount Ultrasonic Flow Meters:

• Serial connection for RS-232 or RS-485

• Ethernet

• HART®

• Modbus TCP/IP (requires a VIM card)

Refer to the Install Your Digital Automation System manual for field wiring terminations, I/O
interface, power, and DeltaV control Network.

1. Access the DeltaV website hyperlink shown below.

2. Click Books Online under Quick Links.

3. Setup your user account and access the manual.

https://www.emerson.com/en-us/automation/deltav
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3 Optional feature keys

3.1 General overview of the Optional feature keys
Rosemount 3410 Series Gas Ultrasonic Flow Meters offer many industry-leading features
including Chapter 21-compliant data log access, gas chromatograph (GC) interface,
AGA10 sound velocity calculation (with comparison to measured sound velocity) and
Continuous Flow Analysis diagnostics.

With Mark XX v1.50 Firmware or later, features keys will be generated on meter start up
and this enables all optional features available. All keys are unique to the CPU board's serial
number, so a key from one meter will not work in another meter.

The Continuous Flow Analysis optional feature is enabled via a software "key" value that is
specific to the meter's CPU Board. This software feature key consists of 16 characters
divided into four hyphen-separated, 4-character groups (such as 1234-5678-90AB-CDEF).
This dialog is only available while connected to a meter with firmware that contains option
keys to enable.

In MeterLink, access the Key Manager to view key statuses, add keys or change the key
values.

3.1.1 Obtaining optional keys
If you do not have a valid key to enter to enable a feature, you must have the CPU board
serial number available, which displays in the Meter → Key Manager dialog and the Meter
Menu → Meter Information dialog, when you contact Rosemount to obtain the key. The
keys can be given verbally over the phone or they can be e-mailed in a Key file for easy
entry.

• E-mail: tech.service@emersonprocess.com

• Web: http://www.emerson.com/en-us/support

• Also see, MeterLinkHelp → Technical_Support

3.1.2 GC interface key
The optional GC interface feature allows the meter to read gas property data (composition
and heating value) from a Rosemount gas chromatograph.

The meter can use the gas composition data to:

1. Calculate AGA8 compressibilities for converting volumetric flow rate and volumes
to standard (base) condition

2. Calculate AGA8 density for calculating mass rate and mass totals

3. To optionally calculate the AGA10 sound velocity (see AGA10 key (sound velocity
calculation)). The meter uses the GC-reported gas heating value to calculate the
energy rate and totalized energy rate values. This feature is enabled/disabled via the
GCKey data point.
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3.1.3 AGA10 key (sound velocity calculation)
The optional AGA10 sound velocity calculation feature allows the meter to calculate the
predicted sound velocity based upon the gas composition and compare this value to the
measured average sound velocity. The gas composition can be either specified via data
points or optionally read live from a GC (see above). This feature is enabled or disabled via
the AGA10Key data point.

3.1.4 Continuous Flow Analysis (CFA) key
The Continuous Flow Analysis key enables all optional features and provides extensive
diagnostics for the meter's operational health.

3.2 Configure optional keys
Procedure

1. Open MeterLink and connect to your meter.

2. Use the Meter Menu drop-down list and click Key Manager. MeterLink displays the
Key Manager dialog.

3. Enter the key you obtained in the appropriate field in the Key Manager dialog.
The field turns yellow indicating a change was made and the status will be updated.
When at least one change is made and none of the keys are Invalid, the Write to
Meter button is enabled so the changes can be written to the meter.

The Status column indicates if the key you entered is a Valid key.

4. Click Write to Meter to write the keys to the meter. After the keys are written
successfully, the Key Manager dialog closes.
If for any reason, one or more keys were not written successfully, before the Key
Manager closes, a message displays stating which keys could not be written to the
meter. This could occur if communications to the meter is lost between entering
the Key Manager dialog and clicking Write to Meter.

5. If desired, on the Field Setup Wizard-Startup page, enable the View Gas
Chromatograph setup and View Continuous Flow Analysis setup checkboxes to
display these pages later in the Field Setup Wizard. The Gas Chromatograph Setup
page provides the serial port configuration option to collect live gas compositions.
The Continuous Flow Analysis Setup page allows you to configure the SOS
comparison, liquid detection, abnormal profile detection, blockage detection, and
internal bore buildup detection features.
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4 Measurement

4.1 Flow measurement
Rosemount 3410 Gas Ultrasonic Flow Meters measure the transit times of ultrasonic
pulses passing through the medium on two parallel planes. The measurement paths (also
referred to as "chords") are angled to the pipe axis, and each chord has two transducers
acting alternately as transmitter and receiver as shown in Figure 4-1. This permits the
transit times to be measured both with and against the flow (upstream and downstream).

The transducers are mounted on the meter body at accurately known locations for each
pipe size so the distance L between opposing transducers and the angle are precisely
defined for the measurement path.

Figure 4-1: Direct path transit-time measurement principle
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Figure 4-2: Reflective path measurement principle

4.1.1 Transducer timing control
The following terms are used in explaining the effects of transducer timing control, the
performance of batch data collection and calculation updates in Rosemount 3410 Gas
Ultrasonic Flow Meters.

Figure 4-3: Signal Analyzer - update rate, stack size, filter and emission rate

Terminology
• Sequence - a complete cycle of firing all enabled transducers in a single round of

transducer operation.
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• Stacking - the process of modifying a sequence so that each individual transducer is
fired "x" times (where x equals the stack size) before the next transducer in the
sequence is fired.

• Stack size - the multiple of times each transducer is fired before the next transducer
within the sequence is fired. (When stacking is absent or disabled, the stack size is
actually 1, because each enabled transducer is fired once during the sequence. When
stacking is applied or enabled, it is applied increments of 2, 4, 8, and 16 and are the
only stack size choices, so that each enabled transducer is fired 2, 4, 8, or 16 times
before the next transducer in the sequence is fired.)

• Emission rate - the time elapsed before the next transducer in a sequence is fired,
regardless of stack size (minimum emission rate is 2 milliseconds with the Filter ON or
OFF). We recommend the default Filter setting, which is the OFF position.

• Stack emission rate - the time elapsed before a single transducer is re-fired when
stacking is enabled (minimum stack emission rate is 2 milliseconds with the Filter OFF).

• Chords inactive or active - the exclusion or inclusion of a chord-forming pair of
transducers in the sequence of transducer operation.

• Update time - the time elapsed, in seconds, between each processing, or recalculation
of data that is collected from sequences of transducer firings.

• Batch period, or batch cycle - synonymous with Update time, as defined above.

• Sample - refers to one point on the waveform as in samples per cycle. The data that is
collected from one Sequence of transducer operation. (This term is displayed in the
MeterLink™ Signal Analyzer screen, and is nearly synonymous with Sequence, as
defined above. That is, Samples/update, as displayed in the MeterLink™ Signal Analyzer
Wizard, could be interpreted as Sequences/update.) This shows the average number of
new samples collected during an update period.

4.2 Signal processing
The signal at the receiving transducer is amplified, digitized and processed digitally to
provide accurate transit time measurement.

A measure of the signal "quality" is the signal-to-noise ratio (SNR). The higher the SNR, the
better the signal. In general there are two types of noise: "white" noise and "colored" noise.
White noise is noise that occurs across the frequency spectrum and is asynchronous to the
transmitted signal. Colored noise is concentrated around a particular frequency and can
be synchronous with the transmitted signal. The meter provides two methods for
improving the received signal waveform SNR by reducing the noise energy: Stacking and
Filtering.

4.2.1 Stacking
Stacking is a method of firing a transducer multiple times and averaging the received
signals on a point-by-point basis.

Stacking is effective on asynchronous noise such as is typically seen with valve noise. This
method is not useful for removing synchronous noise and should not be used when there
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is a great deal of signal "jitter." Meters are configured by default with a stack size of 1 (no
stacking).

Care should be taken when turning on stacking and it is recommended to consult with
Emerson Customer Support if you are unsure of how stacking a signal can affect the
meter's operation. Refer to Technical Support under the Help menu of MeterLink for
contact information.

The number of consecutive times to fire each transducer is specified via the StackSize data
point. Available stack sizes are 1 (None), 2, 4, 8, and 16. A stack size of 1 selects no
stacking (i.e., stacking disabled). Stacking is only available when the standard update rate
is selected (see Batch update period).

4.2.2 Filtering
Filtering applies a bandpass filter that removes noise that is above and below the
transducer frequency.

Filtering is effective on noise outside of the frequency passband of the filter (e.g., filtering
works on any noise outside of the passband of the filter).

Filtering is enabled/disabled via the Filter data point (TRUE=enable filtering, FALSE=disable
filtering). Meters are configured by default with filtering disabled. The minimum emission
rate for the gas meter is 2 milliseconds with the filter ON or OFF. We recommend the
default Filter setting, which is the OFF position.

Care should be taken when enabling/disabling filtering and it is recommended to consult
with Flow Lifecycle Services for Rosemount products if you are unsure of how this change
can affect the meter's operation. Refer to Technical Support under the Help menu of
MeterLink™ for contact information.

4.2.3 Batch cycle processing
Batch update period

Calculation updates performed by the meter, for deriving volume and velocity, are based
on batches of data samples collected from sequences of transducer firings. The batch
update period is dependent upon the user specified batch update period
(SpecBatchUpdtPeriod) and the stack size (StackSize) as shown in Table 4-1. The
Standard batch update period is the default. The actual batch update period is readable via
the BatchUpdatePeriod data point.

Table 4-1: Actual meter update period

Stack size

1 (None) 2 4 8 16

SpecBatchUpdtPeriod Rapid
(250 ms)

0.25 sec N/A N/A N/A N/A

Standard
(1000 ms)

1 sec 1 sec 1.5 sec 3 sec 5 sec
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Emission rates

The emission rate is the period between firing two different transducers. The stacked
emission rate is the period between consecutive firings of a single transducer when
stacking is used (i.e., the stack size is not set to None).

The actual emission rates used (readable via the EmRateActual and StackEmRateActual
data points) are functions of the desired emission rates, meter type, firing sequence, stack
size, and pipe diameter.

4.2.4 Smoothing
The Rosemount 3410 Series Gas Ultrasonic Flow Meter applies a method for smoothing
the output (particularly the frequency output) by averaging times collected from past
batch periods with new times for the current batch period.

Smoothing can be applied in the following increments: 0 (i.e., smoothing is disabled), 20,
40, 60, or 80%.

For example, setting Smoothing to 20% means that of the samples used for the current
update, 20% will be from previously collected samples and 80% will be from the newly
collected samples. Thus, if eight new samples are collected, then those eight samples
along with the last two previous samples would be used together for the current update
period calculations.

Meters are configured by default for Smoothing of 0% (only new samples are used for the
Current Update period).

4.3 Acquisition mode
Rosemount 3410 Gas Ultrasonic Flow Meters have two modes of normal operation:
Acquisition and Measurement. The Acquisition mode is used to acquire the ultrasonic
signals. This mode is entered when power is applied to the meter.

Once the ultrasonic signals are acquired, the Measurement mode is entered and the flow
velocity is measured. The meter remains in the Measurement mode as long as at least one
chord is operational.

If while in the Measurement mode all chords fail, then the meter re-enters the Acquisition
mode. If the VelHold data point is set to a value greater than zero, then, while in the
Acquisition mode, the meter holds the average weighted flow velocity to the last good
value for up to the VelHold number of batches before setting the velocity to zero. The
VelHold default value is 0.

The Acquisition mode uses the chords' "L" dimensions (LA… as appropriate to the meter
type) and the specified minimum and maximum sound velocities (SSMin and SSMax)
determines the signal search range. MinHoldTime and MaxHoldTime are also used to
determine the signal search range. The meter uses the more restrictive of SSMin/
MaxHoldTime and SSMax/MinHold time.
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4.3.1 Re-acquisition
When fewer than MinChord (default 1) chords are good, then the meter re-enters the
Acquisition mode. If MinChord is set to the number of active chords, the meter will
reacquire on the first time a chord is failed for a batch.

Note that failed for a batch is different from hard failed. A chord fails for a batch when Pct-
Good[A1..D2] is less than MinPctGood.

Hard fails occur after AlarmDef number of batches in a row.

4.4 Chord gas and sound velocity measurements
At each batch update period, each firing path's transit time measurements are averaged.
The average (mean) value for each path is available via data points (as appropriate for the
meter type).

NOTICE

The data point names often use a "short-hand" way of identifying the receiving transducer.
The last two characters identify the chord and the transducer (1=upstream,
2=downstream). For example, MeanTmA1 is the mean transit time for the chord A
upstream transducer.

The difference between a chord's average upstream transit time and average downstream
transit time is the average delta time. The chord's average times and the chord "X" and "L"
dimensions are used to calculate the gas velocity and sound velocity measured by the
chord as shown in Equation 4-1 and Equation 4-2.

Equation 4-1: Chord Gas VelocityVchord= Lchord22Xchord t1‐t2t1t2
and

Equation 4-2: Chord Sound VelocityCchord,classic= Lchord2 t1+t2t1t2Cchord= Cchord,classic × PortAngleFactor
where the PortAngleFactor is a dimensionless factor that is dependent upon the chord port
angle with respect to the meter body:

For 60 degree port angles,

PortAngleFactor =  1+ 0.5 •  Vchord2Cchord.classic2 • tan2 60°
For 75 degree port angles,
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PortAngleFactor = 1+ 0.5 •  Vchord2Cchord.classic2 • tan2 75°
For all other port angles, PortAngleFactor = 1
where

Vchord = chord average gas velocity (m/s) (FlowVelA ... FlowVelD)
Cchord = chord average sound velocity (m/s) (SndVelA ... SndVelD)
Lchord = chord "L" dimension (m) (LA ... LD)
Xchord = chord "X" dimension (m) (XA...XD)
t1 = chord average transit time in the upstream direction (s) (MeanTmA1 ...
MeanTmD1)
t2 = chord average transit time in the downstream direction (s) (MeanTmA2 ...
MeanTmD2)

Important
Note that a positive chord gas velocity indicates flow in the forward direction whereas a
negative chord gas velocity indicates flow in the reverse direction.

4.4.1 Average sound velocity
The Average Sound Velocity is calculated as the average of the active chord sound velocity
measurements as shown in the equation below:

Equation 4-3: Average sound velocity

CAvg =  ∑ActiveChordsCchordNumActiveChords
where

CAvg = average sound velocity (m/s) (AvgSndVel)
Cchord = chord average sound velocity (m/s) (SndVelA... )
NumActiveChords = number of active chords

4.4.2 Optional AGA10 sound velocity calculation and
comparison
The Rosemount 3410 Series Gas Ultrasonic Flow Meter offers an option to calculate the
sound velocity (using AGA10 equations and gas property data) and compare the result to
the meter- measured sound velocity on an hourly basis.

This feature is enabled via the AGA10 Key (see AGA10 key (sound velocity calculation)).
The gas property data required for using this feature can be specified via data points or
optionally read from a Rosemount GC (Configure Gas Chromatograph parameters). The
AGA8 Detail Method or GERG-2008 must be selected (via the HCH_Method data point,
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Configure Gas Chromatograph parameters) in order for the AGA10 calculations to be
performed.

Every five seconds the meter updates the AGA10-calculated sound velocity. This value is
readable via the AGA10SndVel data point and the calculation status value is readable via
the AGA10SndVelStatus data point. The status values are as listed in the table below:

Table 4-2: Status of AGA speed of sound calculation

AGA10SndVelStatus value Description

0 Calculation OK (no errors)

1 Calculation not performed as the feature is not enabled .
AGA10SndVel is set to zero.

2 Calculations not performed as the AGA8 method (HCH_Method)
is not the Detail Method or GERG-2008. AGA10SndVel is set to
zero.

3 Calculations not performed as the AGA8 calculations are invalid.
AGA10SndVel is set to zero.

4 Calculations not performed due to encountered division by zero.
AGA10SndVel is set to zero.

Over the course of an hour (starting from the top of the hour), the meter calculates the
average measured sound velocity (the average of the average weighted sound velocity)
and the average AGA10-calculated sound velocity. At the end of the hour, the two
averages are compared; the comparison error (%) is readable via the SndVelCompErr data
point.

Note that the comparison error is only calculated at the end of the hour when there is at
least 75% of a log hour worth of valid flow data during the hour. A valid flow data means
that all of the following are true:

• no AGA10 sound velocity calculation errors occurred (i.e., AGA10SndVelStatus always
equal to 0),

• the measured average flow velocity (AvgFlow) is between the diagnostic flow analysis
limits (FlowAnalysisLowFlowLmt and FlowAnalysisHighFlowLmt), and

• the measured sound velocity was always valid (as indicated by the QMeterValidity data
point).

4.4.3 Average weighted gas flow velocity
When all active chords are non-failed, the average weighted gas flow velocity is a weighted
sum of the chord velocity measurements as shown in Equation 4-4 where the chord
weights are determined by the meter geometry.

Equation 4-4: Average weighted gas flow velocityVAvgWtd =  ∑ActiveChordsWtchord Vchord
where
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VAvgWtd = average weighted gas flow velocity (m/s) (AvgWtdFlowVel)
Wtdchord = chord weight (dimensionless) (WtA ... WtD)
Vchord = chord average gas velocity (m/s) (FlowVelA ... FlowVelD)

4.4.4 Average weighted flow velocity using chord proportions
In the event of one or more chord failure(s), the meter operation is dependent upon the
number of non-failed chords. If there is at least one operating chord, then the meter uses a
velocity estimation method described in the following paragraphs.

If all chords fail, then the meter re-enters the Acquisition mode as described in the Re-
acquisition section.

The meter partitions the velocity range (for forward and reverse flow) into ten
consecutive, non- overlapping "bins" (where the velocity range is as specified via the
MeterMaxVel data point).

The meter maintains a set of bins for each active chord where each bin contain three data
values: (1) the chord's average velocity (within the bin's velocity range), (2) the chord's
average proportion value, and (3) an indicator that the value is still the default (Is[Fwd/
Rev]Prop[A..D]DfltBin[1..10]). A chord proportion value is the ratio of the chord velocity
to the average weighted flow velocity as shown in Equation 4-5 below. The default
indicator is used to determine if a bin's velocity and proportion data values have been
updated from their initialized values. The bins are initialized with the average velocity over
the bin's range and meter-geometry-dependent proportion values. All default indicators
are initialized to TRUE. The bin data is stored in non-volatile memory.

Equation 4-5: Chord proportion calculationPropchord =  VchordVAvgWtd
where

Propchord = chord proportion (dimensionless)
Vchord = chord velocity (m/s) (FlowVelA ... FlowVelD)
VAvgWtd = average weighted gas flow velocity (m/s) (AvgWtdFlowVel)

When the meter has operated for a user-specified number of consecutive batches without
any chord failures, the meter updates each chord's data values for the bin containing the
chord velocity as shown in Equation 4-6 and sets the bin's default indicator to FALSE. The
PropUpdtBatches data point, configurable via the MeterLink Edit/Compare Configuration
screen, specifies the number of consecutive failure-free batches required for updating the
bin data (range: [1, 1000], default: 24). The NumVals data point (that determines how
quickly an average value changes) is also configurable via the Edit/Compare
Configuration screen (range: [1, 1000], default: 10).
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Equation 4-6: Updating chord proportion bin data values

AvgVelChordBin n+1 =  AvgVelChordBin n •  NumVals ‐ 1  + VchordNumValsAvgPropChordBin n+1 =  AvgPropChordBin n •  NumVals ‐ 1  + PropchordNumVals
where

AvgVelChordBinn+1
 = chord bin (n+1)st average velocity (m/s)

AvgVelChordBinn
 = chord bin nth average velocity (m/s)

NumVals = update factor data point (dimensionless) (NumVals)
Vchord = chord velocity (m/s) (FlowVelA ... FlowVelD)
AvgPropChordBinn+1

 = chord bin (n+1)st average proportion value (dimensionless)
AvgVelChordBinn

 = chord bin nth average proportion value (dimensionless)
Propchord = chord proportion (dimensionless)

In the event of a chord failure with at least one operating chord, the meter's average
weighted flow velocity is estimated as shown in Equation 4-7.

Equation 4-7: Estimating average flow velocity using proportion values

VAvgWtd est =  ∑ Non‐Failed Chord(s) Vchord∑ Non‐Failed Chord(s) InterpPropchord
where

VAvgWtdest
 = estimated average weighted flow velocity (m/s) (AvgWtdFlowVel)

VChord = (non-failed) chord velocity (m/s) (FlowVelA ... FlowVelD)
InterPropchord = (non-failed) chord interpolated proportion value (dimensionless)

For each non-failed chord, the interpolated proportion value used in Equation 4-7 is
calculated as follows:

• If the chord's velocity is surrounded by non-default (average velocity, average
proportion) data pairs, then the interpolated proportion is the linear interpolation
between the two data pairs.

• If the chord's velocity has a non-default (average velocity, average proportion) data
pair on one side of it but not the other, then the interpolated proportion is the data pair
average proportion.

• If there are only default (average velocity, average proportion) data pairs, then the
interpolated proportion is the corresponding bin's default average proportion value.

4.5 Volumetric flow rate values
The Rosemount 3410 Series Gas Ultrasonic Flow Meter meter provides three volumetric
flow rate values: raw, (expansion-corrected and/or profile-effect corrected) flow-
condition, and base- condition. Note that a positive volumetric flow rate indicates flow in
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the forward direction whereas a negative volumetric flow rate indicates flow in the reverse
direction.

4.5.1 Raw volumetric flow rate
The "raw" volumetric flow rate is calculated from the average gas flow velocity (wet-
calibration gas flow velocity) as shown in Equation 4-8.

Equation 4-8: Raw volumetric flow rateQRaw = VWetCal ⋅ πD24 ⋅ 3600 s/ℎ
where

QRaw = “raw” volumetric flow rate (m3/h) (QMeter)
VWetCal = wet-calibration gas flow velocity (m/s) (AvgFlow)
π = geometric constant, pi (dimensionless) (3.14159...)
D = pipe inside diameter (m) (PipeDiam)

4.5.2 Flow-condition volumetric flow rate
The flow-condition volumetric flow rate is the result of applying expansion correction and
flow- profile correction to the raw volumetric flow rate as shown in Equation 4-9 subject to
the low- flow cut-off. If the resulting value is below the low-flow cut-off value, it is set to
zero. The low-flow cut-off volumetric flow rate (QCutOff) is the specified low-flow velocity
threshold (ZeroCut) converted to a volumetric flow rate.

Equation 4-9: Flow-condition volumetric flow rateQFlow = QRaw ExpCorrP ExpCorrT CorrFctr
where

QFlow = flow-condition volumetric flow rate (m3/h) (QFlow)
QRaw = “raw” volumetric flow rate (m3/h) (QMeter)
ExpCorrP = expansion correction factor due to pressure (dimensionless)
(ExpCorrPressure) calculated as shown in Equation 4-10.
ExpCorrT = expansion correction factor due to temperature (dimensionless)
(ExpCorrTemperature) calculated as shown in Equation 4-12.
CorrFctr = profile-effect correction factor (CorrectionFactor) calculated as shown in
Equation 4-11.

4.5.3 Pressure-effect expansion correction
The meter is capable of correcting the raw volumetric flow rate for the effect of pipe
expansion due to pressure changes.

Note that for the pressure-effect expansion correction factor to be calculated, the
correction must be enabled (via the EnableExpCorrPress data point) and the flow-
condition pressure must be available (i.e., the EnablePressureInput data point must be set
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to 'Live'(1) or 'Fixed'(2), see Configure the pressure parameters for the meter. The
pressure-effect calculation is shown in Equation 4-10. If the pressure-effect expansion
correction factor is not calculated, it is set to 1.0.

Equation 4-10: Pressure-effect expansion correctionExpCorrP = 1 + 3 × β × Pabs, f− Pref
where

ExpCorrP = expansion correction factor due to pressure (dimensionless)
(ExpCorrPressure)
ß = pipe linear expansion coefficient due to temperature (MPaas-1)
(StrainPerUnitStress) calculated as shown in Equation 4-8.
Pabs,f = flow-condition absolute pressure (MPaa) (AbsFlowPressure) calculated as
shown in Equation 4-15
Pref = reference absolute pressure (MPaa) (0.101325MPaa) reference temperature for
the pipe linear expansion coefficient (K)

Equation 4-11: Pressure-effect strain per unit stressβ =  Dout2 1+υ  +  Din2 1‐2υE ×  Dout2 ‐Din2
where

β = pipe strain per unit stress (MPaa-1) (StrainPerUnitStress)
Dout = outside diameter of the meter or pipe (m) (PipeOutsideDiameter)
Din = inside diameter of the meter or pipe (m) (PipeDiam)
ʋ = Poisson’s Ratio (dimensionless) (PoissonsRatio)
E = Young’s Modulus of elasticity (MPaa) (YoungsModulus)

4.5.4 Temperature-effect expansion correction
The meter is capable of correcting the raw volumetric flow rate for the effect of pipe
expansion due to temperature changes.

Note that for the temperature-effect expansion correction factor to be calculated, the
correction must be enabled (via the EnableExpCorrTemp data point) and the flow-
condition temperature must be available (i.e., the EnableTemperatureInput data point
must be set to 'Live'(1) or 'Fixed'(2), see Temperature expansion correction . The
temperature-effect calculation is shown in Equation 4-12. If the temperature-effect
expansion correction factor is not calculated, it is set to 1.0.

Equation 4-12: Temperature-effect expansion correctionExpCorrT = 1 + 3 × α × Tf− Tref
where

ExpCorrT = expansion correction factor due to temperature (dimensionless)
(ExpCorrTemperature)
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α = pipe linear expansion coefficient due to temperature (K-1) (LinearExpansionCoef)
Tf = flow-condition temperature (K) (FlowTemperature)
Tref = reference temperature for the pipe linear expansion coefficient (K)
(RefTempLinearExpCoef)

4.5.5 Profile-effect correction
Two path and bounce path meters (device numbers 3412 and 3411) require profile-effect
correction. All other meters do not require profile-effect correction and the profile-effect
correction factor is set to 1.

For meter types that require profile-effect correction, the correction factor can be either
user- specified or meter-calculated depending upon the value of the
SpecCorrectionFactor data point: if set to 0.0, then the correction factor is meter-
calculated; if set within [0.90, 1.05], then the specified value is used.

Calculating the meter factor requires that the flow-condition pressure and temperature be
live or fixed and that the AGA8 calculations are performed either internally or externally. If
the profile-effect correction factor is to be meter-calculated but either the flow-condition
pressure and/or temperature are/is disabled or the AGA8 calculations are not performed,
then the flow- condition correction factor is set to the default value of 0.95. Otherwise, it is
calculated as shown in Equation 4-13.

Equation 4-13: Profile-effect correction factorCorrFctr = 1 + 0.242log 0.2703WRDin + 0.835Re0.8
where

CorrFctr = flow-profile correction factor (CorrectionFactor)
WR = pipe wall roughness (m) (WallRoughness)
Din = pipe inside diameter (m) (PipeDiam)
Re = Reynolds number (dimensionless) (ReynoldsNumber) calculated as shown in
Equation 4-14.

4.5.6 Reynolds number
Reynolds Number is a dimensionless value that represents the nature of the gas flow
within the pipe. Although the primary reason for calculating Reynolds Number is for
reflective path meters (device numbers 3412 and 3411) profile-effect correction, the value
is calculated for all meter types.

Reynolds Number is calculated as shown in Equation 4-14.

Equation 4-14: Reynolds numberRe = MAX PathFactor 4π QRawρ Ρf,ΤfDinμ ,104
where
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Re = Reynolds Number (dimensionless) (ReynoldsNumber)
MAX = maximum function that takes the maximum of the values within the brackets
PathFactor = factor to (approximately) correct for velocity profile effects (1.00 for
meters) (dimensionless)
π = geometric constant, pi (dimensionless) (3.14159...)
QRaw = "raw" volumetric flow rate (m3/h) (QMeter)
ρ(Pf,Tf) = natural gas mixture mass density at the flow condition (either calculated as
part of internal AGA8 calculations or specified via (SpecRhoMixFlow) (kg/m3)
(RhoMixFlow)
Din = pipe inside diameter (m) (PipeDiam)
µ = dynamic viscosity (Pa•s) (Viscosity)

4.5.7 Base-condition volumetric flow rate
The base-condition volumetric flow rate is the result converting the flow-condition
volumetric flow rate to the base pressure-temperature condition.

This conversion requires (1) AGA8 calculations to be either performed internally (i.e., by
the meter) or externally (with the resulting compressibilities specified to the meter via the
SpecZFlow and SpecZBase data points), and (2) the flow-condition temperature and
pressure to be live or fixed. If AGA8 calculations are not performed (i.e., neither internally
nor externally) or the flow-condition temperature and/or pressure are/is not enabled, then
the base-condition volumetric flow rate is set to zero. The base-condition volumetric flow
rate is calculated as shown in Equation 4-15.

Equation 4-15: Base-condition volumetric flow rateQBase = QFlow Pabs, fPabs, b TbTf ZbZf
where

QBase = “raw” volumetric flow rate (m3/h) (QMeter)
QFlow = flow-condition volumetric flow rate (m3/h) (QFlow)
Pabs,b = flow-condition absolute pressure (MPaa) (AbsFlowPressure) calculated as
shown in Equation 4-10.
Tb = base-condition temperature (K) (TBase)
Tf = flow-condition temperature (K) (FlowTemperature)
Zb = base-condition compressibility factor (ZBase)
Zf = flow-condition compressibility factor (ZFlow)

4.5.8 Volume
The Rosemount 3410 Series Gas Ultrasonic Flow Meter provides forward and reverse
volume accumulators for each of the three volumetric flow rate values: raw, flow-
condition (raw with expansion and/or profile correction), and base-condition.

Each volume accumulator is actually stored as a data pair: (64-bit unsigned integer
portion, 32-bit floating point fractional portion). For example, a volume of 12345.750 m3

is stored as 12345 m3 for the integer portion and 0.750 m3 as the fractional portion. Note
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that while a volumetric flow rate can be positive (indicating forward flow) or negative
(indicating reverse flow), the volume accumulators are always positive values.

The non-volatile volume accumulator data points are as listed in the table below:

Table 4-3: Volume accumulation data points

Volumetric
flow rate type

Forward Direction Reverse direction

Integer Fraction Integer Fraction

Raw PosVolUncorr PosVolUncorrFrac NegVolUncorr NegVolUncorrFrac

Flow-condition PosVolFlow PosVolFlowFrac NegVolFlow NegVolFlowUncorr

Base-condition PosVolBase PosVolBaseFrac NegVolBase NegVolBaseUncorr

4.5.9 Energy rate and totals
The Rosemount 3410 Series Gas Ultrasonic Flow Meter meter calculates the energy rate
and energy totals (forward and reverse). These calculations require that the flow-condition
pressure and temperature are available (either fixed or optional analog inputs, Flow-
condition pressure and temperature, the gas property data (composition and heating
value) are available (either fixed or optionally read from a GC, Flow-condition pressure and
temperature), and the AGA8 calculations are performed (internally by the meter or
externally with the results written to the meter, Flow-condition pressure and
temperature).

The energy rate is calculated as shown in Equation 4-16

Equation 4-16: Energy rateQE = QBase × HV × 1MJ1000kJ × 1000dm31m3
where

QE = energy rate (MJ/h) (EnergyRate)
QBase = base-condition volumetric flow rate (m3/h) (QBase)
HV = "in-use" heating value (kJ/dm3) (HeatingValueInUse)

The sign of the energy rate indicates the flow direction: a positive value indicates flow in
the forward direction, a negative value indicates flow in the reverse direction.

The energy rate validity is indicated by the EnergyRateValidity data point TRUE(1)
indicates valid). The energy rate is valid if the base-condition volumetric flow rate is valid
(indicated by QBaseValidity where TRUE(1) indicates valid) and if the in-use gas properties
are valid (indicated by AreGasPropertiesInvalidInUse where FALSE(0) indicates valid).

The energy rate is accumulated into the corresponding direction energy total regardless of
the energy rate validity.

The forward and reverse direction energy totals are each stored in non-volatile memory as
a data pair: a 64-bit unsigned integer portion and a 32-bit floating point fractional portion.
For example, an energy total of 12345.750 MJ is stored as 12345 MJ for the integer portion
and 0.750 MJ as the fractional portion. Note that while the energy rate can be positive
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(indicating forward flow) or negative (indicating reverse flow), the energy totals are always
positive values.

The non-volatile energy total data points are as listed in the table below:

Table 4-4: Energy total data points

Forward direction Reverse direction

Integer Fraction Integer Fraction

PosEnergy PosEnergyfrac NegEnergy NegEnergyFrac

4.5.10 Mass rate and totals
The Rosemount 3410 Series Gas Ultrasonic Flow Meter meter calculates the mass rate and
mass totals (forward and reverse).

These calculations requires that the flow-condition pressure and temperature are available
(either fixed or optional analog inputs, Gas properties), the gas composition is available
(either fixed or optionally read from a GC, Gas property data), and the AGA8 calculations
are performed (internally by the meter or externally with the results written to the meter,
Configure Gas Chromatograph parameters).

The mass rate is calculated as shown in Equation 4-17

Equation 4-17: Mass rate MassRate = QFlow × ρFlow
MassRate = mass rate (kg/h) (MassRate)
QFlow = flow-condition volumetric flow rate (m3/h) (QFlow)
ρFlow = "in-use" flow-condition gas mass density (kg/m3) (RhoMixFlow)

The sign of the mass rate indicates the flow direction: a positive value indicates flow in the
forward direction, a negative value indicates flow in the reverse direction.

The mass rate validity is indicated by the MassRateValidity data point (TRUE(1) indicates
valid). The mass rate is valid if the flow-condition volumetric flow rate is valid (indicated by
QFlowValidity where TRUE(1) indicates valid) and if the AGA8 flow-condition calculation is
valid (indicated by AGA8FlowCalcValidity where TRUE(1) indicates valid).

The mass rate is accumulated into the corresponding direction mass total regardless of
the mass rate validity.

The forward and reverse direction mass totals are each stored in non-volatile memory as a
data pair: a 64-bit unsigned integer portion and a 32-bit floating point fractional portion.
For example, a mass total of 12345.750 kg is stored as 12345 kg for the integer portion
and 750 kg as the fractional portion. Note that while the mass rate can be positive
(indicating forward flow) or negative (indicating reverse flow), the mass totals are always
positive values.

The non-volatile mass total data points are as listed in the table below:
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Table 4-5: Mass total data points

Forward direction Reverse direction

Integer Fraction Integer Fraction

PosMass PosMassFrac NegMass NegMassFrac

4.6 Rosemount 3410 Series gas flow meter
characterizations
For Rosemount 3410 Series Gas Ultrasonic Flow Meter SeniorSonic meters only, the
following flow characterizations are calculated/estimated: symmetry, cross-flow, chord
turbulence, profile factor, and swirl angle. Alarm limits are provided for the chord
turbulence and swirl angle values.

Symmetry

Symmetry is a dimensionless measure of the flow symmetry comparing the upper chords
to the lower chords and is readable via the Symmetry data point. Ideally the Symmetry
should be 1.0.

Cross-flow

Cross-flow is a dimensionless measure of the flow symmetry comparing the chords on one
side of the meter to the chords on the other side. It is readable via the CrossFlow data
point. Ideally the Cross-flow should be 1.0.

Chord turbulence

Chord Turbulence is a estimate of the turbulence (percentage) at a chord location. A value
is calculated for each active chord and is readable via the TurbulenceA, TurbulenceB,
TurbulenceC, or TurbulenceD data points. A value of 0% indicates no appreciable
turbulence.

Profile Factor

The profile factor is a dimensionless ratio of the inner chord velocities to the outer chord
velocities. It is readable via the ProfileFactor data point.

Swirl angle

The swirl angle is an estimate of the swirl (to the nearest degree) and is readable via the
SwirlAngle data point. It is calculated as a function of the meter body style and Profile
Factor (see above). A value of 0 degrees indicates no appreciable swirl.
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5 Configurations

5.1 Calibrate and configure the meter
Use MeterLink™ to calibrate and configure the meter parameters: Analog (current), Meter
Factors, Flow Calibration, Frequency/Digital Output Sources, Frequency and Digital inputs
and outputs, HART output, Meter corrections (for Models 3412 and 3411), Temperature
and Pressure, AGA8 calculations, and Local Display parameters.

5.1.1 Calibration methods
The Rosemount 3410 Series Gas Ultrasonic Flow meter uses two calibration steps: "dry"
calibration and "wet" calibration.

In this methodology, the "dry-calibration" values are set by Rosemount at the factory and
are not expected to be modified; the "wet-calibration" values are expected to be set as the
result of a user flow calibration (if desired). These two calibration methods are explained in
further detail below.

Important
The WRITE PROT. switch on the CPU Module must be disabled (OFF) before writing
calibration factors to the meter.

After the meter is configured, enable the WRITE PROT. switch (ON) to write-protect the
configuration.

Collect a Maintenance Log and configuration file the meter's "As left" configuration
settings.

Gas flow velocity for dry calibration
The dry-calibration gas flow velocity is the result of applying a third-order polynomial
equation to the average weighted gas flow velocity as shown in Equation 5-1 to correct for
static or zero flow conditions.

Equation 5-1: Dry-calibration gas flow velocityVDryCal = A0+ A1VAvgWtd+ A2VAvgWtd2 + A3VAvgWtd3
where

VDryCal = dry-calibration gas flow velocity (m/s) (DryCalVel)
VAvgWtd = average weighted gas flow velocity (m/s) (AvgWtdFlowVel)
A0 = dry-calibration 0th order coefficient (m/s) (FwdA0 or RevA0)
A1 = dry-calibration 1st order coefficient (dimensionless) (FwdA1 or RevA1)
A2 = dry-calibration 2nd order coefficient (s/m) (FwdA2 or RevA2)
A3 = dry-calibration 3rd order coefficient (s2/m2) (FwdA3 or RevA3)
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Note
Note that the meter provides two sets of dry calibration coefficients - one set for each flow
direction.

Dry calibration procedure

Prerequisites

NOTICE

Modification of dry calibration parameters is not recommended. The dry calibration
parameters should not be modified unless directed by Emerson representative.

Procedure

1. Select the Calibration → Meter Factors menu.

Figure 5-1: Calibration - Meter factors page

2. Click the Advanced View button to display the zero flow calibration polynomial
coefficients. Regardless of what flow calibration method is selected, the zero flow
calibration polynomial coefficients will be applied first.

3. Set the flow calibration method to None.

4. Enter the appropriate forward and reverse meter factors and click Write to send the
factors to the meter.

5. Click the Cancel button to cancel any changes and close the dialog box.

The meter provides separate dry calibration coefficients for each flow direction as
listed in the table below.
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Table 5-1: Data Points for dry calibration

MeterLink ™

Display Name
Data points, options and guidelines

Forward A0 Data points affected:

• FwdA0

0 Options:

• Enter a value (m/s or ft/s) within the range [-1,1 m/s].

Guidelines:

• This value should only be modified under direction of Emerson
representative.

Forward A1 Data points affected:

• FwdA1

1 Options:

• Enter a value (dimensionless) within the range [0.95, 1.05].

Guidelines:

• This value should only be modified under direction of Emerson
representative.

Forward A2 Data points affected:

• FwdA2

2 Options:

• Enter a value (s/m or s/ft) within the range [-0.1, 0.1].

Guidelines:

• This value should only be modified under direction of Emerson
representative.

Forward A3 Data points affected:

• FwdA3

3 Options:

• Enter a value (s2/m2 or s2/ft2) within the range [-0.1, 0.1 s2/
m2].

Guidelines:

• This value should only be modified under direction of Emerson
representative.

Reverse A0 Data points affected:

• RevA0

0 Options:

• Enter a value (s/m or s/ft) within the range [-1, 1].

Guidelines:

• This value should only be modified under direction of Emerson
representative.
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Table 5-1: Data Points for dry calibration (continued)

MeterLink ™

Display Name
Data points, options and guidelines

Reverse A1 Data points affected:

• RevA1

1 Options:

• Enter a value (dimensionless) within the range [0.95, 1.05].

Guidelines:

• This value should only be modified under direction of Emerson
representative.

Reverse A2 Data points affected:

• RevA2

2 Options:

• Enter a value (s/m or s/ft) within the range [-0.1, 0.1].

Guidelines:

• This value should only be modified under direction of Emerson
representative.

Reverse A3 Data points affected:

• RevA3

3 Options:

• Enter a value s2/m2 or s2/ft2) within the range [-0.1, 0.1 s2/
m2].

Guidelines:

• This value should only be modified under direction of Emerson
representative.

Gas flow velocity for wet calibration
The Rosemount 3410 Series Gas Ultrasonic Flow meter offers three selections for wet
calibration: 12-point piece-wise linearization, a third-order polynomial, or none. The wet
calibration method is selected via the CalMethod data point with "None" being the default
value. The wet calibration gas flow velocity is calculated from the dry calibration gas flow
velocity as shown in Equation 5-2.

Equation 5-2: Wet-calibration gas flow velocityVWetCal = WetCalFunction VDryCal
where

VWetCal = wet-calibration gas flow velocity (m/s) (AvgFlow)
VDryCal = dry-calibration gas flow velocity (m/s) (DrycalVel)
WetCalFunction(x) = selected wet-calibration function
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Wet calibration procedure using gas flow velocity

Configure the date points listed below from the MeterLink Calibration → Meter Factors
menu:

Table 5-2: Data Points for wet calibration

MeterLink™

Display Name
Data points, options and guidelines

Flow calibration method Data points affected:

• CalMethod

Options:

• Piece-wise (2)

• Polynomial (1)

• None (0)

Guidelines:

• This value should only be modified under direction of Emerson
representative.

Procedure

1. Choose a Flow Calibration Method:

• Polynomial

• Piece-wise linear

• None (If set to None then the wet calibration has the same value as the dry
calibration.)

2. Select the Calibration → Meter Factors menu.
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Figure 5-2: Calibration - Meter Factor: None

Piece-wise linearization for wet calibration
If the 12-point piece-wise linearization (PWL) wet calibration method is selected, then the
dry-calibration gas flow velocity is calculated as shown in Equation 5-3.

The inputs to the 12-point piece-wise linearization are the (up to) 12 pairs of volumetric
flow rates and meter factors for each flow direction ([FwdFlwRt1, FwdMtrFctr1], ...,
[FwdFlwRt12, FwdMtrFctr12] for forward flow; [RevFlwRt1, RevMtrFctr1], ...,
[RevFlwRt12, RevMtrFctr12] for reverse flow). Refer to Calibrate meter factors to
configuring these data points using MeterLink.

NOTICE

The input flow rates should be entered in descending order (highest first) with their
corresponding meter factors. If these are entered in the wrong order, the meter will still
work but the accuracy may be affected. The meter will not accept negative values, so only
positive values should be entered for both forward and reverse flow rates. If fewer than 12
points are to be used, the unused flow rate and meter factor pairs should be set to 0 and 1
respectively.

Equation 5-3: Wet calibration - 12-point piece-wise linearizationVWetCal = VDryCalLinearMeterFctr
where

Configurations Operations Manual
April 2022  00809-1100-3104

40 Emerson.com/Rosemount



VWetCal = wet-calibration gas flow velocity (m/s) (AvgFlow)
VDryCal = dry-calibration gas flow velocity (m/s) (DryCalVel)
LinearMeterFctr = linear meter factor (dimensionless) (LinearMeterFctr)

Wet calibration procedure using piece-wise linearization

The linear meter factor is determined by the PWL inputs, the flow direction, and the dry-
calibration gas flow velocity. If set to Piece-wise Linear" then the piece-wise linearization
flow rate and meter factor parameters are used to calculate the meter factor to be applied.

Figure 5-3: Calibration - Meter Factor: Piece-wise linearization

Table 5-3: Data points for Piece-wise linearization calibration

Meterlink™

Display Name
Data points, options and guidelines

Forward Flow Rate Data points affected

• FwdFlwRate1...FwdfltRate12

Options:

• Enter a value (m3/h or ft3/h) within the range [0.200000 m3/h].

Guidelines:

• The flow rates must be entered from highest to lowest.

Forward Meter Factor Data points affected

• FwdMtrFctr1...FwdMtrFctr12

Options:

• Enter a value (dimensionless) within the range [0.95, 1.05].
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Table 5-3: Data points for Piece-wise linearization calibration (continued)

Meterlink™

Display Name
Data points, options and guidelines

Reverse Flow Rate Data points affected

• RevFlwRate1...RevFltRate12

Options:

• Enter a value (m3/h or ft3/h) within the range [0.200000 m3/h]

Guidelines:

• The flow rates must be entered from highest to lowest.

Reverse Meter Factor Data points affected

• RevMtrFctr1...RevMtrFctr12

Options:

• Enter a value (dimensionless) within the range [0.95, 1.05]

Procedure

1. Select Piece-wise linear from the Calibration → Meter Factors menu.

2. Click the Add button below the table to add a new calibration point to the bottom
of the table. You can add a maximum of 12 points. The calibration points must be
entered from the highest flow rate to the lowest flow rate.

3. Click Write to apply the calibration parameters to the meter.

Third-order polynomial for wet calibration
When the Polynomial wet calibration method is selected, the meter uses a third-order
polynomial on the dry-calibration velocity Equation 5-4.

Equation 5-4: Wet calibration - third order polynomialVWetCal = C0+ C1VDryCal +C2VDryCal2 + C3VDryCal3
Where

VWetCal = wet-calibration gas flow velocity (m/s) (AvgFlow)
VSryCal = dry-calibration gas flow velocity (m/s) (ADryCalVel)
C0 = wet-calibration 0thorder coefficient (m/s) (FwdC0 or RevC0)
C1 = wet-calibration 1storder coefficient (dimensionless) (FwdC1 or RevC1)
C2 = wet-calibration 2ndorder coefficient (s/m) (FwdC2 or RevC2)
C3 = wet-calibration 3rdorder coefficient (s2/m2) (FwdC3 or RevC3)

Wet calibration procedure using Third-order polynomial

If selecting "Polynomial Coefficients", the "C" calibration coefficients are applied.
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Figure 5-4: Calibration - Meter Factor: Polynomial

Three coefficients are specified for each flow direction from the MeterLink Calibration →
Meter Factors page as shown in the table below:

Table 5-4: Data points for Polynomial wet calibration

Meterlink™

Display Name
Data points, options and guidelines

Forward C0 Data points affected

• FwdC0

Options:

• Enter a value (m/s or ft/s) within the range [-1, 1 m/s].

Forward C1 Data points affected

• FwdC1

Options:

• Enter a value (dimensionless) within the range [0.95, 1.05].

Forward C2 Data points affected

• FwdC2

Options:

• Enter a value (s/m or s/ft ) within the range [-0.1, 0.1 s/m].

Forward C3 Data points affected

• FwdC3

Options:

• Enter a value (m/s or ft/s) within the range (s2/m2 or s2/ft 2) within
the range [-0.1, 0.1 s2/m2].
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Table 5-4: Data points for Polynomial wet calibration (continued)

Meterlink™

Display Name
Data points, options and guidelines

Reverse C0 Data points affected

• RevC0

Options:

• Enter a value (m/s or ft/s) within the range [-1, 1 m/s].

Reverse C1 Data points affected

• RevC1

Options:

• Enter a value (dimensionless) within the range [0.95, 1.05].

Reverse C2 Data points affected

• RevC2

Options:

• Enter a value (m/s or ft/s) within the range [-0.1, 0.1 s/m].

Reverse C3 Data points affected

• RevC3

Options:

• Enter a value (s2/m2 or s2/ft 2) within the range [-0.1, 0.1 s2/m2].

Procedure

1. Select Polynomial from the Calibration → Meter Factors menu.

2. Add the value for the forward and reverse coefficients.

3. Click Write to apply the parameters to the meter.

No wet calibration
If no wet calibration is selected, then the wet calibration gas flow velocity is equal to the
dry calibration gas flow velocity.

Triggered delta volumes
The "triggered delta volume" feature provides the ability to measure total gas flow volume
(flow- and base-condition) between two successive external event triggers.

To trigger an event, set the DoUpdtTrigDeltaVols data point to TRUE. This causes the
meter to save the current accumulated flow- and base-condition volume values (forward
and reverse). The meter then calculates the difference between these values and the
corresponding values saved from the previous event trigger. Finally the meter writes the
delta volume values to the appropriate data points (TrigDeltaPosVolFlow,
TrigDeltaNegVolFlow, TrigDeltaPosVolBase, and TrigDeltaNegVolBase) and sets the
DoUpdtTrigDeltaVols data point to FALSE to clear the trigger and indicate the calculation
completion.
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The triggered delta volume functionality is retained across power cycles as the
accumulated volumes values at the last event trigger are saved in non-volatile memory.

The delta volume data points are stored internally in non-volatile memory as double-
precision floating point numbers. The delta volume data points can be read via Modbus as
either 32-bit floating point values or as integer values (using the [overflow,lower] LONG
register pair in a manner similar to reading the accumulated volumes).

Suggested user access logic

The following pseudo-code demonstrates the logic to access the triggered delta volume
functionality:

• INITIAL SET-UP:
Ensure Modbus units are set-up as desired: set Modbus register 10026 (UnitsSystem)
to 0 for U.S. Customary units or to 1 for metric units.

• Periodic Loop:
Wait for external event for synchronizing the start of the meter delta volumes.
Send trigger Modbus message: set Modbus register 12199 (DoUpdtTrigDeltaVols) to 1
(TRUE).
Read trigger Modbus register 12199 (DoUpdtTrigDeltaVols) in a loop until it is read as
0 (FALSE) indicating that the delta volumes have been updated.

Read delta volume registers (either the FLOAT registers or the LONG register pairs) in a
single Modbus read. If the delta volume registers are read as LONG register pairs, calculate
each delta volume as follows:

Equation 5-5: Triggered delta volumeDeltaVolume = Overflow × 1e9 + Lower
where

DeltaVolume = triggered delta volume (forward or reverse, flow-condition or base-
condition) (m3 or ft3) (TrigDeltaPosVolFlow, TrigDeltaNegVolFlow,
TrigDeltaPosVolBase, TrigDeltaNegVolBase)
Overflow = triggered delta volume overflow integer value (forward or reverse, flow-
condition or base-condition) (1e9m3 or 1e9ft3)
Lower = triggered delta volume lower integer value (forward or reverse, flow-condition
or base-condition) (m3 or ft3)

Repeat "PERIODIC LOOP"

5.1.2 Configure operational parameters
Table 5-5: Configure Operational parameters

Calibration selection Description

Analog inputs and outputs
(Calibrate analog inputs
and outputs)

Calibration settings for the pressure and temperature analog inputs.

Meter factors (Calibrate
meter factors)

Calibration settings for the pressure and temperature analog inputs.
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Table 5-5: Configure Operational parameters (continued)

Calibration selection Description

Flow calibration (Flow
calibration)

Calibrate the meter during flowing conditions.

Frequency/Digital output
sources (Configure
Frequency/Digital output
sources)

Outputs that can be configured as either a frequency output or a
digital status.

Frequency output
(Configure frequency
outputs)

Configure the available frequency outputs.

Meter Digital outputs
(Configure digital input/
outputs)

Configure the digital outputs.

HART outputs (Configure
HART outputs)

Configure the HART outputs.

Meter corrections
(Configure meter
corrections)

Configure meter corrections that include:

• Profile factor for 3412 and 3411 meters

• Temperature expansion correction (if Live or Fixed), Linear
expansion coefficient

• Linear expansion coefficient reference temperature

• Pressure expansion correction

• Pipe outside diameter

• Young's modulus value (ratio of tensile stress to tensile strain)

• Poisson's Ratio value (the absolute ratio of the pipe material lateral
strain over axial strain)

Temperature and pressure
(Configure temperature
and pressure)

Temperature and Pressure - to set the scaling for analog inputs, enter
fixed values, and set alarm limits for both temperature

Gas Chromatograph setup
(Configure Gas
Chromatograph
parameters)

Configure a serial port as a Modbus master for polling a GC. Selections
include:

• Port

• GC protocol

• GC baud rate

• GC comms address

• GC stream number

• GC heating value units

• GC IP address

• GC port number

• GC heating value type

• Gas composition to use on alarm
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Table 5-5: Configure Operational parameters (continued)

Calibration selection Description

AGA8 calculations
(Configure AGA8
parameters)

Configure the properties necessary for the AGA8 calculations.
Selections include:

• Gross Method 1

• Gross Method 2

• Detail Method

• Externally

• GERG-2008

Continuous flow analysis
(Configure Continuous
Flow Analysis parameters)

Configure the Continuous Flow Analysis features. Selections include:

• Flow limits

• SOS comparison

• Liquid detection

• Abnormal profile

• Blockage Internal bore buildup

Local Display (Configure
the Local Display)

Configure the local display settings. Selections include:

• Display Units

• Display Items

• Scroll Delay

5.2 Calibrate analog inputs and outputs
NOTICE

The WRITE PROT. switch on the CPU Module must be disabled or the calibration values will
not be updated for a meter.

An analog input can be calibrated regardless of the corresponding input type, pressure of
temperature. However, if the corresponding input type is selected as Live, then the input
being calibrated is considered to be invalid and the in-use value depends upon the
FlowPOrTSrcUponAlarm selection (see above). In this case, the appropriate data point
(FlowPressureWhileCal, FlowTemperatureWhileCal) is set to the in-use value so that it
can be logged in the optional log.

The offset and gain can be reset to the default values (0 and 1, respectively) by clicking the
Reset Defaults button.

NOTICE

Clicking the Reset Defaults button writes the offset and gain immediately - the previous
values cannot be restored.

Click the Edit Scaling button to modify the input scaling.
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NOTICE

Changes made to an analog input's offset, gain, and scaling values are written to the log.

From MeterLink, select Calibrate to make changes using the Analog Inputs Wizard.

Procedure

1. Choose the analog input to calibrate, either temperature or pressure and click Next.
The Current → Calibration screen shows the current offset and gain and the input
scaling (i.e., the pressures or temperatures corresponding to the minimum (4 mA)
input and maximum (20 mA) inputs).

2. Click Next to proceed to the Calibration → Method screen then, select either the
offset or two-point calibration methods.

• The Offset method requires a single calibration point and only affects the input's
calibration offset parameter.

• The two-point calibration requires calibrating at two different points (ideally far
apart in value) and affects the input's calibration offset and gain parameters.
Depending upon the selected calibration method, either one or two screens will
follow when the Next button is clicked.

3. The screen(s) displays the current (live) reading. When the input is stable, click the
Hold button to freeze the current reading.

4. Enter the correct value in the Actual edit box. Finally, the Finish screen shows the
new calculated offset and gain values.
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Figure 5-5: Offset calibration

5. Click Finish to write the values to the meter. If the meter is not configured to use
live values from the analog input for calculation, a prompt displays asking if the
configuration should be changed to use the live input.

6. Enable the WRITE PROT. switch on the CPU Module to write-protect the
configuration.

Table 5-6: Calibrate analog inputs and outputs

MeterLink

Display name

Data Points, options and guidelines

Current output
Output setting

Data points affected:
• AO1TestModeOutputPercent

Options:

• Enter the integer percentage of full scale for the analog output
within the range [0, 100 %] where 0% corresponds to the
minimum output (4 mA) and 100% corresponds to the
maximum output (20 mA).

Guidelines

• The specified test value takes effect within one batch period of
clicking the Start button.
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Table 5-6: Calibrate analog inputs and outputs (continued)

MeterLink

Display name

Data Points, options and guidelines

Current output
Start (Stop) AO1

Data points affected:
• IsAO1EnableTest

Options:

• Click on the StartAO1 button to enter the test mode (TRUE).

Note
The Start button will become the Stop button after clicking on
it.

• Click on the StopAO1 button to exit the test mode (FALSE).

Note
The Stop button will become the Start button after clicking on
it.

Guidelines

• The specified test value takes effect within one batch period of
clicking the Start button (see below).

Current output
Output setting

Data points affected:
• AO2TestModeOutputPercent

Options:

• Enter the integer percentage of full scale for the analog output
within the range [0, 100 %] where 0% corresponds to the
minimum output (4 mA) and 100% corresponds to the
maximum output (20 mA).

Guidelines

• The specified test value takes effect within one batch period of
clicking the Start button.

Note
The AO2 is only available with CPU module, part number
1-360-03-010.
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Table 5-6: Calibrate analog inputs and outputs (continued)

MeterLink

Display name

Data Points, options and guidelines

Data points affected:
• IsAO2EnableTest

Options:

• Click on the StartAO2 button to enter the test mode (TRUE).

Note
The Start button will become the Stop button after clicking on
it.

• Click on the StopAO2 button to exit the test mode (FALSE).

Note
The Stop button will become the Start button after clicking on
it.

Guidelines

• The specified test value takes effect within one batch period of
clicking the Start button (see below).

The maximum length of time that the analog output can remain in the test mode is
specified via the NonNormalModeTimeout data point. Note that this data point
applies to other tests as well. The NonNormalModeTimeout data point can be
changed using the MeterLink Edit/Compare Configuration screen. It can be set
within the range [1, 30 min] and has a default value of 2 min.

5.3 Calibrate meter factors
The factory calibrated flow velocity is the result of applying a third-order polynomial
equation (see Third-order polynomial for wet calibration) to the average weighted flow
velocity. Rosemount 3410 Gas Ultrasonic Flow Meters are factory calibrated and the
default calibration settings are recommended.

5.3.1 Flow calibration
Rosemount 3410 Gas Ultrasonic Flow Meters can be calibrated during flowing conditions
by selecting the calibration type in MeterLink from Calibration → Flow Calibration.

In a timed calibration, the meter records the volume through the meter over a user
specified period of time for a calibration run.

A gated calibration records the volume seen between switch closures directly from a
prover for the number of passes it takes for the prover to make a run. Use the spin buttons
or type in the number of passes of a prover to make a run. Calibration Gating configuration
parameter selections are:

• Edge gated, active high
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Figure 5-6: Gating configuration parameter Edge gated, active high

• Edge gated, active low

Figure 5-7: Gating configuration parameter Edge gated, active low

• State gated, active high

Figure 5-8: Gating configuration parameter State gated, active high

• State gated, active low
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Figure 5-9: Gating configuration parameter State gated, active low

A Microsoft Excel® file is generated and the calibration log report can be saved or
appended to an existing file.

5.3.2 Configure Frequency/Digital output sources
The meter has three user-configurable outputs that can be configured for either a
Frequency output or Digital output (FODO).

• FODO1 (eight possible parameter configurations) [Type 2] [Type 4]

• FODO2 (eight possible parameter configurations) [Type 2] [Type 4]

• FODO3 (eight possible parameter configurations) [Type 2] [Type 4]

• FODO4 (eight possible parameter configurations) [Type 4]

• FODO5 (eight possible parameter configurations) [Type 4]

• FODO6 (eight possible parameter configurations) [Type 4]
— (DI1Mode must be set to Frequency/Digital Output 6 to enable FODO6)

Frequency or Digital Outputs (FODO1, FODO6) source options ∼ Group 1

• FO1A, DO1A, FO1B, DO1B, FO2A, DO2A, FO2B, DO2B

• Frequency output 1A is the A Phase of Frequency output 1 content (Uncorrected
volume flow rate, Corrected volume flow rate, Average flow velocity, Average speed of
sound, Energy flow rate, Mass flow rate)

• Frequency output 1B is the B Phase of Frequency output 1

• Frequency output 2A is based on frequency content (Actual - Uncorrected Flow Rate)

• Frequency output 2B is based on frequency content and Frequency 2B Phase

• Digital output 1A is based on Digital output1A content (Frequency Output 1 Validity,
Flow Direction)

• Digital output 1B is based on Digital output1B content (Frequency Output 1 Validity,
Flow Direction)

• Digital output 2A is based on Digital output 2A content (Frequency Output 2 Validity,
Flow Direction)

• Digital output 2B is based on Digital output 2B content (Frequency Output 2 Validity,
Flow Direction)
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Frequency or Digital Outputs (FODO2, FODO3, FODO4, FODO5) source options ∼
Group 2

• FO1A, DO1A, FO1B, DO1B, FO2A, DO2A, FO2B, DO2B

• Frequency output 1A is the A Phase of Frequency output 1 content (Uncorrected
volume flow rate, Corrected volume flow rate, Average flow velocity, Average speed of
sound, Energy flow rate, Mass flow rate)

• Frequency output 1B is the B Phase of Frequency output 1

• Frequency output 2A is the A Phase of Frequency output 2 content (Uncorrected
volume flow rate, Corrected volume flow rate, Average flow velocity, Average speed of
sound, Energy flow rate, Mass flow rate)

• Frequency output 2B is the B Phase of Frequency output 2 content

• Digital output 1A is based on Digital output1A content (Frequency Output 1 Validity,
Flow Direction)

• Digital output 1B is based on Digital output1B content (Frequency Output 1 Validity,
Flow Direction)

• Digital output 2A is based on Digital output 2A content (Frequency Output 2 Validity,
Flow Direction)

• Digital output 2B is based on Digital output 2B content (Frequency Output 2 Validity,
Flow Direction)

Mode options

• Open Collector (requires external excitation supply voltage and pull-up resistor)

• TTL (internally powered by the meter 0-5 VDC signal)

Channel B Phase options:

• Lag forward, Lead reverse (Phase B lags Phase A while reporting forward flow, leads
Phase A while reporting reverse flow)

• Lead forward, Lag reverse (Phase B leads Phase A while reporting forward flow, lags
Phase A while reporting reverse flow)

Phase A and Phase B output (based on flow direction)

• Reverse flow - output only reports flow in the reverse direction. For frequency outputs,
Phase B of the output is 90 degrees out of phase with Phase A.

• Forward flow - output only reports flow in the forward direction. For frequency outputs,
Phase B of the output is 90 degrees out of phase with Phase A.

• Absolute - output reports flow in both directions. For frequency outputs, Phase B of the
output is 90 degrees out of phase with Phase A.

• Bidirectional - output reports flow on Phase A only in the forward direction and on
Phase B only in the reverse direction.

Maximum frequency for the frequency outputs

• 1000Hz

• 5000Hz
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Frequency/Digital output Source configuration

Frequency /Digital Output 1

Frequency /Digital Output 2

Frequency /Digital Output 3

Frequency /Digital Output4

Frequency /Digital Output 5

Frequency /Digital Output 6

• Frequency output 1A

• Frequency output 1B

• Digital output 1A

• Digital output 1B

• Frequency output 2A

• Frequency output 2B

• Digital output 2A

• Digital output 2B

Output for FODO1 and Digital Input 1 (Group 1 on the CPU Module) share a common
ground and have 50V isolation. FODO2 and FODO3 (Group 2 on the CPU Module) share a
common ground and have 50V isolation. This allows an output to be connected to a
different flow computer. The outputs are opto-isolated from the CPU Module and have a
withstand voltage of at least 500V rms dielectric.

Figure 5-10: CPU Module - Frequency/Digital outputs common ground - Type 2

A. FODO1 and Digital input1 - shared common ground (Group 1)

B. FODO2 and FODO3 - shared common ground (Group 2)
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Figure 5-11: CPU Module - Frequency/Digital outputs common ground - Type 4

A. FODO1 and DI1/FODO6 - shared common ground - Type 4 CPU Module (Group 1)

B. FODO2, FODO3, FODO4 and FODO5 - shared common ground - Type 4 CPU Module
(Group 2)

5.4 Configure frequency outputs
The Frequency Outputs allows you to configure the available frequency outputs for the
meter.

If you previously configured one or more Frequency/Digital outputs make selections for
the following parameters.

Content:

• Valid outputs are based on Uncorrected (Actual) flow rates or on Corrected (Standard)
flow rates. If pressure or temperature is set to Not used, or the Base condition
correction is cleared on the Startup Page, the Corrected (Standard) option will not be
available.

• Rosemount ™ Gas Ultrasonic meters will also allow you to set the outputs for Average
Flow Velocity, Average Sound Velocity, Energy Rate, and Mass Rate.

Direction:

• Reverse: The output only reports flow in the reverse direction. For frequency outputs,
Phase B of the output is 90 degrees out of phase with Phase A.

• Forward: The output only reports flow in the forward direction. For frequency outputs,
Phase B of the output is 90 degrees out of phase with Phase A.

• Absolute: The output reports flow in both directions. For frequency outputs, Phase B of
the output is 90 degrees out of phase with Phase A.

• Bidirectional: The output reports flow on Phase A only in the forward direction and on
Phase B only in the reverse direction.
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Maximum frequency output:

• Valid frequency output options are 1000 Hz and 5000 Hz.

The following fields are used to configure the frequency outputs selected to output a
volumetric flow rate. The fields are only enabled if the associated output's Content is set to
Uncorrected (Actual) or Corrected (Standard).

Full scale volumetric flow rate used with output:

• Enter the flow rate to be equivalent to the maximum frequency of the frequency
output. This property is disabled if Frequency outputs was cleared on the Startup Page.

K-factor:

A read-only value showing the calculated K-factor from the Full scale volumetric flow rate
used with frequency outputs and the Maximum frequency for frequency output. This
property is disabled if Frequency outputs was cleared on the Startup Page.

Vol/pulse:

A read-only value showing the calculated inverse of the K-factor. This property is disabled
if Frequency outputs was cleared on the Startup Page.

Velocity:

• Maximum scale velocity used with output: Enter the velocity to be equivalent to the
maximum frequency of the frequency output. These values are only enabled if the
Content is set to Average flow velocity or Average sound velocity. This property is
disabled if Frequency outputs was cleared on the Startup Page.

• Minimum scale velocity used with output: Enter the velocity to be equivalent to the
minimum frequency (i.e. 0Hz) of the frequency output. These values are only enabled if
the Content is set to Average flow velocity or Average sound velocity. This property is
disabled if Frequency outputs was cleared on the Startup Page.

Energy Rate:

The following fields are used to configure the frequency or current outputs selected to
output an energy rate. The fields are only enabled if the associated output's Content is set
to Energy rate.

• Full scale energy rate used with output: Enter the energy rate to be equivalent to the
maximum frequency of the frequency output.

• Energy/pulse: A read-only value showing the calculated inverse of the K-factor. Each
frequency output has its own register.

Mass Rate:

• The following fields are used to configure the frequency outputs selected to output a
mass rate. The fields are only enabled if the associated output's Content is set to Mass
rate.

• Full scale mass rate used with output: Enter the mass rate to be equivalent to the
maximum frequency of the frequency output.

• Mass/pulse: A read-only value showing the calculated inverse of the K-factor. Each
frequency output has its own register.

Operations Manual Configurations
00809-1100-3104 April 2022

Rosemount 3410 Series Gas Ultrasonics Flow Meters 57



5.5 Configure digital input/outputs
Digital input

The Rosemount 3410 Gas Ultrasonic Flow Meters provides one digital input (referred to as
DI1). The polarity of the input is configured via the DI1IsInvPolarity data point as follows:

• FALSE - normal polarity (default setting), or

• TRUE - inverted polarity

The digital input is not configurable via the MeterLink Field Setup Wizard. It must be
configured via the MeterLink Tools → Edit/Compare Configuration.

The value of the input is accessible via the DI1 data point.

Digital input calibration

The IsDI1UsedForCal specifies whether digital input 1 (DI1) is used for general purpose
(when set to FALSE) or for synchronizing calibration (when set to TRUE). If used for
calibration, the polarity is determined by the IsDI1ForCalActiveLow data point select one
of the following:

• FALSE - general purpose (default setting), or

• TRUE - for synchronizing calibration

The IsDI1ForCalActiveLow data point specifies the polarity for digital input 1 (DI1) when it
is configured (via IsDI1UsedForCal) for use in synchronizing a calibration. See also
IsDI1ForCalStateGated.

• FALSE = Cal Active High

• TRUE = Cal Active Low (default)

The IsDI1ForCalStateGated data point specifies the calibration gating for digital input 1
(DI1) when it is configured (via IsDI1UsedForCal) for use in synchronizing a calibration.
When FALSE, the calibration is started/stopped via an inactive->active edge; when TRUE,
the calibration is started via an inactive->active state change and stopped via an active-
>inactive state change. The active edge/state is specified via the IsDI1ForCalActiveLow
data point.

• FALSE = Cal Edge Gated (default)

• TRUE = Cal State Gated

For detailed digital proving configuration, refer to Flow calibration.

Digital output

Select the function for which the digital output should be configured. Available options are
validity and direction.

The inverted operation option is useful if the output of the ultrasonic meter is reversed
from what a flow computer is expecting. This means that if the output normally outputs a
HIGH for a TRUE condition, selecting this checkbox will change the output to output a
LOW for a TRUE condition.
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5.6 Outputs test mode
The Rosemount 3410 Gas Ultrasonic Flow Meters provides a mode of operation for testing
the frequency, current (analog) and digital output signals. Entering, configuring, and
exiting this mode is accomplished by setting data points using the MeterLink Tools →
Outputs Test.

Figure 5-12: Meter Outputs Test page

Note
The AO2 is only available with CPU module, part number 1-360-03-010.

The Outputs Test dialog box allows you to monitor the live values of all the frequency,
current (analog) and digital outputs. Additionally the outputs can be set into a Test mode
to force the outputs to a specific user defined value. This dialog box is only available while
connected to a meter.

When the dialog box first opens, the available Outputs show the current "Live" values the
outputs are driving. The LED Test mode will remain gray while not in Test mode.
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To fix the frequency and current outputs to a user-defined value, enter the desired
percentage of full-scale into the Output setting. For Rosemount 3410 Gas Ultrasonic Flow
Meters, each available output has individual output control and can be set from 0 to 150%.
The 100% Scaling indicates the full scale value for the frequency outputs and can be
changed from the Field Setup Wizard.

Click the Start button to enter Test mode. Each output has its own start button, so each
available output can be tested one at a time. The frequency and current outputs will not
be updated until the end of the next batch cycle. Once the Test mode LED turns green, the
output values displayed represent the values the outputs are driving under test.

The frequency outputs for both the A and B channels are displayed. If Channel B zero on
error is selected in the Field Setup Wizard the Channel B phase will show zero because the
frequency output is considered invalid during test mode.

The K-Factor and Inverse K-Factor will be displayed for the frequency outputs configured
for Volumetric flow rate. The values will be displayed next to the label for the associated
frequency output.

To set the digital outputs to a known state, select the Test High or Test Low for the
appropriate digital output and click the Start button for the digital output. Once the Test
mode LED turns green, the value displayed for the outputs will represent the values the
outputs are driving under test.

The timeout for each output in test mode is reset by MeterLink each time the values are
updated. As long as this dialog is open with an output in test mode, the output will remain
in test mode or until the Stop button is clicked to end the test.

In the event communications are lost between MeterLink and the meter (before a test
mode is stopped), the meter will automatically end the test mode after the
NonNormalModeTimeout has expired. This can be from 1 to 30 minutes depending on its
settings. By default, the timeout is set to two minutes.

The Output setting can only be changed while out of Test mode. To end the Test mode,
click Stop and wait for the end of the batch and the Test mode LED to turn gray to indicate
the Outputs are driving live values.

Click Cancel to close the dialog box. If the meter is currently in Test mode when Cancel is
clicked, MeterLink will first end the test mode before returning to the Main Screen.

5.7 Configure HART outputs
Configure the HART outputs of the Rosemount Ultrasonic meter. For additional
information refer to the HART Field Device Specification Manual (00825-0400-3240).

5.7.1 Configure the four dynamic variables
• Primary - set to match the Content for Current Output 1

• Secondary - set to match the Content for Current Output 2

• Third - select from the following variables: Uncorrected flow rate, corrected flow rate,
Average flow velocity, Energy flow rate, Mass flow rate Pressure and Temperature
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• Fourth - select from the following variables: Uncorrected flow rate, corrected flow rate,
Average flow velocity, Energy flow rate, Mass flow rate Pressure and Temperature

5.7.2 Configure the device identification
Configure the common variables in HART devices used to identify the particular device.

• Tag - the tag name for the HART device which may be used by host systems to uniquely
identify the meter. The tag may be up to 8 characters in length.

• Long tag - the specified long tag matches that of the meter. The tag may be 32 bytes in
length.

• Date - a 3 byte value where the most significant byte is the day of the month (1-31), the
second byte is the month of the year (1-12), and the third byte is the year-1900.

• Message - a string value that can be no more than 32 characters in length.

• Descriptor - a string value that can be no more than 16 characters in length.

• Final assembly number - a numeric value that must be between 0 and 1677215.

• Polling address - the HART address for the meter. By default the meter is 0 but the
address can range from 0 to 63.

5.7.3 Configure the HART units
Configure the units that values will be read in over the HART interface.

• Volume units

• Mass units

• Energy units

• Flow rate time units

• Velocity

• Pressure

• Temperature

5.8 Configure meter corrections
Meter profile corrections are used for Rosemount™ 3411 and 3412 Ultrasonic Flow meters
only as shown in Flow profile correction, Temperature expansion correction and Pressure
expansion correction.

5.8.1 Flow profile correction
Select the profile correction; Fixed, Calculated or Default.

• If Live or Fixed is selected on the MeterLink Startup page, for both temperature and
pressure enter a value from 0.9 to 1.0 for Fixed correction factor.
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• If Not used was selected for either temperature or pressure on the Startup Page, then
choose from Fixed or Default for a correction factor. Calculated will be disabled. Enter a
value from 0.9 to 1.0 for Fixed correction factor.

• Default - The default value is 0.95.

5.8.2 Temperature expansion correction
• Linear expansion coefficient of the meter body material.

• Linear expansion coefficient reference temperature.

5.8.3 Pressure expansion correction
• Pipe outside diameter: enter the outside diameter of the meter body.

• Young's modulus: enter the Young's Modulus value (ratio of tensile stress to tensile
strain).

• Poisson's ratio: enter the Poisson's Ratio value (the absolute ratio of the pipe material
lateral strain over axial strain).

5.9 Configure temperature and pressure

5.9.1 Flow-condition pressure and temperature
The flow-condition pressure and temperature are used by the Rosemount 3410 Series Gas
Ultrasonic Flow Meter for various calculations such as:

• Expansion correction

• Flow profile correction (JuniorSonic™ meters only)

• Calculation of base (standard) condition volumetric flow rate and volumes

• Optional AGA10 sound velocity calculation

Configuration

The flow-condition pressure and temperature are individually configurable (via the
EnablePressureInput and EnableTemperatureInput data points) to be:

• Disabled (0),

• Live (1) (4-20 mA input signal)

• Fixed (2)

If an input is live, then the values corresponding to the minimum and maximum input (4
and 20 mA, respectively) are specified via data points (MinInputPressure,
MaxInputPressure, MinInputTemperature, MaxInputTemperature).

If an input is fixed, then its value is specified via a data point (SpecFlowPressure,
SpecFlowTemperature).
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Alarm limits can be specified for each input (LowPressureAlarm, HighPressureAlarm,
LowTemperatureAlarm, HighTemperatureAlarm). Additionally, the flow-condition
pressure is configurable to be gage or absolute (via the InputPressureUnit data point). If
the pressure is gage, then the atmospheric pressure must be specified (via the
AtmosphericPress data point). See Configure the temperature parameters for the meter
and Configure the pressure parameters for the meter for details on configuring the flow-
condition pressure and temperature.

Another data point (FlowPOrTSrcUponAlarm), common to both pressure and
temperature, is used to specify the data source to use when the selected input data is
invalid (i.e., value at or outside its alarm limits or a live input in calibration) as either:

• Last good value (0), or

• Fixed value (1).

This data point (FlowPOrTSrcUponAlarm) is configurable via the MeterLink Field Setup
Wizard → Temperature and Pressure page under Alarm Selection. It is also configurable
via the MeterLink Tools → Edit/Compare Configuration screen. The default is to use the
last good value.

Data updates

The Rosemount 3410 Series Gas Ultrasonic Flow Meter samples the input analog signal(s)
and updates the corresponding data point(s) (LiveFlowPressure, LiveFlowTemperature)
once per second regardless of the input selection (disabled, live, ).

Every five seconds, the meter updates the "in-use" flow-condition pressure and
temperature values (FlowPressure, AbsFlowPressure, FlowTemperature) depending
upon the input selection, validity of the input data, and the selected data source upon
alarm according to Table 5-7.

Table 5-7: Flow-condition pressure and temperature data source

Input Type
(EnablePressureInput
or
EnableTemperaturein
put)

Data Validity
(PressureValidity or
TemperatureValidity)

Data Source Upon
Alarm
(FloePOrtSrcUponA
larm)

"In-Use" Data Source
(FlowPressure or
FlowTemperature)

Disabled N/A N/A "In-Use" value unchanged

Live Valid N/A Average of live values
(LiveFlowPressure or
FlowTemperature)

Invalid(1) Last good value "In-Use" value unchanged

Fixed Fixed data point
(SpecFlowPressure or
SpecFlowTemperature)

Fixed Valid N/A Fixed data point
(SpecFlowPressure or
SpecFlowTemperature)

Invalid Last good value "In-Use" value changed
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Table 5-7: Flow-condition pressure and temperature data source (continued)

Input Type
(EnablePressureInput
or
EnableTemperaturein
put)

Data Validity
(PressureValidity or
TemperatureValidity)

Data Source Upon
Alarm
(FloePOrtSrcUponA
larm)

"In-Use" Data Source
(FlowPressure or
FlowTemperature)

Fixed Fixed data point
(SpecFlowPressure or
SpecFlowTemperature)

(1) Live input can be invalid due to (a) one or more live values is/are at or outside the alarm limits, or
(b) the input is being calibrated.

The flow-condition absolute flow pressure is calculated as shown in Flow-condition
absolute pressure.

Equation 5-6: Flow-condition absolute pressurePabs, f = Pf+PAtmospℎereInputPressureUnit = FALSE GagePabs, f = PfInputPressureUnit = TRUE Absolute
where

Pabs,f = flow-condition absolute pressure (MPaa) (AbsFlowPressure)
Pf = flow-condition pressure (MPa if InputPressureUnit=FALSE, MPaa if
InputPressureUnit=TRUE) (FlowPressure)
PAtmosphere = (specified) atmospheric pressure (MPaa) (AtmosphericPress)

5.9.2 Configure the temperature parameters for the meter
• Live temperature - if Live Analog was selected for Temperature for meter corrections on

the MeterLink Startup Page, enter the scaling for the transmitter connected to the
analog input. Minimum input is the zero scale temperature of the transmitter (i.e. 1
Volt or 4mA). Maximum input is the full scale temperature of the transmitter (i.e. 5
Volts or 20 mA).

• Fixed temperature - If Fixed was selected on the MeterLink Startup Page for
Temperature It will also be enabled if a live temperature input was selected. Enter a
fixed value to use for calculations if the live input goes into alarm. Enter an average
temperature of the process fluid.

• Temperature alarm - Enter the low and high alarm limits. A temperature reading
outside of these limits causes a Temperature Validity alarm. The Alarm selection
determines what value to use while a live input is in alarm. This value is common with
the pressure Alarm selection so when one is changed, the other will change to match.

5.9.3 Configure the pressure parameters for the meter
• Pressure reading - Select either Gage or Absolute for the type of pressure reading

desired. If a live pressure transmitter is connected, select the type of reading the
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transmitter outputs. If Absolute is selected, you must also enter the Atmospheric
pressure.

• Live pressure - Enter in the scaling for the transmitter connected to the analog input.
Min. input is the zero scale pressure of the transmitter (i.e. 1 Volt or 4mA). Max. input is
the full scale pressure of the transmitter (i.e. 5 Volts or 20 mA).

• Fixed pressure - Enabled if Fixed was selected for Temperature for meter corrections on
the Startup Page. It will also be enabled if a live temperature input was selected to
allow you to enter a fixed value to use for calculations if the live input goes into alarm.
Enter an average pressure of the process fluid.

• Pressure alarm - Enter the low and high alarm limits. A pressure reading outside of
these limits causes a Pressure Validity alarm. The Alarm selection determines what
value to use while a live input is in alarm. This value is common with the temperature
Alarm selection so when one is changed, the other will change to match.

5.10 Configure Gas Chromatograph parameters
Use the Meter → Field Setup Wizard menu and enable the View Gas Chromatograph
setup checkbox. Configure the following parameters to setup a port as a Modbus master
for polling a GC.

• Port - Select which port will be connected to the GC. While a serial port is configured for
communications to a GC, it will not act as a Modbus slave device for communications
from MeterLink or a SCADA system. USM can also poll a gas chromatograph using
Modbus TCP/IP. Choose Port as Ethernet.

• GC protocol - Select the protocol for which the GC is configured. The Rosemount Gas
Ultrasonic meter uses 7 data bits, Even parity, and 1 stop bit for ASCII Modbus and 8
data bits, No parity, and 1 stop bit for RTU Modbus. This option will be enabled only
when a serial port is selected.

• GC baud rate - Select the baud rate for which the GC is configured. This option will be
enabled only when a serial port is selected.

• GC comms address - Enter the Modbus ID of the GC.

• GC IP address - enter the IP address of the GC. This option is only enabled when Port is
selected as Ethernet.

• GC TCP/IP port number - enter Modbus TCP/IP port number of the GC. This option is
only enabled when Port is selected as Ethernet.

• GC stream number - Enter the stream number for the gas composition the Rosemount
Gas Ultrasonic meter will read.

• GC heating value units - Select the units for which the heating value is configured in the
GC.
— Btu/ft3

— kJ/m3

— kJ/dm3

— MJ/m3
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— kCal/m3

— kWh/m3

• GC heating value type - Select the type of heating value the GC will return.
— Btu-Dry

— Btu-Saturated

— Btu-Actual

• Gas composition on GC alarm - Select which gas composition the Rosemount Gas
Ultrasonic meter will use if the GC goes into alarm.
— Fixed - if selected, the meter will start using the fixed gas composition stored in the

meter.

— Last Good Value - if selected, the meter will use the last gas composition collected
from the GC before the GC started to report alarms.

5.10.1 Gas properties
Gas property data (composition and heating value) are used by the meter for AGA8
calculations (for converting to base or standard volumes and for mass calculation), for
energy calculation, and for optional AGA10 calculations (sound velocity calculation and
comparison).

The data are also used by JuniorSonic™ meters when the profile correction factor is to be
calculated by the meter (rather than fixed or a default value). See Table 5-12 for GC
registers polled by the meter. The gas property data can either be fixed (specified via data
points) or optionally read from a Rosemount™ Gas Chromatograph (GC). Reading the gas
property data from a GC requires a valid GC feature key (See GC interface key). Use the
Field Setup Wizard in MeterLink™ to configure these parameters.

Fixed gas property data

If the data is fixed, then the heating value and its reference temperature are specified via
the MeasVolGrossHeatingVal and RefTemperatureHV data points, respectively; the gas
components are specified via the data points listed in Table 5-8 below. Fixed gas property
data is always assumed to be valid.

NOTICE

If the gas composition is specified from within MeterLink, the data point's unit is mole
percentage, not mole fraction (as the data point name would imply).

Table 5-8: Fixed gas composition data points

Gas composition data points

MoleFractionN2Method2

MoleFractionCO2

MoleFractionH2

MoleFractionCO

MoleFractionMethane
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Table 5-8: Fixed gas composition data points (continued)

Gas composition data points

MoleFractionEthane

MoleFractionPropane

MoleFractionIsoButane

MoleFractionNButane

MoleFractionIsoPentane

MoleFractionNPentane

MoleFractionNHexane

MoleFractionNHeptane

MoleFractionNOctane

MoleFractionNNonane

MoleFractionNDecane

MoleFractionH2S

MoleFractionHelium

MoleFractionWater

MoleFractionOxygen

MoleFractionArgon

Live (GC) gas property data

The purpose of this section is to give a brief overview of the gas property data read from a
GC. Refer to MeterLink utilities for information on configuring the Rosemount 3410 Series
Gas Ultrasonic Flow Meter (using the MeterLink program) for communicating with a
Rosemount GC.

If the gas components are read from the GC, then the GC-reported heating value is
readable via the HeatingValueGC data point. Note that type of heating value to be read
from the GC must be specified via the GCHeatingValueType data point as either Btu-Dry,
Btu-Saturated, or Btu-Actual. So that the correct GC register is read. Also, the heating
value unit must be specified via the GCHeatingValueUnit data point as either Btu/ft3,
kJ/m3, kJ/dm3, MJ/m3, kCal/m3, or kWh/ m3. The GC-reported gas composition is readable
via the data points listed in Table 5-9 below:

Table 5-9: GC-reported gas composition data points

GC reported composition data points

N2GC

CO2GC

H2GC

COGC

MethaneGC
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Table 5-9: GC-reported gas composition data points (continued)

GC reported composition data points

EthaneGC

PropaneGC

IsoButaneGC

NButaneGC

IsoPentaneGC

NPentaneGC

NHexaneGC

NHeptaneGC

NOctaneGC

NNonaneGC

NDecaneGC

H2SGC

HeliumGC

WaterGC

OxygenGC

ArgonGC

C6PlusGC (C6PlusGCComponentID)

NeoPentaneGC

The validity of the GC-read gas property data is readable via the
AreGasPropertiesInvalidGC data point where TRUE(1) indicates invalid data and FALSE(0)
indicates valid data. Refer to GC data validity for further information on how the data
validity is determined.

In-Use gas property data

The "In-Use" gas property data is the actual data used by the meter for calculations.

The GasPropertiesSrcSel data point is used to select the gas property data source as either
Fixed (0) or Live - GC (1). If the data source is Live - GC and the GC-read data is invalid, then
the GasPropertiesSrcSelGCAlarm data point is used to select the data source as either Last
good value (0) or Fixed value (1). When Last good value is selected, the "In-Use" gas
property data is not updated with the invalid GC-read gas property data. When Fixed value
is used, the "In-Use" gas property data is updated with the fixed gas property data.

The meter maps the appropriate input gas property data points (fixed or GC-reported as
discussed above) to the corresponding "In-Use" data points (the HeatingValueInUse data
point and the gas composition data points listed in the Table 5-10 below).
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Table 5-10: In-Use gas composition data points

"In-Use" gas composition data points

N2InUse

CO2InUse

H2InUse

COInUse

MethaneInUse

EthaneInUse

PropaneInUse

IsoButaneInUse

NButaneInUse

IsoPentaneInUse

NPentaneInUse

NHexaneInUse

NHeptaneInUse

NOctaneInUse

NNonaneInUse

NDecaneInUse

H2SInUse

HeliumInUse

WaterInUse

OxygenInUse

ArgonInUse

The fixed gas component data points map directly to the corresponding "In-Use" gas
component data points. The GC-reported gas component data points map directly to the
corresponding "In-Use" gas component data points except for the C6PlusGC and
NeoPentaneGC components. The C6PlusGC quantity is divided among the
NHexaneInUse, NHeptaneInUse, and NOctaneInUse data points according to the
component ID (C6PlusGCComponentID) as listed in Table 5-11 below:

Table 5-11: C6+ breakdown to standard components by component ID

C 6 + Component ID
(C6PlusGCComponent
ID)

Percentage to
NHexaneInUse

Percentage to
NHeptaneInUse

Percentage to
NOctaneInUse

108 47.466 35.340 17.194

109 50.000 50.000 0.000

110 60.000 30.000 10.000

111 57.143 28.572 14.285
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For example, if the C6PlusGC mole percentage is 1% and its component ID is 110, then 60%
of the C6+ mole percentage (0.60x1%=0.60%) is added to NHexaneInUse, 30%
(0.30x1%=0.30%) is added to NHeptaneInUse, and 10% (0.10x1%=0.10%) is added to
NOctaneInUse.

The GC-reported NeoPentane component (NeoPentaneGC) quantity is added to the
IsoPentane component (IsoPentaneInUse).

The validity of the "In-Use" gas property data is readable via the
AreGasPropertiesInvalidInUse data point where TRUE(1) indicates invalid data and
FALSE(0) indicates valid data. The validity of the "In-Use" gas property data is a function of
the validity of the selected source data. If the source data is selected as Fixed, then the "In-
Use" gas property data is valid (since the fixed data is assumed to be valid). If the source
data is selected as Live - GC, then the "In-Use" gas property data is valid only if the GC-read
gas property data is valid.

Optional gas chromatograph interface

The Rosemount 3410 Series Gas Ultrasonic Flow Meter can optionally interface with any
Rosemount gas chromatograph (GC) that supports the SIM 2251 mode to read gas
property data (such as for AGA8, AGA10, energy rate, mass rate, and/or profile correction
calculations).

NOTICE

The gas chromatograph interface is an optional feature that requires a valid GC feature
key. Refer to GC interface key.

The following table lists the Gas Chromatograph SIM registers polled by the meter. Also
refer to Rosemount Engineering Specification Part Number ES-17128-005 Rev. B.

Table 5-12: Gas chromatograph Sim 2251 Registers

Sim 2251 Register Description

3034 Stream identifier

3041 Cycle time start - month(1-12)

3042 Cycle time start - day(1-31)

3043 Cycle time start - last two year digits

3044 Cycle time start - hour(0-23)

3045 Cycle time start - minutes(0-59)

3046 GC alarm bitmap 1

3047 GC alarm bitmap 2

3001 - 3016 Component codes

7001 - 7016 Mole fractions for corresponding component codes

7033 BTU (dry)

7034 BTU (sat)

7035 Specific gravity
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Table 5-12: Gas chromatograph Sim 2251 Registers (continued)

Sim 2251 Register Description

7038 Total unnormalized mole percent

7054 BTU (actual)

Table 5-13: Supported Components IDs

Component IDs

METHANE (100)

CO2 (117)

PROPANE (102)

H2S (140)

CO (115)

IBUTANE (103)

IPENTANE (105)

NHEXANE (139)

NOCTANE (152)

NDECANE (150)

ARGON (146)

C6PLUS_COMP_ID_1 (108)

C6PLUS_COMP_ID_3 (110)

NITROGEN (114)

ETHANE (101)

H20 (144)

HYDROGEN (112)

O2 (116)

NBUTANE (104)

NPENTANE (106)

NHEPTANE (145)

NNONANE (151)

HELIUM (113)

NEO_PENTANE (107)

C6PLUS_COMP_ID_2 (109)

Note
Gas Component IDs can be configured using “Gas Chromatograph Component Data”
page in Field Setup Wizard of the MeterLink. This allows USM to read gas properties from
GC system, which support different component IDs.
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Gas property data
The gas property data read from the GC includes gas composition, heating value, and
specific gravity (relative density).

The gas composition includes the 21 standard components plus C6+ and Neopentane (see
Table 5-9 for a list of data point names). Refer to In-Use gas property data for further
information on how the GC-read gas properties are mapped to the 'in-use' gas property
data points.

The GC-read heating value and specific gravity are stored in the HeatingValueGC and
SpecificGravityGC data points, respectively.

Data polling
The meter periodically polls the GC looking for data updates. If the meter is
communicating normally with the GC, then it polls the GC every one minute looking for an
update (i.e., a change in the GC analysis time). Otherwise, the meter polls the GC every 15
seconds.

When the meter determines that a GC update is available for the specified stream number,
it then reads the GC data using multiple reads one second apart until all the data is read.
The GC analysis time is read again at the end of the data collection to determine if another
update occurred during the data collection (i.e., the data is not all from the same update).
If so, the meter discards the gas property data just read and begins looking immediately
for the next update.

If the meter cannot successfully communicate with the GC after four consecutive polls (15
seconds apart), then the meter indicates the communication alarm via the IsGCComErr
data point with the GCCommStatus data point indicating an error code (listed in Table
5-14 below).

Table 5-14: GC Communications status list

GCComm status value Error description

0 No error.

1 Desired stream not found.

2 GC controller is busy (error defined by Modbus protocol).

3 GC detected an illegal Modbus function code from the meter.

4 GC detected an illegal Modbus data address from the meter.

5 GC detected an illegal data value from the meter.

6 Failure in associated device (Modbus defined error).

7 GC has accepted the meter's request but is still processing.

8 A firmware logic error was detected.

9 Modbus address mismatch.

10 Modbus function code mismatch.

11 GC reports an exception code that is unrecognized.
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Table 5-14: GC Communications status list (continued)

GCComm status value Error description

12 The meter's Modbus request message is too long (exceeds the
maximum allowable length).

13 The GC's Modbus response message is too long (exceeds the
maximum allowable length).

14 GC response message has incorrect number of registers.

15 GC does not support the requested message data type.

16 GC does not support the requested data protocol.

17 The meter's Modbus request message (RTU protocol) is too
long (exceeds the maximum allowable length).

18 GC response not received within the communication timeout.

19 GC response message (ASCII protocol) incomplete.

20 GC response message (RTU protocol) incomplete.

21 GC gas property data spans more than one update.

22 Server port not open. Gateway path not available or target
device failed to respond.

23 GC IP address incorrect.

GC data validity
The GC-read gas property data validity is indicated by the AreGasPropertiesInvalidGC data
point. The data is considered invalid if any of the conditions listed in Table 5-15 is true.
These conditions are indicated by the MeterLink Monitor page Field I/O indicator.

Table 5-15: GC-read gas property invalid conditions

Indication Data Point Condition

IsGCAlarmPresent GC reported alarm (GC Alarm1 bits 14 and/or 15 set, GC Alarm2 bits 0, 1,
2, and/or 3 set).

IsGCWarningPresent Not presently used - reserved for future use.

IsGCCommErr The meter is not able to communicate successfully with the GC. Refer to
communication error conditions listed in Table 5-14.

IsGCDataErr The total unnormalized gas composition mole percentage of all the gas
components read from the GC is not within [85%, 115%].

An individual gas composition mole percentage is not within [0%, 100%].

The specific gravity is not within the range of [0.2, 0.8].

The heating value is greater than 50 kJ/dm3.

Specified gas stream (GCStreamNumber) not found within the specified
period (GCDesiredStreamTimeout).

Invalid GC feature key (GC interface key) Port improperly configured
(such as if configured without using the MeterLink Field Setup Wizard).

Operations Manual Configurations
00809-1100-3104 April 2022

Rosemount 3410 Series Gas Ultrasonics Flow Meters 73



GC alarm handling
The following data points are included in the meter's alarm log (See Event log: alarm/
audit): AreGasPropertiesInvalidGC, IsGCAlarmPresent, IsGCCommErr, GCCommStatus,
and IsGCDataErr.

5.10.2 Configure AGA8 parameters
Configure the properties necessary for the AGA8 calculations.

How the AGA8 calculations to be performed:

• Internally by the meter - calculates the flow mass density, the flow compressibility and
the base compressibility.

• Externally - calculations are done externally. The calculated values must then be written
to the meter using MeterLink™ or a flow computer.

AGA8 method

• Gross Method 1

• Gross Method 2

• Detail Method - enter the amount of each of the 21 gas components as a percentage.

• GERG-2008

Gas composition

• Fixed - use the fixed gas composition stored in the meter for all calculations.

• Live GC - use a gas composition collected by the meter from a gas chromatograph for
all calculations. This option is only available with a GC key or is enabled with the
Continuous Flow Analysis key.

• Configure the Gas properties for the gas chromatograph

• Base temperature

• Base pressure

• Specific gravity

• Specific gravity reference temperature

• Specific gravity reference pressure

• Volumetric gross heating value

• Volumetric gross heating value reference temperature

• Molar density reference temperature

• Molar density reference pressure

• Flow mass density(1)

• Flow compressibility(1)

(1) If a flow computer or SCADA system is used to write these values to the meter, they do not have to be entered at this time.
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• Base compressibility(1)

5.10.3 Configure Continuous Flow Analysis parameters
Configure the Continuous Flow Analysis features of the Rosemount Ultrasonic meter. This
MeterLink™ Field Setup Wizard page is displayed only if the View Continuous Flow Analysis
setup was selected on the Startup Page and you have a valid Continuous Flow Analysis key.

These features require that the meter baseline be set using the Tools → Set Baseline
Wizard.

• Flow limits - low and high flow velocity limits.

• SOS comparison - compares the meter average speed of sound to the AGA 10
calculated speed of sound. SOS comparison is also performed when AGA8 method is or
GERG-2008.

• Liquid detection - identifies when liquids may be present in the bottom of the meter run
base on the meter's flow characteristics.

• Abnormal profile - identifies if the meter flow profile has shifted from the original
baseline profile of the meter.

• Blockage - identifies a possible blockage of an upstream flow conditioner.

• Internal bore buildup - indicates that the flow characteristics have changed indicating a
build up on the internal bore of the meter.

Set baseline parameters
Select the direction to baseline and what data to use to perform the baseline. The wizard
will step you through setting a baseline in one direction.

It is necessary to baseline the meter in both directions if the meter will be operating in a bi-
directional application. For meters only operating in a uni-directional application, the
meter only needs one baseline. The status message displayed on the Meter monitor
screen about the baseline not being set can simply be acknowledged to clear the alarm for
a flow direction you do not want to baseline.

Setting baselines in two directions is only necessary if the meter is installed in a bi-
directional application. Flow through the meter in one direction can be quite different
from flow through a meter in the opposite direction. This could be because of flow
conditioners, thermowells, or elbows.

• Select baseline flow direction - forward or reverse

• Select baseline data source
— 1-minute averages from the meter - the preferred option when setting the baseline

for a new meter. The meter must be under typical flowing conditions when the
baseline is set.

— Maintenance log - if the meter has already been installed in the field for a period of
time and a MeterLink maintenance log is available from the initial startup that was
taken during normal flowing conditions.
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— Manual entry - manually enter data for each of the parameters. This could be used
to modify a single parameter for a baseline already set or it could be to enter data
from a historical record from when the meter was first put into service.

Configure the Local Display
Configure the parameters for the local display.

Use the drop-down arrow in the Display Items list box and select or modify the parameters
that will be displayed; the Display items, the Display units and the Scroll delay.

Important
When connected to a meter with the local display option, reverse flow direction is
indicated with a minus sign (negative) before the value(s) shown on the local display.

Figure 5-13: Field Setup Wizard - Local Display

Mode

Select Scroll items 1-10 or Uncorrected volume only. The default value is Scroll items 1-10.
Scroll items 1-10 mode, allows selection of up to ten data points to be displayed on the
local display. In Uncorrected volume only mode, the display will only alternate between
the forward and reverse uncorrected volume in units of cubic meters in compliance with
OIML R-137-1 and the European MID directive. Depending on the size of the meter, the
value displayed in the Uncorrected volume only mode will be X 10 cubic meters or X 100
cubic meters as indicated on the display in the bottom line.
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Display items and display units

Display units - Meter volume units displayed are either U.S. Customary or Metric. The Meter
volume units displayed reflect the meter's units selected on the File → Program Settings
dialog (e.g. U.S. Customary or Metric units). Configure the Meter volume units for U.S.
Customary selections:

• Cubic feet,

• Thousand cubic feet

Or

Metric unit selections are:

• Cubic meters

• Thousand cubic meters

Configure the Flow rate time units:

• Second

• Hour

• Day
Display units preceded by a plus or minus sign indicate forward and reverse flow
direction, as shown in the table below.

Table 5-16: Local display labels, descriptions and valid units

Local display labels, descriptions and valid units

QFLOW - Uncorrected volume flow rate
— ACF - Actual Cubic Feet

— ACM - Actual Cubic Meters

— MACF - Thousand Actual Cubic Feet

— MACM - Thousand Actual Cubic Meters

TDYVL - Current day's forward uncorrected volume
— +ACF - Actual Cubic Feet

— +ACM - Actual Cubic Meters

— +MACF - Thousand Actual Cubic Feet

— +MACM - Thousand Actual Cubic Meters

TDYVL - Current day's reverse uncorrected volume
— -ACF - Actual Cubic Feet

— -ACM - Actual Cubic Meters

— -MACF - Thousand Actual Cubic Feet

— -MACM - Thousand Actual Cubic Meters
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Table 5-16: Local display labels, descriptions and valid units (continued)

Local display labels, descriptions and valid units

YSTVL - Previous day's forward uncorrected volume
— +ACF - Actual Cubic Feet

— +ACM - Actual Cubic Meters

— +MACF - Thousand Actual Cubic Feet

— +MACM - Thousand Actual Cubic Meters

YSTVL- Previous day's forward uncorrected volume
— -ACF - Actual Cubic Feet

— -ACM - Actual Cubic Meters

— -MACF - Thousand Actual Cubic Feet

— -MACM - Thousand Actual Cubic Meters

TOTVL - Forward uncorrected volume
— +ACF - Actual Cubic Feet

— +ACM - Actual Cubic Meters

— +MACF - Thousand Actual Cubic Feet

— +MACM - Thousand Actual Cubic Meters

TOTVL - Reverse uncorrected volume
— -ACF - Actual Cubic Feet

— -ACM - Actual Cubic Meters

— -MACF - Thousand Actual Cubic Feet

— -MACM - Thousand Actual Cubic Meters

QBASE - Corrected volume flow rate
— SCF - Standard Cubic Feet

— SCM - Standard Cubic Meters

— MSCF - Thousand Standard Cubic Feet

— MSCM - Thousand Standard Cubic Meters

TDYVL- Current days forward corrected volume
— +SCF - Standard Cubic Feet

— +SCM - Standard Cubic Meters

— +MSCF - Thousand Standard Cubic Feet

— +MSCM - Thousand Standard Cubic Meters

TDYVL- Current days reverse corrected volume
— -SCF - Standard Cubic Feet

— -SCM - Standard Cubic Meters

— -MSCF - Thousand Standard Cubic Feet

— -MSCM - Thousand Standard Cubic Meters
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Table 5-16: Local display labels, descriptions and valid units (continued)

Local display labels, descriptions and valid units

YSTVL - Previous days forward corrected volume
— +SCF - Standard Cubic Feet

— +SCM - Standard Cubic Meters

— +MSCF - Thousand Standard Cubic Feet

— +MSCM - Thousand Standard Cubic Meters

YSTVL - Previous days reverse corrected volume
— -SCF - Standard Cubic Feet

— -SCM - Standard Cubic Meters

— -MSCF - Thousand Standard Cubic Feet

— -MSCM - Thousand Standard Cubic Meters

TOTVL - Forward uncorrected volume
— +SCF - Standard Cubic Feet

— +SCM - Standard Cubic Meters

— +MSCF - Thousand Standard Cubic Feet

— +MSCM - Thousand Standard Cubic Meters

TOTVL - Reverse uncorrected volume
— -SCF - Standard Cubic Feet

— -SCM - Standard Cubic Meters

— -MSCF - Thousand Standard Cubic Feet

— -MSCM - Thousand Standard Cubic Meters

VEL - Average flow velocity
— Ft/S - Feet per Second

— M/S - Meters per Second

SOS - Average sound velocity
— Ft/S - Feet per Second

— M/S - Meters per Second

TEMP - Flow-condition temperature
— DEGF - Degrees Fahrenheit

— DEGC - Degrees Celsius

PRESS - Flow-condition pressure
— PSI - Pound per square inch

— MPA - Megapascals

FRQ1A - Frequency channel 1A
— HZ - Hertz

Operations Manual Configurations
00809-1100-3104 April 2022

Rosemount 3410 Series Gas Ultrasonics Flow Meters 79



Table 5-16: Local display labels, descriptions and valid units (continued)

Local display labels, descriptions and valid units

FRQ1B - Frequency channel 1B
— HZ - Hertz

KFCT1 - Frequency 1K-factor
— CF - Cubic Feet

— CM - Cubic Meters

— MCF - Thousand Cubic Feet

— MCM - Thousand Cubic Meters

FRQ2A - Frequency channel 2A
— HZ - Hertz

FRQ2B - Frequency channel 2B
— HZ - Hertz

KFCT2 - Frequency 2K-factor
— CF - Cubic Feet

— CM - Cubic Meters

— MCF - Thousand Cubic Feet

— MCM - Thousand Cubic Meters

AO1- Analog Output 1 current
— MA- Miliamperes

AO2 - Analog Output 2 current
— MA- Miliamperes

Scroll delay - Time interval for the selected display items to be shown on the Local
Display. Use the spin buttons to increase or decrease the time interval.
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6 Directory

6.1 Archive logs
The Rosemount 3410 Series Gas Ultrasonic Flow Meters provides five types of data logs
(daily, hourly, audit, alarm, and system logs).

From Rosemount 3410 Series Firmware v1.42 and later, the meter can store up to 1825
daily records (5 years) and 4320 hourly records (180 days).

Each log type is discussed in detail below followed by MeterLink instructions to read (and
optionally save) meter log records (Options for reading daily and/or hourly log records).

6.1.1 Daily and Hourly log data points actions
Five different log data point actions are supported by the daily and hourly logs: snapshot,
average, flow-gated (average), totalize, and macro as described below:

• SNAPSHOT: causes the data point's value at the log time to be recorded.

• AVERAGE: causes the data point's average value over the log interval (day or hour) to
be recorded.

• FLOW_GATED: Average value of the data point over the log interval (day or hour) to be
recorded while the volumetric flow rate (QFlow) is above the volumetric flow rate
threshold (QCutOff). If the volumetric flow rate does not exceed the threshold during
the log interval, then the flow gated average of the data point is the same as the
average value of the data point over the log interval to be recorded.

• FLOW_ANALYSIS_GATED: Average of the data point over the log interval (day or hour)
to be recorded while the average flow velocity (AvgFlow) is between the diagnostic
flow analysis limits (FlowAnalysisLowFlowLmt and FlowAnalysisHighFlowLmt). If the
average flow velocity is not within the limits during the interval, then the flow analysis
gated average of the data point is the same as the average value of the data point over
the log interval to be recorded.

• TOTALIZE: causes the data point's accumulated value over the log interval (day or
hour) to be recorded.

• MACRO: causes the (boolean) data point's 'latched' value over the log interval (day or
hour) to be recorded. A (boolean) data point's latched value indicates if the point was
ever TRUE during the log interval (where a TRUE value is represented by a 1 and a FALSE
value is represented by a 0). This allows a group of boolean data points to be grouped
into a single integer value where each bit represents the latched value of a single
boolean data point.
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Daily log
The Rosemount 3410 Series Gas Ultrasonic Flow Meter stores a daily log record once per
day at the specified contract hour.

(Refer to the MeterLink Help files for information on specifying the ContractHour data
point.)

The user can select whether old, unread records can be overwritten by new records when
the log becomes full via the data point DoOverwriteUnreadDailyLog. This point can be
modified using the MeterLink Tools → Edit/Compare Configuration screen. The default is
to overwrite old, unread records. Refer to Options for reading daily and/or hourly log
records for information on reading records and marking records as read. The data point
IsDailyLogFull indicates whether or not the daily log is full and cannot overwrite old,
unread records.

The data points included in the daily log and the corresponding log action are as shown in
the table below. Data points required by the API Chapter 21 standard are marked with an
asterisk (*). For information on a particular data point, consult MeterLink online help (see
the help topic for any data point in MeterLink. Click Help → Gas 3410 Series Registers
Reference, select the Index tab, start typing the data point name until the desired point is
highlighted, and then click the Display button.)

Table 6-1: Daily log data points

Data point Content Log action

DailySMVResult SNAPSHOT

PosVolFlow TOTALIZE and
SNAPSHOT

NegVolFlow TOTALIZE and
SNAPSHOT

AccumFlowTime TOTALIZE

DailyMacro1 MACRO
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Table 6-1: Daily log data points (continued)

Data point Content Log action

bit 0

bit 1

bit 2

bit 3

bit 4

bit 5

bit 6

bit 7

bit 8

bit 9

bit 10

bit 11

bit 12

bit 13

bit 14

bit 15

bit 16

bit 17

bit 18

bit 19

bit 20

bit 21

bit 22

bit 23

bit 24

bit 25

bit 26

bit 27

bit 28

bit 29

bit 30

bit 31

IsQFlowInvalid

IsQBaseInvalid

IsMassRateInvalid

IsEnergyRateInvalid

IsEstimatedFlowVelocityInUse

IsTooFewOperChords

IsFwdBaselineNotSet

IsRevBaselineNotSet

IsGCDataErr

Un-used

IsAcqModuleIncompatible

IsHourlyLogFull

IsDailyLogFull

IsAuditLogFull

IsAlarmLogFull

IsSystemLogFull

IsXdcrFiringSyncError

IsColocMeterCommErr

IsGCCommErr

IsGCAlarmPresent

IsElecVoltOutOfRange

IsElecTempOutOfRange

DidCnfgChksumChg

DidPowerFail

IsAcqModuleError

IsAcqMode

DidColdStart

IsCorePresent

WatchDogReset

DI1

IsWarmStartReq

IsClkInvalid

DailyMacro2 MACRO
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Table 6-1: Daily log data points (continued)

Data point Content Log action

bit 0

bit 1

bit 2

bit 3

bit 4

bit 5

bit 6

bit 7

bit 8

bit 9

bit 10

bit 11

bit 12

bit 13

bit 14

bit 15

bit 16

bit 17

bit 18

bit 19

bit 20

bit 21

bit 22

bit 23

bit 24

bit 25

bit 26

bit 27

bit 28

bit 29

bit 30

bit 31

Un-used

Un-used

Un-used

AreGasPropertiesInvalidInUse

IsSndVelCompErr

IsReverseFlowDetected

IsAbnormalProfileDetected

IsLiquidDetected

IsBoreBuildupDetected

IsBlockageDetected

IsDiagnosticSndSpdRangeErr

Un-used

IsColocMeterSndSpdRangeErr

IsColocMeterQFlowRangeErr

DidWarmStart

Un-used

IsAnyLogFull

TemperatureInvalid

PressureInvalid

Un-used

IsChordLengthMismatched

IsXdcrMaintenanceRequired

IsSNRTooLow

IsPeakSwitchDetected

IsHardFailedD

IsHardFailedC

IsHardFailedB

IsHardFailedA

IsMeterVelAboveMaxLmt

IsAvgSoundVelRangeErr

IsMeasSndSpdRange

Un-used

DailyMacro3 MACRO

bits 0 - 3

bits 4 - 7

bits 8 - 11

bits 12 - 15

bits 16 -19

bits 20 - 23

bits 24 - 27

bits 28 - 31

IsChordLengthMismatched<A..D>

Un-used

IsBatchInactive<A..D>

Un-used

IsXdcrMaintenanceRequired<A..D>

Un-used

IsFailedForBatch<A..D>

Un-used

DailyMacro4
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Table 6-1: Daily log data points (continued)

Data point Content Log action

bits 0 – 3

bits 4 - 7

bits 8 - 11

bits 12 - 15

bits 16 -19

bits 20 - 23

bits 24 - 27

bits 28 - 31

DidDltTmChkFail<A..D>

Un-used

IsSigQltyBad<A..D>

Un-used

DidExceedMaxNoise<A..D>

Un-used

IsSNRTooLow<A..D>

Un-used

DailyMacro5 MACRO

bits 0 - 3

bits 4 - 7

bits 8 - 11

bits 12 - 15

bits 16 - 19

bits 20 - 23

bits 24 - 27

bits 28 -31

DidTmDevChkFail<A..D>

Un-used

IsSigDistorted<A..D>

Un-used

IsPeakSwitchDetected<A..D>

Un-used

IsSigClipped<A..D>

Un-used

DailyMacro6

bits 0 - 3

bits 4 - 7

bits 8 - 11

bits 12 - 31

IsMeasSndSpdRange<A..D>

Un-used

IsStackingIncomplete<A..D>

Un-used

ProfileFactor FLOW_ANALY
SIS_GATED

SwirlAngle FLOW_ANALY
SIS_GATED

Symmetry FLOW_ANALY
SIS_GATED

CrossFlow FLOW_ANALY
SIS_GATED

Turbulence<A..D> FLOW_ANALY
SIS_GATED

SndVel<A..D> FLOW_GATED

SpdSndSpread AVERAGE

AvgSndVel FLOW_GATED

SndVelDiff<A..D> FLOW_GATED

AGA10SndVel FLOW_GATED

SndVelCompErr FLOW_ANALY
SIS_GATED
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Table 6-1: Daily log data points (continued)

Data point Content Log action

ColocMeterTH2VsTH1AvgSndVelPctDiff FLOW_GATED

FlowVel<A..D> FLOW_GATED

AvgFlow FLOW_GATED

FlowVelRatio<A..D> AVERAGE

PctGood<A1..D2> AVERAGE

Gain<A1..D2> AVERAGE

SNR<A1..D2> AVERAGE

NoiseAmplitude<A1..D2> AVERAGE

EnergyRate FLOW_GATED

PosEnergy TOTALIZE and
SNAPSHOT

NegEnergy TOTALIZE and
SNAPSHOT

MassRate FLOW_GATED

PosMass TOTALIZE and
SNAPSHOT

NegMass TOTALIZE and
SNAPSHOT

PosVolBase TOTALIZE and
SNAPSHOT

NegVolBase TOTALIZE and
SNAPSHOT

QFlow FLOW_GATED

ColocMeterTH2VsTH1QFlowPctDiff FLOW_GATED

QBase FLOW_GATED

FlowTemperature FLOW_GATED

ExpCorrTemperature FLOW_GATED

FlowPressure FLOW_GATED

ExpCorrPressure FLOW_GATED

AbsFlowPressure FLOW_GATED

CorrectionFactor FLOW_GATED

RhoMixFlow FLOW_GATED

ZFlow FLOW_GATED

ZBase FLOW_GATED

MethaneInUse FLOW_GATED

N2InUse FLOW_GATED
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Table 6-1: Daily log data points (continued)

Data point Content Log action

CO2InUse FLOW_GATED

EthaneInUse FLOW_GATED

PropaneInUse FLOW_GATED

WaterInUse FLOW_GATED

H2SInUse FLOW_GATED

H2InUse FLOW_GATED

COInUse FLOW_GATED

OxygenInUse FLOW_GATED

IsoButaneInUse FLOW_GATED

NButaneInUse FLOW_GATED

IsoPentaneInUse FLOW_GATED

NPentaneInUse FLOW_GATED

NHexaneInUse FLOW_GATED

NHeptaneInUse FLOW_GATED

NOctaneInUse FLOW_GATED

NNonaneInUse FLOW_GATED

NDecaneInUse FLOW_GATED

HeliumInUse FLOW_GATED

ArgonInUse FLOW_GATED

HeatingValueInUse FLOW_GATED

SpecificGravityInUse FLOW_GATED

CnfgChksumValue SNAPSHOT

CnfgChksumDate SNAPSHOT

Hourly log
The Rosemount 3410 Series Gas Ultrasonic Flow Meter meter stores an hourly log record
once per hour on the hour. The user can select whether old, unread records can be
overwritten by new records when the log becomes full via the data point
DoOverwriteUnreadHourlyLog.

This point can be modified using the MeterLink™ Tools → Edit/Compare Configuration
screen. The default is to overwrite old, unread records. Refer to Options for reading daily
and/or hourly log records for information on reading records and marking records as read.
The data point IsHourlyLogFull indicates whether or not the hourly log is full and cannot
overwrite old, unread records.
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The data points included in the hourly log and the corresponding log action are as shown
in the table below. Data points required by the API Chapter 21 standard are marked with
an asterisk (*). For information on a particular data point, consult MeterLink online help.

Table 6-2: Hourly log data points

Data point Content Log action

HourlySMVResult SNAPSHOT

PosVolFlow TOTALIZE and
SNAPSHOT

NegVolFlow TOTALIZE and
SNAPSHOT

AccumFlowTime TOTALIZE

HourlyMacro1 MACRO

bit 0

bit 1

bit 2

bit 3

bit 4

bit 5

bit 6

bit 7

bit 8

bit 9

bit 10

bit 11

bit 12

bit 13

bit 14

bit 15

bit 16

bit 17

bit 18

bit 19

bit 20

bit 21

bit 22

bit 23

bit 24

bit 25

bit 26

bit 27

bit 28

bit 29

bit 30

bit 31

IsQFlowInvalid

IsQBaseInvalid

IsMassRateInvalid

IsEnergyRateInvalid

IsEstimatedFlowVelocityInUse

IsTooFewOperChords

IsFwdBaselineNotSet

IsRevBaselineNotSet

IsGCDataErr

Un-used

IsAcqModuleIncompatible

IsHourlyLogFull

IsDailyLogFull

IsAuditLogFull

IsAlarmLogFull

IsSystemLogFull

IsXdcrFiringSyncError

IsColocMeterCommErr

IsGCCommErr

IsGCAlarmPresent

IsElecVoltOutOfRange

IsElecTempOutOfRange

DidCnfgChksumChg

DidPowerFail

IsAcqModuleError

IsAcqMode

DidColdStart

IsCorePresent

WatchDogReset

DI1

IsWarmStartReq

IsClkInvalid
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Table 6-2: Hourly log data points (continued)

Data point Content Log action

HourlyMacro2 MACRO

bit 0

bit 1

bit 2

bit 3

bit 4

bit 5

bit 6

bit 7

bit 8

bit 9

bit 10

bit 11

bit 12

bit 13

bit 14

bit 15

bit 16

bit 17

bit 18

bit 19

bit 20

bit 21

bit 22

bit 23

bit 24

bit 25

bit 26

bit 27

bit 28

bit 29

bit 30

bit 31

Un-used

Un-used

Un-used

AreGasPropertiesInvalidInUse

IsSndVelCompErr

IsReverseFlowDetected

IsAbnormalProfileDetected

IsLiquidDetected

IsBoreBuildupDetected

IsBlockageDetected

IsDiagnosticSndSpdRangeErr

Un-used

IsColocMeterSndSpdRangeErr

IsColocMeterQFlowRangeErr

DidWarmStart

Un-used

IsAnyLogFull

TemperatureInvalid

PressureInvalid

Un-used

IsChordLengthMismatched

IsXdcrMaintenanceRequired

IsSNRTooLow

IsPeakSwitchDetected

IsHardFailedD

IsHardFailedC

IsHardFailedB

IsHardFailedA

IsMeterVelAboveMaxLmt

IsAvgSoundVelRangeErr

IsMeasSndSpdRange

Un-used

HourlyMacro3 MACRO

bits 0 - 3

bits 4 - 7

bits 8 - 11

bits 12 - 15

bits 16 -19

bits 20 - 23

bits 24 - 27

bits 28 - 31

IsChordLengthMismatched<A..D>

Un-used

IsBatchInactive<A..D>

Un-used

IsXdcrMaintenanceRequired<A..D>

Un-used

IsFailedForBatch<A..D>

Un-used
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Table 6-2: Hourly log data points (continued)

Data point Content Log action

HourlyMacro4 MACRO

bits 0 - 3

bits 4 - 7

bits 8 - 11

bits 12 - 15

bits 16 -19

bits 20 - 23

bits 24 - 27

bits 28 - 31

DidDltTmChkFail<A..D>

Un-used

IsSigQltyBad<A..D>

Un-used

DidExceedMaxNoise<A..D>

Un-used

IsSNRTooLow<A..D>

Un-used

HourlyMacro5 MACRO

bits 0 - 3

bits 4 - 7

bits 8 - 11

bits 12 - 15

bits 16 -19

bits 20 - 23

bits 24 - 27

bits 28 - 31

DidTmDevChkFail<A..D>

Un-used

IsSigDistorted<A..D>

Un-used

IsPeakSwitchDetected<A..D>

Un-used

IsSigClipped<A..D>

Un-used

HourlyMacro6 MACRO

bits 0 - 3

bits 4 - 7

bits 8 - 11

bits 12 - 31

IsMeasSndSpdRange<A..D>

Un-used

IsStackingIncomplete<A..D>

Un-used

ProfileFactor FLOW_ANALY
SIS_GATED

SwirlAngle FLOW_ANALY
SIS_GATED

Symmetry FLOW_ANALY
SIS_GATED

CrossFlow FLOW_ANALY
SIS_GATED

Turbulence<A..D> FLOW_ANALY
SIS_GATED

SndVel<A..D> FLOW_GATED

SpdSndSpread AVERAGE

AvgSndVel FLOW_GATED

SndVelDiff<A..D> FLOW_GATED

AGA10SndVel FLOW_GATED
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Table 6-2: Hourly log data points (continued)

Data point Content Log action

SndVelCompErr FLOW_ANALY
SIS_GATED

ColocMeterTH2VsTH1AvgSndVelPctDiff FLOW_GATED

FlowVel<A..D> AVERAGE

AvgFlow FLOW_GATED

FlowVelRatio<A..D> FLOW_GATED

PctGood<A1..D2> AVERAGE

Gain<A1..D2> AVERAGE

SNR<A1..D2> AVERAGE

NoiseAmplitude<A1..D2> AVERAGE

EnergyRate FLOW_GATED

PosEnergy TOTALIZE and
SNAPSHOT

NegEnergy TOTALIZE and
SNAPSHOT

MassRate FLOW_GATED

PosMass TOTALIZE and
SNAPSHOT

NegMass TOTALIZE and
SNAPSHOT

PosVolBase TOTALIZE and
SNAPSHOT

NegVolBase TOTALIZE and
SNAPSHOT

QFlow FLOW_GATED

ColocMeterTH2VsTH1QFlowPctDiff FLOW_GATED

QBase FLOW_GATED

FlowTemperature FLOW_GATED

ExpCorrTemperature FLOW_GATED

FlowPressure FLOW_GATED

ExpCorrPressure FLOW_GATED

AbsFlowPressure FLOW_GATED

CorrectionFactor FLOW_GATED

RhoMixFlow FLOW_GATED

ZFlow FLOW_GATED

ZBase FLOW_GATED
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Table 6-2: Hourly log data points (continued)

Data point Content Log action

MethaneInUse FLOW_GATED

N2InUse FLOW_GATED

CO2InUse FLOW_GATED

EthaneInUse FLOW_GATED

PropaneInUse FLOW_GATED

WaterInUse FLOW_GATED

H2SInUse FLOW_GATED

H2InUse FLOW_GATED

COInUse FLOW_GATED

OxygenInUse FLOW_GATED

IsoButaneInUse FLOW_GATED

NButaneInUse FLOW_GATED

IsoPentaneInUse FLOW_GATED

NPentaneInUse FLOW_GATED

NHexaneInUse FLOW_GATED

NHeptaneInUse FLOW_GATED

NOctaneInUse FLOW_GATED

NNonaneInUse FLOW_GATED

NDecaneInUse FLOW_GATED

HeliumInUse FLOW_GATED

ArgonInUse FLOW_GATED

HeatingValueInUse FLOW_GATED

SpecificGravityInUse FLOW_GATED

CnfgChksumValue SNAPSHOT

CnfgChksumDate SNAPSHOT

Audit log
The Rosemount 3410 Gas Ultrasonic Flow Meters stores an audit log record whenever any
parameter affecting the flow measurement is modified. The audit log record indicates
which data point changed, the date and time of the change, and both the 'as-found' and
'as-left' values.

The meter can store up to 3000 audit records. The user can select whether old, unread
records can be overwritten by new records when the log becomes full via the data point
DoOverwriteUnreadAuditLog. This point can be modified using the MeterLink Tools →
Edit/Compare Configuration screen. The default is to overwrite old, unread records. Refer
to Options for reading audit, alarm, and/or system log records for information on reading
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records and marking records as read. The data point IsAuditLogFull indicates whether or
not the audit log is full and cannot overwrite old, unread records.

The data points monitored and collected for the audit log are as shown in Audit log
through Event log: alarm/audit below. The points are grouped and, within each group, are
listed alphabetically.

The groupings are as follows:

• AGA8

• AGA10

• Calibration

• Chord Proportions

• Co-located meter

• Communications

• Data Logging

• Expansion Correction

• Flow analysis

• Frequency, Digital, and Analog Signals

• Gas chromatograph

• General

• HART

• Indicators

• Local display

• Meter Information

• Pressure & Temperature

• Reynolds Number Calculation

• Signal Processing

• Tracking

For information on a particular data point, consult MeterLink online help.

Table 6-3: Audit log AGA 8 group monitored data points

Data group Data Point

HCH_Method

PBase

RefPressureGr

RefPressureMolarDensity

RefTemperatureGr

RefTemperatureHV

RefTemperatureMolarDensity

Tbase
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Table 6-4: Audit log AGA 10 group monitored data points

Data group Data Point

AGA10Key

IsGasCompositionValidationEnabled

IsSndVelCompEnabled

SndVelCompErrLimit

Table 6-5: Audit log Baseline group monitored data points

Data group Data Point

FwdBaselineAvgFlow

FwdBaselineComment

FwdBaselineCrossFlow

FwdBaselineFlowPressure

FwdBaselineFlowTemperature

FwdBaselineProfileFactor

FwdBaselineSwirlAngle

FwdBaselineSymmetry

FwdBaselineTime

FwdBaselineTurbulenceA

FwdBaselineTurbulenceB

FwdBaselineTurbulenceC

FwdBaselineTurbulenceD

RevBaselineAvgFlow

RevBaselineComment

RevBaselineCrossFlow

RevBaselineFlowPressure

RevBaselineFlowTemperature

RevBaselineProfileFactor

RevBaselineSwirlAngle

RevBaselineSymmetry

RevBaselineTime

RevBaselineTurbulenceA

RevBaselineTurbulenceB

RevBaselineTurbulenceC

RevBaselineTurbulenceD
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Table 6-6: Audit log calibration group monitored data points

Data group Data Point

AvgDlyA

AvgDlyB

AvgDlyC

AvgDlyD

CalFlag

CalMethod

DltDlyA

DltDlyB

DltDlyC

DltDlyD

FwdA0

FwdA1

FwdA2

FwdA3

FwdC0

FwdC1

FwdC2

FwdC3

FwdFlwRt1

FwdFlwRt10

FwdFlwRt11

FwdFlwRt12

FwdFlwRt2

FwdFlwRt3

FwdFlwRt4

FwdFlwRt5

FwdFlwRt6

FwdFlwRt7

FwdFlwRt8

FwdFlwRt9

FwdMtrFctr1

FwdMtrFctr10

FwdMtrFctr11

FwdMtrFctr12

FwdMtrFctr2

FwdMtrFctr3

FwdMtrFctr4

FwdMtrFctr5

FwdMtrFctr6

FwdMtrFctr7

FwdMtrFctr8

FwdMtrFctr9

MeterHousingLength<A..D>
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Data group Data Point

LA

LB

LC

LD

PipeDiam

RevA0

RevA1

RevA2

RevA3

RevC0

RevC1

RevC2

RevC3

RevFlwRt1

RevFlwRt10

RevFlwRt11

RevFlwRt12

RevFlwRt2

RevFlwRt3

RevFlwRt4

RevFlwRt5

RevFlwRt6

RevFlwRt7

RevFlwRt8

RevFlwRt9

RevMtrFctr1

RevMtrFctr10

RevMtrFctr11

RevMtrFctr12

RevMtrFctr2

RevMtrFctr3

RevMtrFctr4

RevMtrFctr5

RevMtrFctr6

RevMtrFctr7

RevMtrFctr8

RevMtrFctr9

SystemDelay

WtA ...WtD

XA ... XD

XdcrAssyComponent4SerialNumber<A..D>

XdcrAssyComponent4Length<A..D>

XdcrAssyComponent3SerialNumber<A..D>

XdcrAssyComponent3Length<A..D>
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Data group Data Point

XdcrAssyComponent2SerialNumber<A..D>

XdcrAssyComponent2Length<A..D>

XdcrAssyComponent1SerialNumber<A..D>

XdcrAssyComponent1Length<A..D>

Table 6-7: Audit log Chord proportions group monitored data points

Data group Data Point

LowFlowLmt

NumVals

PropUpdtBatches

ResetProp

Table 6-8: Audit log collocated meter group monitored data point

Data group Data Point

ColocMeterMode

ColocMeterQFlowErrLimit

ColocMeterSndSpdErrLimit

IsColocMeterClockSyncEnabled

IsColocMeterQFlowRangeCheckEnabled

IsColocMeterSndSpdRangeCheckEnabled

Table 6-9: Audit log communication group monitored data point

Data group Data Point

CommTCPTimeoutPortA

CommTCPTimeoutPortB

CommTCPTimeoutPortC

FTPServerControlPort

HTTPServerPort

MaxConnDBAPI

ReadWriteModePort<A..C>

Table 6-10: Audit log data logging group monitored data point

Data group Data Point

AlarmTurnOffHysterisisCount

AlarmTurnOffHysterisisTimeSpan

ContractHour

DailyLogInterval

HourlyLogInterval

IsAuditLogFixedDataPointsEnabled
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Table 6-11: Audit log Expansion correction group monitored data point

Data group Data Point

EnableExpCorrPress

EnableExpCorrTemp

LinearExpansionCoef

PipeOutsideDiameter

PoissonsRatio

RefPressExpCoef

RefTempLinearExpCoef

YoungsModulus

Table 6-12: Audit log Flow analysis group monitored data point

Data group Data Point

AbnormalProfileDetectionLmt

BlockageCrossFlowLmt

BlockageSymmetryLmt

BlockageTurbulenceLmtA

BlockageTurbulenceLmtB

BlockageTurbulenceLmtC

BlockageTurbulenceLmtD

ContinuousFlowAnalysisKey

FlowAnalysisHighFlowLmt

FlowAnalysisLowFlowLmt

IsAbnormalProfileDetectionEnabled

IsBlockageDetectionEnabled

IsBoreBuildupDetectionEnabled

IsLiquidDetectionEnabled

IsReverseFlowDetectionEnabled

LiquidDetectionSDevCrossFlowLmt

LiquidDetectionSDevProfileFactorLmt

LiquidDetectionSDevSymmetryLmt

ReverseFlowDetectionZeroCut

ReverseFlowVolLmt
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Table 6-13: Audit log frequency, digital and analog group monitored data point

Data group Data Point

AO1ActionUponInvalidContent

AO1Content

AO1CurrentTrimGain

AO1CurrentTrimZero

AO1Dir

AO1FullScaleEnergyRate

AO1FullScaleMassRate

AO1FullScaleVolFlowRate

AO1MaxVel

AO1MinVel

AO1TestModeOutputPercent

AO1TrimCurrent

AO1TrimGainExtMeasCurrent

AO1TrimZeroExtMeasCurrent

AO1ZeroScaleEnergyRate

AO1ZeroScaleMassRate

AO1ZeroScaleVolFlowRate

AO2ActionUponInvalidContent

AO2Content

AO2CurrentTrimGain

AO2CurrentTrimZero

AO2Dir

AO2FullScaleEnergyRate

AO2FullScaleMassRate

AO2FullScaleVolFlowRate

AO2MaxVel

AO2MinVel

AO2TestModeOutputPercent

AO2TrimCurrent

AO2TrimGainExtMeasCurrent

AO2TrimZeroExtMeasCurrent

AO2ZeroScaleEnergyRate

AO2ZeroScaleMassRate

AO2ZeroScaleVolFlowRate

DI1IsInvPolarity

DO1AContent ... DO1BContent

DO1AIsInvPolarity ... DO1BIsInvPolarity

DO1PairTestEnable

DO2AContent ... DO2BContent

DO2AIsInvPolarity... DO2BIsInvPolarity

DO2PairTestEnable

FODO1Mode

FODO1Source
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Data group Data Point

FODO2Mode

FODO2Source

FODO3Mode

FODO3Source

FODO4Mode

FODO4Source

FODO5Mode

FODO5Source

FODO6Mode

FODO6Source

Freq1BPhase

Freq1Content

Freq1Dir

Freq1FeedbackCorrectionPcnt

Freq1FullScaleEnergyRate

Freq1FullScaleMassRate

Freq1FullScaleVolFlowRate

Freq1MaxFrequency

Freq1MaxVel

Freq1MinVel

Freq1TestModeOutputPercent

Freq1ZeroScaleEnergyRate

Freq1ZeroScaleMassRate

Freq1ZeroScaleVolFlowRate

Freq2BPhase

Freq2Content

Freq2Dir

Freq2FeedbackCorrectionPcnt

Freq2FullScaleEnergyRate

Freq2FullScaleMassRate

Freq2FullScaleVolFlowRate

Freq2MaxFrequency

Freq2MaxVel

Freq2MinVel

Freq2TestModeOutputPercent

Freq2ZeroScaleEnergyRate

Freq2ZeroScaleMassRate

Freq2ZeroScaleVolFlowRate

IsAO1EnableTest

IsAO2EnableTest

IsDI1ForCalActiveLow

IsDI1ForCalStateGated

IsFreq1BZeroedOnErr

IsFreq1EnableTest
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Data group Data Point

IsFreq2BZeroedOnErr

IsFreq2EnableTest

Table 6-14: Audit log gas chromatograph group monitored data point

Data group Data Point

GasPropertiesSrcSel

GasPropertiesSrcSelGCAlarm

GCBaud

GCCommTimeout

GCDesiredStreamTimeout

GCHeatingValueType

GCHeatingValueUnit

GCKey

GCModbusID

GCProtocol

GCSerialPort

GCStreamNumber

GCIPAddr

GCTCPPort
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Table 6-15: Audit log general group monitored data point

Data group Data Point

AlarmDef

AsyncEnable

AvgSoundVelHiLmt

AvgSoundVelLoLmt

ChordalConfig

ChordInactvA

ChordInactvB

ChordInactvC

ChordInactvD

DampEnable

DeviceNumber

DitherEnable

FlowDir

MaxNoDataBatches

MeterMaxVel

MinChord

MinPctGood

NonNormalModeTimeout

PerfStatusSuppressLmt

RTCSecondsSinceEpochSet

SevereFlowConditionFactor

SevereFlowConditionLmt1

SevereFlowConditionLmt2

SpecCorrectionFactor

SSMax

SSMin

UnitsSystem

VelHold

VolFlowRateTimeUnit

VolUnitMetric

VolUnitUS

WallRoughness

XdcrFiringSync

XdcrType

ZeroCut
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Table 6-16: Audit log HART data group monitored data point

Data group Data Point

HARTDate

HARTDescriptor

HARTDeviceFinalAssyNum

HARTEnergyUnit

HARTLongTag

HARTMassUnit

HARTMessage

HARTMinNumPreambles

HARTNumPreambleBytesFromSlave

HARTPollingAddress

HARTPressureUnit

HARTQVContent

HARTRateTimeUnit

HARTSlot0Content

HARTSlot1Content

HARTSlot2Content

HARTSlot3Content

HARTTag

HARTTemperatureUnit

HARTTVContent HARTVelUnit

HARTVolUnit

Table 6-17: Audit log indicators group monitored data point

Data group Data Point

CnfgChksumDate

CnfgChksumValue

DidCnfgChksumChg

DidColdStart

DidPowerFail

DidWarmStart

DoWarmStart

IsConfigProtected

IsCorePresent

MeterResetTime

WatchDogReset

DidWarmStart
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Table 6-18: Audit log local display group monitored data point

Data group Data Point

LocalDisplayFlowRateTimeUnit

LocalDisplayItem1

LocalDisplayItem10

LocalDisplayItem2

LocalDisplayItem3

LocalDisplayItem4

LocalDisplayItem5

LocalDisplayItem6

LocalDisplayItem7

LocalDisplayItem8

LocalDisplayItem9

LocalDisplayScrollDelay

LocalDisplayVolUnitMetric

LocalDisplayVolUnitUS

Table 6-19: Audit log meter information group monitored data point

Data group Data Point

CPUBdBootLoaderSwVer

CPUBdSwVer

Eth1DfltGatewayAddr

Eth1IPAddr

Eth1SubnetMask

FileSysVer

MeterModel

MeterNominalSize

MeterSerialNumber

OSVer

UserScratch1

UserScratch2
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Table 6-20: Audit log pressure and temperature group monitored data point

Data group Data Point

AtmosphericPress

EnablePressureInput

EnableTemperatureInput

FlowPOrTSrcUponAlarm

FlowPressureWhileCal

FlowTemperatureWhileCal

HighPressureAlarm

HighTemperatureAlarm

InputPressureUnit

LiveFlowPressureCalCtrl

LiveFlowPressureGain

LiveFlowPressureOffset

LiveFlowTemperatureCalCtrl

LiveFlowTemperatureGain

LiveFlowTemperatureOffset

LowPressureAlarm

LowTemperatureAlarm

MaxInputPressure

MaxInputTemperature

MinInputPressure

MinInputTemperature

Table 6-21: Audit log Reynolds number calculation group monitored data point

Data group Data Point

Viscosity
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Table 6-22: Audit log signal processing group monitored data point

Data group Data Point

BatchPercentSmoothing

BatchSize

CRange

DltChk

EmRateActual

EmRateDesired

Filter

FireSeq

GainHighLmt

GainLowLmt

MaxHoldTm

MaxNoise

MinHoldTime

MinSigQlty

NegSpan

Pk1Pct

Pk1Thrsh

Pk1Wdth

PosSpan

SampInterval

SampPerCycle

SetXdcrType

SndSpdChkMaxVel

SndSpdChkMinVel

SNRatio

SpecBatchUpdtPeriod

StackEmRateActual

StackEmRateDesired

StackSize

TmDevFctr1

TmDevLow1

XdcrFreq

XdcrNumDriveCycles
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Table 6-23: Audit log tracking group monitored data point

Data group Data Point

ResetTrkParam

Tamp

TampHi

TampLo

TampSen

TampWt

Tspe

TspeHi

TspeLmt

TspeLo

TspeSen

TspeWt

Tspf

TspfHi

TspfLo

TspfMatch

TspfSen

TspfWt

Table 6-24: Audit Log Fixed data points

Fixed value configuration data points, which are written by external client like flow computer at
regular interval of time, can be enabled by setting IsAuditLogFixedDataPointsEnabled as TRUE. By
default, IsAuditLogFixedDataPointsEnabled is set to FALSE which disables audit logging of following
data points.
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Data group Data Point

AGA 8 MeasVolGrossHeatingVal

SpecificGravity

MoleFractionN2Method2

MoleFractionCO2

MoleFractionH2

MoleFractionCO

MoleFractionMethane

MoleFractionEthane

MoleFractionPropane

MoleFractionIsoButane

MoleFractionNButane

MoleFractionIsoPentane

MoleFractionNPentane

MoleFractionNHexane

MoleFractionNHeptane

MoleFractionNOctane

MoleFractionNNonane

MoleFractionNDecane

MoleFractionH2S

MoleFractionHelium

MoleFractionWater

MoleFractionOxygen

MoleFractionArgon

SpecFlowTemperature

SpecFlowPressure

SpecRhoMixFlow

SpecZFlow

SpecZBase

Determining meter power-up and power-down times
The audit log can be used to determine the meter start (or re-start) time and the meter
power-down time by examining the MeterResetTime record(s). The MeterResetTime
record time stamp indicates (to within a few seconds) the time that the meter was started.
The As-left value indicates the time (to within a few seconds) that the meter was powered-
down.

6.1.2 Event log: alarm/audit
The meter monitors several data points with respect to each point's alarm limit(s). Non-
boolean data points can have low and high alarm limits. Boolean data points only have a
single alarm limit (i.e., either TRUE or FALSE). There are two statuses associated with
alarms: set and cleared. An alarm is set when the data point is at or exceeds its alarm limit.
An alarm is cleared when the data point is within its alarm limit(s).
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The Rosemount 3410 Series Ultrasonic Flow Meter stores an alarm log record whenever
any monitored data point's alarm status (cleared or set) changes. The alarm log record
indicates the data point, date and time, alarm status, corresponding alarm limit, and data
point value.

The meter can store up to 3000 alarm records. The user can select whether old, unread
records can be overwritten by new records when the log becomes full via the data point
DoOverwriteUnreadAlarmLog. This point can be modified using the MeterLink Tools →
Edit/Compare Configuration screen. The default is to overwrite old, unread records. Refer
to Options for reading audit, alarm, and/or system log records for information on reading
records and marking records as read. The data point IsAlarmLogFull indicates whether or
not the alarm log is full and cannot overwrite old, unread records.

The user-settable data points AlarmTurnOffHysterisisCount and
AlarmTurnOffHysterisisTimeSpan are used to prevent very repetitive alarms from filling
up the alarm log. When an alarm is set AlarmTurnOffHysterisisCount times within
AlarmTurnOffHysteresisTimeSpan seconds, then the alarm is suppressed until the alarm
frequency drops below the specified rate (counts per time span) at which point the next
alarm clearing "unsuppresses" the alarm. The alarm log records indicate when an alarm
suppression is started and ended. The default values are 8 occurrences in 240 seconds.

The data points monitored for the alarm log are as shown in the tables below. Note that
the alarm limits are themselves data points. The user-settable alarm limits are listed by
data point name. Non-settable alarm limits are listed by data point value.

Table 6-25: Alarm log monitored data points

Data point Low alarm limit High alarm limit

GainA1, GainA2,

GainB1, GainB2,

GainC1, GainC2,

GainD1, GainD2

GainLowLmt GainHighLmt

AvgSndVel AvgSoundVelLoLmt AvgSoundVelHiLmt

SpecFlowPressure LowPressureAlarm HighPressureAlarm

SpecFlowTemperature LowTemperatureAlarm HighTemperatureAlarm

LiveFlowPressure LowPressureAlarm HighPressureAlarm

LiveFlowTemperature LowTemperatureAlarm HighTemperatureAlarm

AvgFlow MeterMaxNegVel MeterMaxVel

SysTemp -40°C 100°C

SysVoltage1V 0.90V 1.10V

SysVoltage1V2 1.08V 1.32V

SysVoltage2V5 2.225 V 2.775 V

SysVoltage3V3 2.937 V 3.663 V
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Table 6-26: Alarm log Boolean alarm limit

Data point Boolean alarm unit

IsBatchDataRcvFailed TRUE

IsClkInvalid TRUE

SpecFlowTemperature TRUE

SpecFlowPressure TRUE

PressureInvalid TRUE

TemperatureInvalid TRUE

AGA8BaseCalcStatus TRUE

AGA8BaseCalcValidity FALSE

AGA8FlowCalcStatus TRUE

AGA8FlowCalcValidity FALSE

IsAcqModuleError TRUE

AvgFlow TRUE

IsMeterVelAboveMaxLmt TRUE

AvgSndVel TRUE

IsAvgSoundVelRangeErr TRUE

QMeterValidity FALSE

QFlowValidity FALSE

QBaseValidity FALSE

DidColdStart TRUE

IsMeasSndSpdRange<A..D> TRUE

IsAcqMode TRUE

IsTooFewOperChords TRUE

IsHardFailed<A..D> TRUE

Freq1DataValidity FALSE

Freq2DataValidity FALSE

SysTemp TRUE

SysVoltage2V5 TRUE

SysVoltage3V3 TRUE

IsHourlyLogFull TRUE

IsDailyLogFull TRUE

IsAuditLogFull TRUE

IsSystemLogFull TRUE

IsAcqModuleIncompatible TRUE
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Table 6-26: Alarm log Boolean alarm limit (continued)

Data point Boolean alarm unit

LiveFlowPressure TRUE

LiveFlowTemperature TRUE

IsSndVelCompErr TRUE

EnergyRateValidity FALSE

AreGasPropertiesInvalidInUse TRUE

AreGasPropertiesInvalidGC TRUE

GCCommStatus TRUE

IsGCCommErr TRUE

IsGCDataErr TRUE

IsGCAlarmPresent TRUE

MassRateValidity FALSE

AO1IsSaturated TRUE

AO2IsSaturated TRUE

AO1DataValidity FALSE

AO2DataValidity FALSE

HARTTVValidity FALSE

HARTQVValidity FALSE

HARTSlot0Validity FALSE

HARTSlot1Validity FALSE

HARTSlot2Validity FALSE

HARTSlot3Validity FALSE

AreSwComponentsCompatible TRUE

IsAcqModuleErrorLatched TRUE

IsAcqModeLatched TRUE

IsTooFewOperChordsLatched TRUE

TemperatureInvalidLatched TRUE

PressureInvalidLatched TRUE

IsMeterVelAboveMaxLmtLatched TRUE

IsAvgSoundVelRangeErrLatched TRUE

IsBlockageDetected TRUE

IsBlockageDetectedLatched TRUE

IsBoreBuildupDetected TRUE

IsBoreBuildupDetectedLatched TRUE
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Table 6-26: Alarm log Boolean alarm limit (continued)

Data point Boolean alarm unit

IsLiquidDetected TRUE

IsLiquidDetectedLatched TRUE

IsAbnormalProfileDetected TRUE

IsAbnormalProfileDetectedLatched TRUE

IsReverseFlowDetected TRUE

ReverseFlowVol TRUE

IsFwdBaselineNotSet TRUE

IsRevBaselineNotSet TRUE

IsReverseFlowDetectedLatched TRUE

IsSndVelCompErrLatched TRUE

SysVoltage1V2 TRUE

SysVoltage1V TRUE

SysVoltageAcqModule1V2 TRUE

SysVoltageAcqModule2V5 TRUE

SysVoltageAcqModule3V3 TRUE

SysTempAcqModule TRUE

IsDiagnosticSndSpdRangeErr TRUE

IsDiagnosticSndSpdRangeErrLatched TRUE

IsXdcrFiringSyncError TRUE

IsColocMeterCommErr TRUE

IsColocMeterCommErrLatched TRUE

IsColocMeterSndSpdRangeErr TRUE

IsColocMeterSndSpdRangeErrLatched TRUE

IsColocMeterQFlowRangeErr TRUE

IsColocMeterQFlowRangeErrLatched TRUE

IsChordLengthMismatched<A..D> TRUE

System log
The Rosemount 3410 Series Gas Ultrasonic Flow Meter meter logs all system messages in
the system log.

The meter can store up to 3000 system records. The user can select whether old, unread
records can be overwritten by new records when the log becomes full via the data point
DoOverwriteUnreadSystemLog.

This point can be modified using the MeterLink Tools → Edit/Compare Configuration
screen. The default is to overwrite old, unread records. Refer to Options for reading audit,
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alarm, and/or system log records for information on reading records and marking records
as read. The data point IsSystemLogFull indicates whether or not the system log is full and
cannot overwrite old, unread records.

Repetitive system messages are prevented from filling up the system log. When a
particular system message occurs 3 times within 60 seconds, that system message is
suppressed until that message's frequency drops below the 3 times-per-60 sec rate. The
system log records indicate when a system message suppression is started and ended.

6.1.3 Reading log records
Rosemount 3410 Series Ultrasonic Flow Meter log records are read using the MeterLink
Logs/Reports → Meter Archive Logs screen.

There are three log groups:

• Daily

• Hourly

• Event (audit, alarm, and systems logs)

Select the desired log group(s) via the Collect daily log/Collect hourly log/Collect event
log check boxes. If the event group is selected, the audit, alarm, and system logs are
individually selectable. Whenever any log is collected, the current meter configuration is
also collected.

6.1.4 Options for reading daily and/or hourly log records
The options for reading daily and hourly log records are the same. The MeterLink™ Logs/
Reports → Meter Archive Logs screen indicates the number of daily records that are
available to read. Select the log type(s) to be collected via the Collect daily log and/or
Collect hourly log check boxes.

Select whether to collect all log records or the last specified number of daily records. Also,
select whether to collect all log data or just the data points required by the API Chapter 21
standard. Table 6-1 lists the daily log data points and Table 6-2 lists the hourly log data
points. For both tables, data points required by the API Chapter 21 standard are marked
with an asterisk (*).

6.1.5 Options for reading audit, alarm, and/or system log
records
The options for reading audit, alarm, and system log records are the same. The MeterLink™

Logs/Reports → Meter Archive Logs screen indicates the number of records available for
each log type. Select whether to collect either all the records or just the last specified
number of daily records for the selected log type.
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6.1.6 Collecting and viewing log records
Three log formats are available:

• Microsoft Excel - This is the recommended format for collecting/saving log records in
order to get the full benefits of the data logging feature. This option, however, is only
available if Microsoft Excel 97 or later is installed on the PC. The Excel file generated by
this utility has up to six worksheets depending upon the logs collected: Daily Log,
Hourly Log, Alarm Log, Audit Log, System Log, and Meter Config. The collected log
data is also displayed on the screen.

• Comma-separated values - This format creates a file with data separated by commas.
Each log record collected is put on a separate line in the file. Each log type is separated
by a blank line. The meter configuration follows the log data separated by a blank line.
The collected log data is also displayed on the screen.

• Don't log to file - This option will not save any of the collected log data to a file but will
display it on the screen.

After selecting the desired log type(s) and the log format, click on the Collect button to
initiate the log data collection. If a format that saves the data to a file is selected, then a
Save As dialog box is opened to allow specifying the file name. A default file name is
suggested but can be modified. A comment may also be entered to be included with the
data file.

If a log type to be read is configured so that unread records are not over-written, then
MeterLink queries the user as to whether or not that log's records should be marked as
'read'.

Once the data collection is completed, the data is displayed in the Meter Archive Logs
dialog box one log type at a time. Select the log type to be displayed via the View log box.
The data may be sorted by selecting either Oldest first or Newest first in the Sort order
box.

6.1.7 Collecting logs
To collect Maintenance and Trend Logs for meter diagnostics

Procedure

1. Establish communication with the meter via MeterLink.

2. From MeterLink main window, select Logs/Reports → Maintenance Logs and
Reports. The Maintenance Logs and Reports dialog displays.
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Figure 6-1: Maintenance Logs

3. Set the log collection Duration (mins) (2 minutes is the default value which is
normally adequate to capture a good snapshot of the meter's current diagnostic
parameters). To get a good representation of the meter performance, it is
recommended that there be at least 30 records (lines of data). The actual number
of records collected are a function of the type of communication (Serial or
Ethernet), Stack Size (if stacking is turned on), and the Collection speed selected.
The duration value can be changed by clicking the number in the display/edit box
and entering a new value.

4. If desired, a comment may be included in the log file by entering it in the display/
edit box provided.

5. In the Log Format field, select Microsoft® Excel®. DO NOT select Comma Separated
Values (CSV), as this format is not compatible with the generation of graphics,
trending and analysis offered by 3410 Series Gas Ultrasonic Flow Meters and
Microsoft® Excel®. CSV should only be used if the computer does not have
Microsoft® Excel®. Once the file is collected in the CSV format, it can not be
converted to a Microsoft® Excel® format.

6. Select the Default view for either Technician or Engineer. The log file captures all
the data regardless of the view setting selected. If the Technician view is selected,
some of the data will be hidden. The view can be changed when the Microsoft®

Excel® file is opened then selecting View → Custom Views or by un-hiding the
columns by selecting Format → Column → Unhide.

7. To begin collecting logs, click the Start button. MeterLink collects the meter's
configuration and then begins collecting all the data from the meter.
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8. MeterLink displays the Log Complete message box after the logs are collected.

Figure 6-2: Log complete dialog

9. To view the Microsoft® Excel® file, select YES to open the Workbook.

10. Select the Workbook report view from the Microsoft® Excel® toolbar at the bottom
of the page. Tab selections include:

• Charts

• Inspection Report

• Meter Config

• Raw Data

Figure 6-3: Microsoft® Excel ® report view toolbar

11. Charts is the default view when you open the Maintenance Log.
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Figure 6-4: Microsoft® Excel ® charts view

12. The Inspection Report is the report view.
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Figure 6-5: Microsoft® Excel ® inspection report view
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Figure 6-6: Microsoft® Excel ® inspection report view

13. The next Microsoft® Excel® report view is Meter Config.
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Figure 6-7: Microsoft® Excel® Meter Config. view
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Figure 6-8: Microsoft® Excel® Meter Config. view

14. The last Microsoft® Excel® report view is Raw Data.

Figure 6-9: Microsoft® Excel® Raw Data view
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Figure 6-10: Microsoft® Excel® Raw Data view

6.1.8 Collect meter archive logs
This utility allows you to collect historical log information from an ultrasonic meter. This
dialog box is only available while connected to a meter.

Select the checkboxes for the types of logs you will collect. All of the logs will be collected
into a single Archive log file. The Log format can be selected as either Microsoft® Excel,
Comma- separated values, and Don't log to file. The Don't log to file option will not save
any of the log data to file but will only display it on the screen.

The meter configuration is always collected and included into the archive log file. Select
the desired log options and click Collect. MeterLink opens a Save As dialog box to allow
you to choose a name for the Archive log. A default name based on the Meter Name, type
of logs collected, and PC date and time is suggested. Change the name or default location
if desired.
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Figure 6-11: Meter Archive Logs

6.2 Smart Meter Verification
The Rosemount 3410 Series Gas Ultrasonic Flow Meter firmware v1.50 and later, supports
Smart Meter Verification feature. Smart Meter Verification is a performance-diagnostic
tool for Rosemount Ultrasonic Flow Meters as it delivers confidence in measurement
integrity and performance by helping you to quickly identify and resolve meter or process
issues. Using meter’s hourly logs, the meter can generate Scheduled or On-Demand
reports to monitor performance indicators like speed of sound, speed of sound spread,
swirl angle, crossflow, profile factor, symmetry, turbulence, etc. over a period. No
additional hardware or feature keys are required to use this feature. The feature is
supported on model numbers 3414 (Gas 4-Path), 3418 (Gas 8-Path), 3415 (4-path head
only), 3416 (4-path head only) and 3417. The meter can store 20 Smart Meter Verification
reports in non-volatile memory of the meter. This includes a maximum of five On-Demand
reports.

6.2.1 Smart Meter Verification report types

Smart Verification Reports can be created in 2 ways. MeterLink Software v1.80 and later, is
required to collect Smart Meter Verification reports.

1. Scheduled – Meter automatically generate reports. This is enabled by default and
generated at midnight (where midnight is understood to be the start of the day) of
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the first day of every month using data from hourly log records of the previous
calendar month.

2. On-Demand – MeterLink can request meter to generate a report. This is created
with hourly log records between the user specified start date and end date.

6.2.2 Replacing Smart Meter Verification reports

1. When an On-Demand report is created and five already exist, the oldest created On-
Demand report will be deleted instead of the oldest created of all reports.

2. When a new On-Demand report is created and 20 total reports already exist, but 5
On-Demand reports do not exist, the oldest created report will be deleted. The
deleted report could be either be Scheduled or On-Demand.

3. When a Scheduled report is created and 20 total reports already exist, the oldest
created report will be deleted. The deleted report could be either Scheduled or On-
Demand.

6.2.3 Smart Meter Verification report result

The report result is based on whether any alarm(s) is/are active during the report period.
Rosemount Ultrasonic Meter alarms are divided in two groups, Meter and Process. These
two groups have further subgroups for alarms. Alarms which represents failure with meter
functioning like electronics, transducer, uncorrected volumetric flow rate measurement
etc. are grouped under Meter group. Alarms which indicate a process issue like corrected
volumetric flow rate calculation, gas composition, pressure and temperature etc. are
grouped under Process group. Below table shows mapping of alarms in groups and
subgroups.

Meter alarm group Process alarm group

Alarm
subgroup

Alarm Alarm
subgroup

Alarms

Configuration IsWarmStartReq

IsChordLengthMismatched<A.
.H>

DidCnfgChksumChg

Base-
condition
volumetric
flow rate

QBaseValidity
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Meter alarm group Process alarm group

Alarm
subgroup

Alarm Alarm
subgroup

Alarms

Electronics DidColdStart

IsCorePresent

WatchDogReset

IsAcqModuleError

IsAcqModuleIncompatible

IsXdcrFiringSyncError

IsClkInvalid

IsColocMeterCommErr

DidPowerFail

IsElecTempOutOfRange

IsElecVoltOutOfRange

IsHourlyLogFull

IsDailyLogFull

IsAuditLogFull

IsAlarmLogFull

IsSystemLogFull

DidWarmStart

Flow rate
diagnostics

IsColocMeterQFlowRangeErr

IsReverseFlowDetected

Flow-
condition
volumetric
flow rate

IsTooFewOperChords

IsEstimatedFlowVelocityInUse

QFlowValidity

Gas
composition/
pressure/
temperature

PressureInvalid

TemperatureInvalid

AreGasPropertiesInvalidInUse

IsGCCommErr

IsGCDataErr

IsGCAlarmPresent

Performance IsFailedForBatch<A..D>

IsHardFailed<A..D>

DidDltTmChkFail<A..D>

IsSigQltyBad<A..HD

DidExceedMaxNoise<A..D>

IsSNRTooLow<A..D>

DidTmDevChkFail<A..D>

IsSigDistorted<A..D

IsPeakSwitchDetected<A..D>

IsSigClipped<A..D>

Speed of
sound
diagnostics

IsSndVelCompErr

IsColocMeterSndSpdRangeErr

IsDiagnosticSndSpdRangeErr

IsAvgSoundVelRangeErr
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Meter alarm group Process alarm group

Alarm
subgroup

Alarm Alarm
subgroup

Alarms

Speed of
sound path
spread

IsMeasSndSpdRange<A..D> Velocity
diagnostics

IsMeterVelAboveMaxLmt

IsFwdBaselineNotSet

IsRevBaselineNotSet

IsBlockageDetected

IsBoreBuildupDetected

IsLiquidDetected

IsAbnormalProfileDetected

IsSevereFlowConditionDetect
ed

Transducers IsAcqMode

IsBatchInactive<A..H>

IsXdcrMaintenanceRequired<
A..H>

If result of all alarm subgroups is Pass, then overall report result shall be Pass. If at least one
alarm subgroup result is Warning and no alarm subgroup result is Fail, then overall report
result shall be Warning. If at least one alarm subgroup result is Fail, then overall report
result shall be Fail.

A “Pass” result represents that no alarms were present during the report period. The meter
and/or process conditions were within specified limits.

A “Warning” result represents that alarms occurred during the report period that indicate
that the meter or process conditions may have an impact on measurement accuracy.

A “Fail” result represents alarms occurred during the report period that could indicate a
loss of measurement validity or a reduction in measurement accuracy.

6.2.4 Collect Smart Meter Verification report

Collect Smart Meter Verification reports using Smart Meter Verification under the Logs/
Reports menu in MeterLink. Select the checkbox for the report to be collected.
Alternatively, select Select all/none to collect reports from the meter. Click Collect under
Reports in the meter and MeterLink will retrieve report and generate the PDF report.
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Figure 6-12: MeterLink’s Smart Meter Verification Dialog

6.2.5 Create On-Demand Smart Meter Verification report

Create an On-Demand Smart Meter Verification report using Smart Meter Verification
under the Logs/Reports menu in MeterLink. At the bottom of the dialog enter the Start
date and the End date as report period. Click Collect under Collect on-demand SMV
Report… and the meter will generate the report and MeterLink will retrieve it and
generate the PDF report. See Figure 6-12.

6.2.6 Daily Smart Meter Verification results on Modbus

Flow computers/RTUs can read daily Smart Meter Verifications results via the Modbus
protocol. Registers include the result date (month, day, year), an overall Pass, Warning or
Fail result, and a Pass, Fail or Warning result for each of the 11 meter and process condition
alarm “subgroup” categories. The results are calculated at midnight using hourly log
records of the previous day. The following registers are used to read daily SMV results on
Modbus.

Register Data point Description Type Value

7424 /
15424

SMVDailyResultMonth Daily SMV result
month

int Not calculated (0) or
month of year

7425 /
15425

SMVDailyResultDay Daily SMV result day int Not calculated (0) or
day of month

7426 /
15426

SMVDailyResultYear Daily SMV result year
(2 digit)

int Not calculated (0) or
2-digit year

7427 /
15427

DailyResult Daily SMV result int Not calculated (0),
Pass (1), Warning (2),
Fail (3)

7428 /
15428

DailyFlowVolFlowRateResult Daily SMV flow-
condition volumetric
flow rate group result

int Not calculated (0),
Pass (1), Warning (2),
Fail (3)

7429 /
15429

DailyElectronicsResult Daily SMV electronics
group result

int Not calculated (0),
Pass (1), Warning (2),
Fail (3)
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Register Data point Description Type Value

7430 /
15430

DailySpdSndPathSpreadResu
lt

Daily SMV speed of
sound path spread
group result

int Not calculated (0),
Pass (1), Warning (2),
Fail (3)

7431 /
15431

DailyPerformanceResult Daily SMV
performance group
result

int Not calculated (0),
Pass (1), Warning (2),
Fail (3)

7432 /
15432

DailyTransducersResult Daily SMV
transducers group
result

int Not calculated (0),
Pass (1), Warning (2),
Fail (3)

7433 /
15433

DailyConfigurationResult Daily SMV
configuration group
result

int Not calculated (0),
Pass (1), Warning (2),
Fail (3)

7434 /
15434

DailyBaseVolFlowRateResult Daily SMV base-
condition volumetric
flow rate group result

int Not calculated (0),
Pass (1), Warning (2),
Fail (3)

7435 /
15435

DailyVelocityDiagnosticsRes
ult

Daily SMV velocity
diagnostics group
result

int Not calculated (0),
Pass (1), Warning (2),
Fail (3)

7436 /
15436

DailySpdSndDiagnosticsResu
lt

Daily SMV speed of
sound diagnostics
group result

int Not calculated (0),
Pass (1), Warning (2),
Fail (3)

7437 /
15437

DailyFlowRateDiagnosticsRe
sult

Daily SMV flow rate
diagnostics group
result

int Not calculated (0),
Pass (1), Warning (2),
Fail (3)

7438 /
15438

DailyGasCompPresTempRes
ult

Daily SMV Gas
composition/
pressure/
temperature group
result

int Not calculated (0),
Pass (1), Warning (2),
Fail (3)
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7 Commands

7.1 Tools commands
The MeterLink Tools menu commands provides the following utilities for the meter's
health status, monitoring operational conditions, establishing a baseline of the meter's
flow characteristics, updating the meter's program components and monitoring
communications between MeterLink and the meter.

Command Description

Edit/Compare Configuration Open, edit, and compare configurations from files and meters.

Waveform Viewer Collect, view, save, print ultrasonic waveforms from meter or file.

Gas SOS Calculator Calculate speed of sound for a known gas composition.

Outputs Test Test frequency, current, and digital outputs by fixing them to a
set value.

Transducer Swap-Out Adjust path length parameters when changing out transducers,
stalks, holders, or mounts.

Set Baseline Wizard Establishes the baseline for the meter's flow characteristics that
can be used to monitor the heath of the meter run using
Continuous Flow Analysis features.

Program Download Upgrade the program components in Rosemount Ultrasonic
meters.

Communications Analyzer Monitor communications between MeterLink and a meter

Locate Meter Selecting this command will prompt you Are you sure you want
to locate the meter by displaying a pattern on its local
display? Click Yes to set the meter to display the 0-0-0-0 test
pattern. Click No to cancel the operation. As long as the Locate
Meter dialog is open, the meter shall continue to display the test
pattern. Click Close to close the Locate Meter dialog and return
the meter display back to normal operation.

Warm Start Meter Selecting this command will prompt you, Do you want to warm
start the meter and disconnect from it now? Click Yes to force
the meter to restart itself. A warm start is the same restart as
when power is removed and reapplied to the meter. No
configuration or archive log history is lost. Some configuration
changes require a restart of the meter for the changes to take
effect. Click No to close the dialog.
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Command Description

Set Transducer Type Select the appropriate transducer type and click Write to
reconfigure the meter for that transducer type. The “transducer
type” may be a set of transducer types with compatible default
tracking parameters. If any of the changes require a warm start, a
message will be displayed indicating this. Click Yes to warm start
the meter so the changes will take effect. It is highly
recommended not to use this dialog unless a Emerson Flow
service representative has instructed you to do so and has given
you specific instructions on what actions to perform. Click Cancel
to close this dialog without making any changes to the meter
configuration.

Reset Tracking Displays the current tracking parameter values for Tspf, Tspe,
and Tamp and allows the user to change them if needed. Click
Reset Tracking to write any tracking parameter changes to the
meter and reset the tracking operation in the meter. It is highly
recommended not to use this dialog unless a Emerson Flow
service representative has instructed you to do so and has given
you specific instructions on what actions to perform.

Reset Velocity Estimation Selecting this command will prompt you Are you sure you want
to reset chord proportions used for velocity estimation to their
default values? Click Yes to return the chord proportions back to
default values. Click No to close this dialog without making any
changes to the meter configuration. It is recommended not to
use this dialog unless a Emerson Flow service representative has
instructed you to do so and has given you specific instructions on
what actions to perform.

Override Velocity Estimation
Update Time

In normal operation, the meter must run for a period of time
(PropUpdateSeconds) with no performance issues before it will
begin to update chord proportions. This information is used to
compensate for chord failures that may occur at a later point in
time. However, there are times such as during a flow calibration
that it is not desirable to wait the period of time before updates
begin. Running this command will force the meter to require only
24 consecutive batches before updates to the proportions are
allowed. Any restart of the meter will force the meter to wait
(PropUpdateSeconds) again before updates are allowed. So
during a flow calibration, it is necessary to run this command
after every restart if a chord failure test is required at the end of
the test.

To run this command, enter the Passcode and click Override.
Click Cancel to close this dialog without making any changes to
the meter configuration. This command will be disabled if
unsupported in the meter.

Commands Operations Manual
April 2022  00809-1100-3104

130 Emerson.com/Rosemount



7.1.1 Edit/Compare configuration parameters

Figure 7-1: Edit/Compare configuration parameters

This dialog's options include:

• View and edit configurations collected from the meter or opened from a file

• Write all or a portion of changed parameters of a configuration to a connected meter

• Comparing and converting legacy configurations

• Save and Print configurations

• Find button is used to find a data point using an alphabetically sorted list of data point
labels

Procedure

1. Click Read to collect and display a configuration from a connected meter.

2. Click ALL to display the meter's extended configuration or Metrology to display only
the metrology portion of the configuration.

3. Double-click the Value to change a parameter and select the option from the drop-
down list or if a caret is displayed, enter the value Figure 7-2.

If you change a data register, the Value displayed in the dialog turns yellow and the
check box is selected. You can later choose to only Write Checked values to the
meter.
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Figure 7-2: Edit/Compare configuration parameter changes

4. Click the question mark icon, , to the right of a data point to display the additional
information.

5. Click Write All to write the full configuration to a meter. Depending on the View
selected, the displayed configuration may not be the full configuration. Click Write
Checked to write only the values with a selected check box next to the value and are
visible in the currently selected view. Select any values to write and clear any values
you don't want to write to the meter before clicking Write Checked.

6. Open a configuration in the editor and select Meter or select File to compare it to a
configuration saved as a file.

7. Click Compare to either read the configuration from the meter or open the Open
dialog box to select the configuration to compare to the one in the editor.

Once the configurations are selected, a dialog displays, providing options to further
customize the compare operation.

Figure 7-3: Compare Configurations Options dialog

• Exclude registers that are typically different: includes items that could change
regularly such as SpecFlowPressure, SpecFlowTemperature, Gas composition,
etc. A complete list is defined in reg_list_compare_config_exclude.txt found
under the installation directory for MeterLink.

• Include read-only registers: includes, in the compare, read-only registers stored
in the collected configurations. This includes points like firmware version, K-
factors, etc.
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8. Click Save to save the configuration file. A default filename is provided based on the
meter name, time, and date the configuration was collected. You can keep the
default name or change it. The file is saved, by default, to the Data folder directory
defined under Program Settings. You may change the directory location if desired.

9. Click Print to print the configuration currently opened in the editor. Only the
registers in the currently selected view will be printed. You can also click the print
icon, , on the tool bar to print the opened configuration.

10. Use Convert to download the configuration from a legacy Rosemount Ultrasonic
meter to later generation of electronics.

a) First connect to the legacy electronics. Collect and save the configuration
using the Edit/Compare Configuration dialog box. Upgrade the electronics
on the meter.

b) Connect to the new meter electronics and open the Edit/Compare
Configuration dialog. Open the configuration collected from the legacy
electronics. The Convert button is enabled.

c) Click Convert to read the configuration from the new meter and modify it
with the data from the legacy configuration. MeterLink displays this modified
configuration in the dialog. At this point, MeterLink has not written anything
to the new meter. All the values highlighted in yellow are values from the
legacy configuration.

d) Click Write Checked to write the changed portion of the configuration to the
new meter. If any data point failed to be written, you must correct the invalid
value and click Write Checked again until the configuration is written
without any errors. Once the configuration is written, you can choose to
compare the displayed configuration with the configuration in the meter by
selecting Meter and clicking Compare. This will verify everything was written
correctly.

7.1.2 Waveform viewer

View the transducer waveforms
Rosemount 3410 Series Ultrasonic Flow Meters includes a feature for streaming
transducer waveforms that can be viewed using the MeterLink Tools → Waveform Viewer
screen. The speed at which the waveforms update is dependent upon the type of
connection between the PC and the meter. With an Ethernet connection and MeterLink,
several updates per second are possible. With a serial connection, updates may occur only
every 15 to 30 seconds.

Up to three types of waveform signals can be displayed per chord:

• Raw - the sampled waveform received by the transducer (with gain applied)

• Stacked - the result of applying stacking to the raw signal(s). Note that when stacking is
not used (StackSize is set to 1), the stacked signal is the same as the raw signal.

• Filtered - the result of applying the bandpass filter on the stacked signal. This waveform
is only available when the filter is enabled (via the Filter data point).
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For diagnostic purposes, the transducer waveform signals can be stored to a file using the
Diagnostic Collection - Stream to file checkbox. This utilizes the Rosemount 3410 Series
Gas Ultrasonic Flow Meter's patented "snapshot-and-playback" feature to accurately
record the flow signals that can then be later reproduced for detailed analysis.

Waveforms are displayed in the time domain (e.g., the waveform signal is plotted against
time).

Figure 7-4: Waveform viewer - time domain

The waveforms may also be displayed in the frequency domain. In this mode a Fast Fourier
Transform is taken of the waveform so that the frequency content of the waveform can be
displayed. This can be useful in noisy environments to see the frequency of the noise and if
it is in the range of the transducer signal.
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Figure 7-5: Waveform viewer - frequency domain

Zero crossing and first motion markers

Two markers display along the horizontal axis for either the Stacked or Filtered waveform.
If filtering is on, the markers will be on the Filtered waveform. If filtering is off, the markers
will be on the Stacked waveform. The green marker shows the point where the first
motion is detected. The purple marker shows the zero crossing which is the point that the
meter uses as the arrival point of the signal.

Navigate the waveform viewer

Procedure

1. Select the waveforms to collect from the Meter box and click Read. Selections
include:

• All Chords

• Chord A

• Chord B

• Chord C

• Chord D

2. MeterLink starts to continuously stream waveforms from the meter.
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3. Click Save while streaming waveforms or click Stop opens a Save As dialog box to
allow you to choose a name for the Waveform file.
A default name based on the Meter Name, the type of waveform collected, and PC
date and time is suggested. Change the name or default location if desired. Click
Save to accept the file name and save the last set of waveforms collected.

4. Click Open and select the Waveform filename from the Open dialog box to view a
previously saved waveform.

5. Click Tracking to display the transducer's raw, filtered or stacked signal Tracking
Parameters dialog for the selected chord. This dialog displays the parameter's label,
value and units. Some of the Tracking parameters included are Gain, Hold time,
Time (stamp), Maximum Signal Quality, Peak width, Peak Position, and Peak Zero
Crossing for upstream and downstream signals. These parameters are used in the
diagnostics of field conditions.

6. Click Export to save the waveforms displayed to Microsoft® Excel® format. The
Excel® file will contain three worksheets. The first worksheet called Charts contains
charts for each of the waveforms collected. The second worksheet called Raw Data
contains the waveform data to make the charts. The third worksheet called
Tracking contains the tracking parameters for the chord.

7. Click Close to exit the Waveform Viewer.

8. Use Diagnostic Collection set of controls feature to capture a waveform snapshot to
be played back on a simulator. This U.S. Patented feature is useful to allow
Rosemount to reproduce any field specific conditions.

a) Click the Stream to file checkbox and wait for the waveforms to start
streaming to the screen. The meter is returning raw waveforms just as they
are received without any stacking or filtering.

b) Click Record to start saving all of the raw waveforms to file. The collection of
waveforms can be paused and resumed without having to start a new file.
Clicking Stop gives you the option to save the data collected to file. The file
will have a .strm extension. There is no utility in MeterLink to playback these
files. The files are only for use internally by Rosemount on special diagnostic
tools. Clearing the Stream to file checkbox stops the streaming mode and
returns the Waveform Viewer back to its normal mode of operation.

Note
The file created with the Diagnostic collection grows quite rapidly. Typically when
connected via Ethernet to the meter, the file can easily take up 2.5 megabytes per
minute. If the file must be e-mailed, many mail servers only allow 10 to 20
megabyte files or approximately 4 to 8 minutes of data.

9. Use the Chart utilities to control the waveform display. The controls for the
waveform chart utility include:

• Scrollbar - enables horizontal and vertical scrollbars on the chart.

• Markers - displays markers for the series in order to see the data points collected.

• Zoom In - zooms in on both the horizontal and vertical scales centered on the
cursor.
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• Zoom Out - zooms out on both the horizontal and vertical scales centered on the
cursor.

• Sticky - forces the cursor to stick to the waveform trace.

• Other keyboard commands - use the keyboard commands as a shortcut to access
the desired function. Right-click the mouse over the chart to display these
commands or enter the keyboard command (Table 7-1).

Table 7-1: Waveform chart keyboard commands

Function Keystroke Description

Save State Ctrl + Home Save the current zoom settings. These
settings can be recalled with the Restore
State command. Any saved settings are
lost once the utility is closed.

Restore State Home Restores the last saved zoom settings.

Cursor to Nearest Point F8 Moves the cursor to the nearest point
displayed

Toggle Coarse/Fine
Cursor

F4 Toggles the cursor between and fast and
slow moving cursor. The cursor is
physically larger for the fast moving
cursor.

Toggle Lines/Markers F9 Toggles off the lines connecting the
collected data and forces on the markers.

Toggle Mouse Position
Tip

Ctrl+F4 Turns on tool tip showing the coordinates
at which the mouse pointer in pointing

Toggle Nearest Point Tip Ctrl+F9 Turns on tool tip showing the coordinates
of the nearest data point to the mouse
pointer

Print Ctrl+P Prints the displayed chart

Copy to clipboard Ctrl+C Copies the displayed chart to the
Windows® clipboard as table data

Paste from clipboard Ctrl+V Paste data from the Windows® clipboard
to the chart utility. The data must be in
the appropriate format to correctly paste
as a new series to the chart. Copy data
from the chart to a text file to see the
appropriate format.

Waveform Zoom Ctrl+I Turns on/off the zoom feature while in
Waveform Read or Stream to file mode.
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7.1.3 Gas SOS calculator
The SOS Calculator dialog box allows you to calculate a Speed of Sound (SOS) for a given
gas composition and operating conditions.

Figure 7-6: Gas SOS Calculator

The SOS calculations are selectable as either AGA-10 (AGA Report No. 10 - May 2003). You
do not need to be connected to a meter to use this utility. The units for the values
displayed are defined in the File → Program Settings dialog.

Calculate SOS for the gas composition

Procedure

1. Enter the gas composition as percentages into the Gas composition inputs table.
If you are connected to a Rosemount Gas Ultrasonic meter running AGA8 Detailed
Method, the "In Use" gas composition is read from the meter and displayed in Gas
composition inputs. It also indicates if the values are Fixed or Live from a GC, and if
Live from a GC, the GC Start Cycle Time of the composition will be displayed.
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2. Click Normalize to adjust the percentages so that the TOTAL gas composition
equals 100%. The normalize operation maintains the ratios between the different
components.

3. If you are connected to a meter with pressure or temperature set to Fixed or Live,
the values are read from the meter and entered in the Pressure/temperature inputs.
If you are not connected, enter the Pressure and Temperature for the gas. Pressure
can be entered as either absolute or gage. Select the desired pressure type. If Gage
is selected for pressure type, enter in the Atmospheric pressure. The label after the
units for Pressure and Temperature is set as follows:

• User: The value was entered manually or imported from a saved file.

• Fixed: The value was read from a meter with the value set as Fixed.

• Live: The value was read from a meter with the value read from a Live sensor.

• Frozen: Indicates the value is frozen on the last good reading before going either
into alarm or calibration.

4. If you are connected to a meter, the Meter average SOS will always be read from the
meter and displayed.

5. While connected to a meter, click Read from Meter to display a dialog to give you
the option to update Pressure, Temperature, Meter average SOS, and Gas
Composition. Only available options will be enabled.

Figure 7-7: Select Meter Data dialog

6. In addition to reading values from a meter, click Write to Meter to display a dialog
to give you the option to write Pressure, Temperature, and Gas Composition to the
meter. Only available options will be enabled. Pressure and Temperature must be
set to Fixed in the meter to enable the selections to write these values to the meter.
Likewise to enable the Gas Composition selection, a meter must be configured for
AGA 8 Detailed Method. If no options are available, the Write to Meter button will
be grayed out.

7. Once the gas composition and operating conditions are entered, click Calculate to
compute the Compressibility (Zf), Density, and Computed SOS.
If connected to a meter the Percent difference will show the percent error from the
Average meter SOS to the Computed SOS.
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8. Enter a Comment to associate with the SOS calculation. The comment is included in
saved gas composition files and print outs.

9. Click Save to save the Meter Name if connected to a meter, Company Name as set
under File → Program Settings, Date and Time based on the PC clock, Comment,
Gas composition inputs, Pressure/temperature inputs, and Calculated values to a
comma- separated values (.csv) file.

10. Click Open to select a saved gas composition file to bring into the SOS Calculator.
Only the Gas composition inputs, Pressure/temperature inputs, and Comment are
imported from a saved file.

11. Click Calculate to compute the calculated values.

Note
The SOS Calculator can open the comma-separated value files exported from
MON20/20 or MON2000 Software for Gas Chromatographs Calculation Results
screen. If you have customized any of the component names in the gas
chromatograph you will need to modify the SOS Calculator's map file. MeterLink
lists any component names that cannot be processed.

12. Click Print to print the Meter name if connected to a meter, Company name as set
under Program Settings, Date and Time based on the PC clock, Comment, Gas
composition inputs, Pressure/temperature inputs, and Calculated values.

13. If the SOS Calculator was launched from Maintenance Logs and Reports, click Finish
to accept the calculation and finish creating the Maintenance log. Click Cancel to
skip the computed SOS and continue making the Maintenance log.

14. If the SOS Calculator was launched from the Tools → SOS Calculator menu, click
Close to return to the Main window of MeterLink™.

7.1.4 Outputs test
The Outputs Test dialog box allows you to monitor the live values of all the frequency,
current and digital outputs. Additionally the outputs can be set into a Test mode to force
the outputs to a specific user defined value. This dialog box is only available while
connected to a meter.

Refer to Outputs test mode in this manual for additional information about the Outputs
Test Mode.

7.1.5 Transducer swap-out
The transducer swap-out utility allows you to update parameters such as path lengths,
delay times, and delta times for chord. This is necessary anytime transducers, mounts,
holders, or stalks have to be replaced for a chord.

Refer to the Rosemount 3410 Series Gas Ultrasonic Flow Meters Maintenance and
Troubleshooting Manual (00809-0600-3104, Sections 3.3 - 3.6) for detailed instructions for
replacing the transducers, mounts and stalks and setting the parameters for the pairs of
transducers you replaced. Also note, separate instructions are given for replacing these
components while under pressure with and without an extractor tool. Refer to the
Rosemount Split Clamp Extractor Tool Operation Manual (00809-0200-3417) for instructions
in safe and proper use of the tool.
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7.1.6 Baseline viewer
Use the Baseline viewer to monitor the meter's flow direction and flow characteristics
including:

• Flow Velocity

• Profile Factor

• Swirl Angle

• Symmetry

• Cross-flow

• Path Turbulences

Access the Baseline viewer from the Meter → Monitor (Detailed) dialog while connected
to your meter.

Note
You must have a valid Continuous Flow Analysis key to enable this feature. See Obtaining
optional keys for instructions about this topic and Set baseline parameters to configure
the baseline parameters for your meter using the Tools → Set Baseline Wizard menu.

Figure 7-8: Baseline viewer
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Figure 7-9: Baseline viewer

The Baseline viewer indicates the current flow direction, forward or reverse, and gauges
display the flow characteristics of the meter. The Baseline viewer dialog displays a
horizontal "green zone" that indicates the expected value range. As an example, Figure 7-9
depicts out-of-range values for turbulence on all four chords.

Read the baselines viewer gauge values
Table 7-2 describes the values for each gauge and how the green zones are defined.

Table 7-2: Baseline viewer gauge values

Value Description

Avg Velocity Displays the average flow velocity for the meter. This gauge contains no
green zone.

Profile Factor Displays the velocity flow profile factor for the meter. The profile factor is
calculated from the chordal velocities as ((VelocityB+VelocityC)/
(VelocityA+VelocityD)). The green zone is centered on the profile factor
set in the baseline ± the percentage defined by Profile factor limit
configurable in the Field Setup Wizard on the Continuous Flow Analysis
page.

Swirl Angle Displays the swirl angle in degrees for the meter. The green zone is
centered on the swirl angle set in the baseline ± 5%.

Symmetry Displays the symmetry for the meter. The symmetry is calculated from
the chordal velocities as ((VelocityA+VelocityB)/(VelocityC+VelocityD)).
The green zone is centered on the Symmetry set in the baseline ± the
percentage defined by Symmetry limit configurable in the Field Setup
Wizard on the Continuous Flow Analysis page.

Cross-Flow Displays the cross-flow for the meter. The cross-flow is calculated from
the chordal velocities as ((VelocityA+VelocityC)/(VelocityB+VelocityD)).
The green zone is centered on the cross-flow set in the baseline ± the
percentage defined by Cross-flow limit configurable in the Field Setup
Wizard on the Continuous Flow Analysis page.
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Table 7-2: Baseline viewer gauge values (continued)

Value Description

Turbulence A through
D

Displays the percent turbulence values for each path of the meter. The
green zone extends for 0% to the Chord turbulence limit configurable in
the Field Setup Wizard on the Continuous Flow Analysis page.

Display Description

1-minute averages Selecting 1-minute averages will make the
gauges display a one minute rolling average.
Next to this selection will be an indication if the
one minute average values are valid or invalid.
For the averages to be valid, the meter must
meet the following criteria for at least one full
minute: flowing in only one direction, no chord
failures or inactive chords present and flowing
within the Flow limits configurable in the Field
Setup Wizard on the Continuous Flow Analysis
page.

Current values Displays the most recently calculated values.

7.1.7 Upgrade program components
Use the MeterLink™ Tools → Program Download dialog to upgrade the program
components in Rosemount Ultrasonic meter. When the dialog is first opened, the
Currently Installed Versions table will show the currently installed program components in
the meter.

The firmware to download to a meter is available as a compressed file with a .zip
extension. MeterLink™ unzips the file when it is opened.
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Figure 7-10: Program download dialog

Procedure

1. Click Open to display an Open Download File dialog and select the desired file and
click Open.
The filename displays in the File edit box under Upgrade. The Version and Date of
the components to download display in the table under Upgrade. All of the
components will be identified as if they are older, newer, or the same as what is
currently installed in the meter.

2. MeterLink™ only downloads components that are different than what is currently
installed in the meter. At least one component must be different for download
before the Download button is enabled.

3. Click Download to initiate the download process. MeterLink™ collects the
configuration from the meter and displays a message where it was saved. If the
upgrade requires the database to be reset, then it will be necessary to use the Edit/
Compare Configuration dialog to write this configuration back down to the meter
after the program download is complete (Edit/Compare configuration parameters).
After the configuration is saved, a progress bar will appear showing the status of the
file download. After the files have been transferred successfully to the meter, the
meter will start the upgrade process and the status will be shown down below
Upgrade Progress.
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4. The meter will have to restart to install the firmware. MeterLink™ will prompt you
with a message that it must disconnect from the meter. Once the firmware upgrade
is complete you will be able to reconnect to the meter with MeterLink™.

5. MeterLink™ prompts you with a message that it must disconnect from the meter.
Once the firmware upgrade is complete you will be able to reconnect to the meter
with MeterLink™.

Important
When the meter restarts, it takes about two minutes before you will be able to
reconnect depending on the firmware upgrade being performed. If the database
does need to be re-initialized, it could take up to five minutes.

6. Reconnect to the meter and repeat the Program Download process after the
program downloads. If all the program components are successfully updated, they
will show to be the same date and version as the Currently Installed Versions and
the Download button will be disabled. If one or more components are still not
updated, click Download to continue the upgrade process. Repeat the process to
ensure all components are updated.

 CAUTION

POWER LOSS DURING PROGRAM DOWNLOAD
The meters program may be lost if the meter loses power in the middle of a
program download.

If this occurs perform the Backup Upgrade procedure to attempt a connection to
download the program again.

Error recovery for program download failure
If the Program Download failed during firmware upgrade, MeterLink can no longer
connect to the meter or a message Attempt FTP-only connection… displays when trying to
connect perform a Backup Upgrade.

It is possible for the meter to lose its programming if the meter power fails during a
firmware upgrade process. If this occurs, use the following special procedure, Backup
Upgrade, to connect to the meter and download the program again.

Backup upgrade

Procedure

1. In MeterLink™, go to the File pull-down menu and select Program Settings. The
Program Settings dialog displays. Enable the Allow backup upgrade mode
connection checkbox and click OK to close Program Settings.

a. For Serial Port Connections: Ensure you are connected to Port A. You may
need to adjust your File → Meter Directory settings for the connection so
that they match the port default settings. Port A will default to 19200 baud
with a modbus address of 32.

b. For Ethernet Connections: If you are connecting to the meter over an
Ethernet port, you should be able to connect with the same IP address as
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normal. If this is unsuccessful, the meter may have defaulted to
192.168.135.100 with a subnet of 255.255.255.0. Ensure your PC has a
compatible address and attempt a connection using this IP address.

2. Once your cabling and Meter Directory record are setup, attempt the connection to
the meter. You will receive a message Error 10001 opening database connection to,
click OK.

3. At the prompt to Attempt FTP-only connection, click Yes. If successful, the
MeterLink™ caption reads …Connected to <meter name>.

4. Go to Tools → Program Download to attempt the firmware upgrade again. If the
firmware upgrade is successful, the meter should start working as normally as the
meter's configuration is not normally lost.

5. If the configuration is lost, a configuration file was saved by the Program Download
utility on the initial firmware upgrade attempt.
Use Edit/Compare Configuration to write this saved configuration back to the
meter. The saved configuration files are typically stored in C:\Ultrasonic Data
\<MeterName>.

6. If the firmware upgrade fails again, contact Emerson Flow Support for assistance.
Contact information can be found in MeterLink™ under the Help pull down menu by
selecting Technical Support. Or, in the Customer service in the preface of this
manual.

7.1.8 Communications analyzer
The Communications Analyzer is a Windows® application that displays "messages"
transmitted to and received from an addressable device, such as a Modbus slave, by
another Windows® application.

The messages are display from the oldest (at the top of the list) to the newest (at the
bottom of the list). The Communications Analyzer date and time stamps each message
displayed. After 4096 messages have been displayed, the oldest messages are cleared
from the list as new messages are added.

The Address combo box filters new messages so that only those with the selected address
(1-32) are displayed. By default, all addresses are displayed. The address filter does not
affect messages already displayed, only new messages.
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Figure 7-11: Communications analyzer

Procedure

1. Check Browse to disable automatic scrolling. This is useful if you want to look at a
certain message while new message are being added to the list.

2. Click Copy to copy the messages to your clipboard so that they can be pasted into
another Windows application, e.g. Notepad.

3. Click Reset to clear the list of displayed messages.
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A Conversion factors

A.1 Conversion factors per unit of measurement
The following table includes conversion factors for many of the Metric and U.S. Customary
units of measure used with Rosemount Ultrasonic Gas Flow Meters and MeterLink.

Table A-1: Conversion Factors per unit of measurement

Conversion Factors Unit of Measurement

(°F-32)x(5/9) -->°C (°C+273.15) -->K

1 K/°C

5/9 °C/°F

10-6 MPa/Pa

0.006894757 MPa/psi

0.1 MPa/bar

0.101325 MPa/atm

0.000133322 MPa/mmHg

0.3048 m/ft

103 dm3/m3

10-6 m3/cc(=m3/cm3)

(0.3048)3 m3/ft3

(0.0254)3 m3/in3

3600 s/h

86400 s/day

103 g/kg

0.45359237 kg/lbm

4.1868 kJ/kcal

1.05505585262 kJ/BtulT

10-3 Pas·s/cPoise

1.488 Pas·s/(lb/(ft·s))
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B Miscellaneous equations

B.1 K-Factor and Inverse K-Factor
Equation B-1: Frequency Volumetric Flow Rate K-FactorKFactor = (MaxFrq)(3600s/ℎr)FreqQFullScale
and

Equation B-2: Frequency Volumetric Flow Rate Inverse K-FactorInvKFactor = FreqQFaullScale(MaxFreq)(3600s/ℎr)
where

KFactor = frequency "K-Factor" (pulses/m3 or pulses/ft3) (Freq1KFactor and
Freq2KFactor)
InvKFactor = frequency "Inverse K-Factor" (m3/pulse or ft3/pulse) (Freq1InvKFactor and
Freq2InvKFactor
FreqQFullScale = frequency full-scale volumetric flow rate (m3/h or ft3/h)
(Freq1FullScaleVolFlowRate and Freq2FullScaleVolFlowRate)
MaxFreq = maximum frequency (Hz = pulses/s) (Either 1000 or 5000 Hz)
(Freq1MaxFrequency and Freq2MaxFrequency)

B.1.1 Volumetric Flow Rate

Equation B-3: Volumetric Flow Rate - U.S. Customary unitsQft3/hr=Vft/s×3600s/hr ×  πD2in4  ×  1ft12in 2
=Vft/s×D2in ×  3600×π s ft24×122hr in2=Vft/s×D2in×19.63495  s ft2  /  hr in2

where

Qft
3/hr = volumetric flow rate (ft3/h) (QMeter)

Vft/s = gas flow velocity (ft/s) (AvgFlow)
π = geometric constant, pi (dimensionless) (3.14159265...)
Din = pipe inside diameter (in) (PipeDiam)
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Equation B-4: Volumetric Flow Rate - Metric UnitsQm3/hr=Vm/s×3600s/hr ×  πD2m4=Vm/s×D2m×  3600×π4 s/hr=Vm/s×D2m× 20827.433  s/hr
where

Qm3/hr = volumetric flow rate (m3/h) (QMeter)
Vm/s = gas flow velocity(m/s) (AvgFlow)
π = geometric constant, pi (dimensionless) (3.14159265...)
Dm = pipe inside diameter (m) (PipeDiam)

B.2 Calculation of Chord "L" dimension
The chord "L" dimension is calculated from the meter housing length as well as the
transducer pair lengths, mount lengths, holder lengths, and stalk lengths as shown in
Equation B-5. The transducer lengths are etched on the transducers. Likewise, the lengths
of the mounts, stalk assemblies, and transducer holders are also etched on the individual
components. The length of the meter body is found on the original calibration sheet
supplied with the meter.

Equation B-5: Chord "L" DimensionLcℎord = LMeterHousing+ LMount1+ LMount2−LXdrc1− LStalk1− LHldr1−LXdrc2− LStalk2− LHldr
where

Lchord = chord "L" dimension (in) (LA... LD)
LMeterHousing = meter housing length (in)
LMount1 = transducer 1 mount length (in)
LMount2 = transducer 2 mount length (in)
LXdr1 = transducer 1 length (in)
LXdr2 = transducer 2 length (in)
LStalk1 = transducer 1 stalk length (in)
LStalk2 = transducer 2 stalk length (in)
LHldr1 = transducer 1 holder length (in)
LHldr2 = transducer 2 holder length (in)
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C Troubleshooting comm., mech., and
elec.

C.1 Communications troubleshooting
Q1. Why won't the CPU Module LINK LED come on when connecting to the meter via
the Ethernet?

A1. The LINK light indicates good electric connectivity between two LAN ports. It also
indicates proper polarity in the Ethernet connection.

WHEN CONNECTING DIRECTLY: Check to ensure that the Ultrasonic cable (P/N
1-360-01-596) cable is properly connected.

WHEN USING A HUB: When using a hub between the meter and the PC, a straight-through
patch cable is required between the meter and the hub and a straight-through patch cable
is required between the hub and the PC. Do not connect either the meter or PC to the hub
UPLINK port. Most hubs do not allow use of the port immediately next to the hub UPLINK
port when the UPLINK port is used to connect the hub to a LAN. Ensure the meter and PC
are not plugged in to a hub non-usable UPLINK port.

Verify that the meter is powered up by checking that CPU Module LED 1 is on (either solid
red or green). If the LED is not on, check power to the meter. If the LED is on, check the
Ethernet cable connections.

Q2. My CPU Module LINK LED is on but I can't communicate with the meter using
Ethernet. What's wrong?

A2. If you are connecting for the first time, refer to Setup the meter directory for
instructions on initial communication (via Ethernet) setup.

If you are using the MeterLink program, ensure that the optional Ethernet connection is
enabled.

Ensure that the meter's DHCP server is enabled (CPU Module switch OFF). Verify that the
PC has received an IP address from the meter as follows:

• Bring up DOS prompt window (Start|Run|(type)cmd)

• In the DOS prompt window, type ipconfig.

You should then see something like:

Windows IP Configuration

Ethernet adapter Local Area Connection 1:

Connection-specific DNS Suffix:

IP Address:192.168.135.35 (note: the last .35can beup to .44)

Subnet Mask: 255.255.255.0DefaultGateway:

If you get the following:

Ethernet adapterLocal Area Connection 1:
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IP Address: 0.0.0.0

then the PC has not yet receivedan IP address from the DHCP server and you should wait
(up to 30 seconds) to receive an IP address before attempting to connect to the meter. If
after 30 seconds the PC has not received an IP address from the meter DHCP server or the
IP addressshown above (from ipconfig) is different from the range of 192.168.135.35
through 192.168.135.44, verify that the PC is configured to receive its IP address
automatically (via DHCP).

To ensure connection to the meter from the PC, at the DOS prompt type:

ping 192.168.135.100 <enter>

If the meter is reachable, then you will see a message like:

Pinging 192.168.135.100 with 32 bytes of data:

Reply from 192.168.135.100: bytes=32 time < 10ms TTL=64

etc.

If the meter is not reachable, then you will see something like:

Pinging 192.168.135.100 with 32 bytes of data:

Request Timed Out etc.

Q3. How do I connect to multiple meters via Ethernet when they are on the same
LAN?

A3. Before connecting multiple meters via Ethernet on a LAN, each meter must be
configured with a unique user- specified IP address (following the initial communication
quick start instructions in MeterLink utilities). Contact your IT department for valid IP
addresses for your LAN and Gateway address if required. Once a meter's IP address is
configured, the meter may be connected to the intranet LAN and accessed using that IP
address.

3410 Series meters connected to an intranet LAN should not have their DHCP servers
enabled.

Q4. How do I connect to multiple meters via Ethernet when they are on the same hub
but not connected to an intranet LAN?

A4. The PC may receive its IP address from an external DHCP server; in this case, one and
only one meter must have its DHCP server enabled. This DHCP server will serve up to 10 IP
addresses to PCs attempting to talk to all meters on the hub.

Before connecting multiple meters via Ethernet on a hub, each meter must be configured
with a unique user- specified IP address (following the initial communication quick start
instructions in MeterLink utilities). Assign each meter on the hub a unique IP address
withintherange192.168.135.150 through192.168.135.254. The Gateway address for each
meter maybe left unconfigured as 0.0.0.0. Once a meter's IP address is configured, the
meter may be connected to the hub and accessed using that IP address.

C.2 Mechanical/Electrical troubleshooting
This section is meant to assist site maintenance and operations personnel trained in the
operation of the ultrasonic flow meter and knowledgeable in basic mechanical and
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electronic/electrical troubleshooting techniques, using lap top computers as well as digital
volt/ohm meters. Great care should be taken not to "short out" a given electronic/electrical
circuit when Troubleshooting.

Table C-1: Mechanical/Electrical troubleshooting

Problem Solution(s)

No power the unit • Check for correct voltage (AC or DC) to the input of the Field
Connection Board. (See Rosemount™ 3410 Series engineering
drawings, System Wiring Diagram).

• Check the main power source for blown fuse or tripped circuit
breaker. Reference your "as built" installation drawings for your
location.

• Check the fuses on the Field Connection Board. Reference fuse F1 and
F2 locations.

Cannot communicate
with MeterLink™

program

• Ensure that the meter is properly powered.

• Ensure that the computer cable is properly connected to the field
connection board (see Rosemount™ 3410 Series engineering
drawings) for the connector and check your interface pins (RS-485 or
RS-232).

• Verify that the communication parameters of the MeterLink program
are set according to jumpers on the meter CPU board. See MeterLink
utilities of this manual for instructions on configuring
communications.

• Check switch S-1 on the field connection board and ensure that it is in
the correct position (RS-485 or RS-232 communication).

Note
Note that S1 is located at the top left side of the board.

One or more of the
chords is not indicating
a reading (reporting
zeros)

• Check for loose connections at the cable connectors. See
Rosemount™ 3410 Series engineering drawings.

• Check the resistance of the transducers (should be approximately 1-2
Ω).

• Problem also may be caused by a bad Acquisition board or
interconnect cable. See Rosemount™ 3410 Series engineering
drawings for more information.

• Check system status in MeterLink™, Meter → Monitor for any flagged
errors.

• Check the CPU board LEDs.

Waveform contains an
excessive amount of
noise

Increase the StackSize until noise level decreases (settings can be 1
(none), 2, 4, 8, or 16). If increasing the StackSize is not successful, try
turning on the filter or consult with Flow Lifecycle Services for Rosemount
products if you are unsure of how stacking a signal can effect the meter's
operation. Refer to Technical Support under the Help menu of MeterLink
for contact information.
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Table C-1: Mechanical/Electrical troubleshooting (continued)

Problem Solution(s)

Connected
communication line to
the flow computer but
no signal is received

• Check for loose connections at the flow meter and the flow computer
(see Rosemount™ 3410 Series engineering drawings).

• Check the CPU Module, Field Connection board and the Power Supply
wiring. Ensure the terminal block wiring and connectors are making
good contact.

Communicating with
meter but all chords
display failures

• Verify that the resistance of transducers is within Specification (1-2
Ω).

• Check the Acquisition board.

• Check the interconnect cables between the base enclosure and the
transmitter enclosure.

Chord is not indicating • Check the resistance of the failed transducer.

• If Chord A is not indicating, change the transducer cables from Chord
D to chord A

• If Chord D then fails, the transducers are bad on Chord A.

• The same test procedure can be accomplished by swapping Chords B
and C if a chord fails in either chord.

Note
Note that the outside chord cables cannot be exchanged with inner chord
cables.
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D Flow Rate charts

D.1 Summary charts for Flow rate
Table D-1: Flow rate summary charts

Flow Rates (MSCFH) Based upon 100 ft/s

PSIG 4 6 8 10 12 16 20 24 30 36

100 247 561 971 1 532 2 174 3 432 5 398 7 807 12 607 18 154

200 468 1 065 1 845 2 908 4 127 6 515 10 248 14 822 23 935 34 467

300 696 1 584 2 743 4 325 6 137 9 690 15 240 22 043 35 596 51 258

400 931 2 118 3 668 5 782 8 206 12 955 20 377 29 472 47 593 69 534

500 1 172 2 667 4 619 7 282 10 334 16 315 25 661 37 114 59 934 86 305

600 1 421 3 232 5 597 8 823 12 522 19 770 31 095 44 973 72 626 104 582

700 1 676 3 813 6 602 10 409 14 772 23 322 36 682 53 055 85 677 123 374

800 1 938 4 409 7 635 12 036 17 082 26 968 42 417 61 349 99 070 142 661

900 2 207 5 021 8 694 13 706 19 452 30 710 48 302 69 861 112 816 162 455

1000 2 482 5 646 9 777 15 414 21 875 31 536 54 320 78 565 126 872 182 696

1100 2 763 6 286 10 885 17 161 24 355 38 451 60 475 87 471 141 254 203 405

1200 3 050 6 939 12 015 18 943 26 883 42 443 66 756 96 551 155 917 224 521

1300 3 341 7 602 13 164 20 753 29 453 46 500 73 137 105 781 170 822 245 983

1400 3 637 8 274 14 327 22 587 32 055 50 608 79 599 115 127 185 915 267 718

1500 3 935 8 953 15 504 24 442 34 688 54 765 89 137 124 583 201 184 289 706

1600 4 235 9 635 16 685 26 305 37 331 58 938 93 700 134 076 216 515 311 781

1700 4 536 10 231 17 871 28 175 39 986 63 128 99 291 143 608 231 908 333 948

1800 4 839 11 002 19 052 30 036 42 627 67 298 105 850 153 094 247 227 356 006

1900 5 134 11 681 20 226 31 888 45 255 71 448 112 376 162 534 262 471 377 958

2000 5 429 12 350 21 386 33 716 47 849 75 543 118 818 171 851 277 516 399 623

Flow Rates (MSCFH) Based upon 30 M/s

kPag 4 6 8 10 12 16 20 24 30 36

1000 9.67 22.01 38.11 60.07 85.27 134.6 211.7 306.2 494.5 712.1

1500 14.22 32.34 56.00 88.27 125.3 197.8 311.1 450.0 726.7 1046

2000 18.85 42.89 74.28 117.1 166.2 262.4 412.7 596.9 963.9 1388

2500 23.59 53.67 92.94 146.5 207.9 328.3 516.4 746.9 1206 1737

3000 28.43 64.68 112.0 176.5 250.6 392.6 622.3 900.0 1453 2093
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Flow Rates (MSCFH) Based upon 30 M/s

3500 33.37 75.92 131.5 207.2 294.1 464.4 730.4 1056 1706 2457

4000 38.41 87.39 151.3 238.5 338.6 534.6 840.8 1216 1964 2828

4500 43.56 99.10 171.6 270.5 384.0 606.2 953.5 1379 2227 3207

5000 48.81 111.1 192.3 303.1 430.3 679.3 1068 1545 2495 3593

5500 54.17 123.2 213.4 336.4 477.4 753.8 1186 1715 2796 3987

6000 59.62 135.6 234.9 370.2 252.5 829.7 1305 1887 3048 4389

6500 65.17 148.3 256.8 404.7 574.5 907.0 1427 2063 3332 4798

7000 70.82 161.1 279.0 439.8 624.3 985.6 1550 2242 3621 5214

7500 76.56 174.2 301.6 475.4 674.8 1065 1676 2424 3914 5636

8000 82.38 187.4 324.6 511.6 726.2 1146 1803 2608 4212 6065

8500 88.28 200.9 347.8 548.2 778.2 1229 1932 2795 4513 6499

9000 94.25 214.4 271.3 585.3 830.9 1312 2063 2984 4818 6939

9500 100.28 228.1 395.1 622.7 883.9 1396 219 3175 5127 7382

1000
0

106.36 242.0 419.0 660.4 937.5 1480 2328 3367 5437 7830

Flow Rates (MMSCFD) Based upon 100 ft/s

PSIG 4 6 8 10 12 16 20 24 30 36

100 5.9 13.5 23.3 36.8 52.2 82.4 129.5 187.4 302.6 435.7

200 11.3 25.6 44.3 69.8 99.0 156.4 245.9 355.7 574.4 827.2

300 16.8 38.0 65.8 103.8 147.3 232.6 365.8 529.0 854.3 1 230

400 22.4 50.8 88.0 138.8 196.9 310.9 489.0 707.3 1 142 1 645

500 28.2 64.0 110.8 174.8 248.0 391.6 615.9 890.7 1 438 2 071

600 34.2 77.6 134.3 211.8 300.5 474.5 746.3 1 079 1 743 2 510

700 40.3 91.5 158.5 29.8 354.5 559.7 880.4 1 273 2 056 2 961

800 46.6 105.8 183.2 288.9 410.0 647.2 1 018 1 472 2 378 3 424

900 53.1 120.5 208.7 328.9 466.8 737.0 1 159 1 677 2 708 3 899

1000 59.7 135.5 234.6 369.9 252.0 828.9 1 304 1 886 3 045 4 385

1100 66.5 150.9 261.2 411.9 584.5 922.8 1 451 2 099 3 390 4 882

1200 73.4 166.5 288.4 454.6 645.2 1 019 1 602 2 317 3 742 5 389

1300 80.4 182.4 315.9 498.1 706.9 1 116 1 755 2 539 4 100 5 904

1400 87.5 198.6 343.8 542.1 769.3 1 215 1 910 2 763 4 462 6 425

1500 94.7 214.9 372.1 586.6 832.5 1 314 2 067 2 990 4 828 6 953

1600 101.9 231.3 400.4 631.3 896.0 1 415 2 225 3 218 5 196 7 483

1700 109.1 247.7 428.9 676.2 959.7 1 515 2 383 3 447 5 566 8 015
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Flow Rates (MMSCFD) Based upon 100 ft/s

1800 116.4 264.0 457.2 720.9 1 023 1 615 2 540 3 674 5 933 8 544

1900 126.5 280.3 485.4 765.3 1 086 1 715 2 697 3 901 6 299 9 071

2000 130.6 296.4 513.3 809.2 1 148 1 813 2 852 4 142 6 660 9 591

Flow Rates (MMSCMD) Based upon 30 M/s

kPag 4 6 8 10 12 16 20 24 30 36

1000 0.232 0.528 0.915 1.442 2.046 3.231 5.082 7.350 11.869 17.091

1500 0.341 0.776 1.344 2.119 3.007 4.748 7.468 10.801 17.441 25.116

2000 0.453 1.029 1.783 2.810 3.989 6.297 9.904 14.325 23.133 33.311

2500 0.566 1.288 2.231 3.516 4.991 7.879 12.393 17.924 28.946 41.682

3000 0.682 1.552 2.688 4.237 6.014 9.495 14.935 21.600 34.882 50.230

3500 0.801 1.821 3.155 4.973 7.059 11.145 17.530 25.354 40.943 58.958

4000 0.922 2.097 3.632 5.725 8.126 12.830 20.179 29.186 47.131 67.869

4500 1.045 2.378 4.119 6.492 9.215 14.549 22.883 33.097 53.447 76.963

5000 1.171 2.664 4.615 7.239 10.326 16.302 25.641
8.0911

37.086 59.889 86.240

5500 1.300 2.957 5.121 7.789 11.459 18.091 28.454 41.154 66.458 95.699

6000 1.431 3.254 5.637 8.347 12.612 19.912 31.319 45.298 73.150 105.33
6

6500 1.564 3.557 6.162 9.713 13.787 21.767 34.236 49.517 79.964 115.14
8

7000 1.700 3.866 6.696 10.555 14.982 23.653 37.203 53.808 86.893 125.12
6

7500 1.837 4.179 7.239 11.410 16.196 25.570 40.218 58.168 93.934 135.26
5

8000 1.977 4.497 7.789 12.278 17.428 27.515 43.277 62.592 101.07
8

145.55
3

8500 2.119 4.819 8.347 13.157 18.676 29.485 46.376 67.075 108.31
8

155.97
8

9000 2.262 5.145 8.912 14.047 19.939 31.479 49.512 71.611 115.64
2

166.52
4

9500 2.407 5.474 9.482 14.945 21.214 33.492 52.679 76.191 123.03
8

177.17
5

10000 2.553 5.805 10.056 15.851 22.500 35.522 55.871 80.808 130.49
4

187.91
1
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E Write-protected configuration

E.1 Parameters for Write-protected configuration
This appendix contains a table of configuration parameters that are write-protected
against changes when the CPU Board WRITE PROT. switch is in the ON position. The data
points in Table E-1 are applicable for firmware v1.06 and later.

Table E-1: Write-protected configuration parameters

Write-protected configuration parameters

AbnormalProfileDetectionLmt

Address

AlarmDef

AO1ActionUponInvalidContent

AO1Content

AO1Dir

AO1FullScaleEnergyRate

AO1FullScaleMassRate

AO1FullScaleVolFlowRate

AO1MaxVel

AO1MinVel

AO1TrimCurrent

AO1TrimGainExtMeasCurrent

AO1TrimZeroExtMeasCurrent

AO2ActionUponInvalidContent

AO2Content

AO2Dir

AO2FullScaleEnergyRate

AO2FullScaleMassRate

AO2FullScaleVolFlowRate

AO2MaxVel

AO2MinVel

AO2TrimCurrent

AO2TrimGainExtMeasCurrent

AO2TrimZeroExtMeasCurrent

AtmosphericPress
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Table E-1: Write-protected configuration parameters (continued)

Write-protected configuration parameters

AvgDlyA

AvgDlyB

AvgDlyC

AvgDlyD

AvgSoundVelHiLmt

AvgSoundVelLoLmt

BatchSize

BlockageTurbulenceLmtA

BlockageTurbulenceLmtB

BlockageTurbulenceLmtC

BlockageTurbulenceLmtD

CalMethod

ChordInactvA

ChordInactvB

ChordInactvC

ChordInactvD

City

ColocMeterMode

ContractHour

CRange

DeviceNumber

DI1IsInvPolarity

DitherEnable

DltChk

DltDlyA

DltDlyB

DltDlyC

DltDlyD

DO1AContent

DO1AIsInvPolarity

DO1BContent

DO1BIsInvPolarity

DO2AContent
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Table E-1: Write-protected configuration parameters (continued)

Write-protected configuration parameters

DO2AIsInvPolarity

DO2BContent

DO2BIsInvPolarity

EmRateDesired

EnableExpCorrPress

EnableExpCorrTemp

EnablePressureInput

EnableTemperatureInput

FireSeq

FlowAnalysisHighFlowLmt

FlowAnalysisLowFlowLmt

FlowDir

FlowPOrTSrcUponAlarm

FODO1Mode

FODO1Source

FODO2Mode

FODO2Source

FODO3Mode

FODO3Source

FODO4Mode

FODO4Source

FODO5Mode

FODO5Source

FODO6Mode

FODO6Source

Freq1BPhase

Freq1Content

Freq1Dir

Freq1FeedbackCorrectionPcnt

Freq1FullScaleEnergyRate

Freq1FullScaleMassRate

Freq1FullScaleVolFlowRate

Freq1MaxFrequency
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Table E-1: Write-protected configuration parameters (continued)

Write-protected configuration parameters

Freq1MaxVel

Freq1MinVel

Freq2BPhase

Freq2Content

Freq2Dir

Freq2FeedbackCorrectionPcnt

Freq2FullScaleEnergyRate

Freq2FullScaleMassRate

Freq2FullScaleVolFlowRate

Freq2MaxFrequency

Freq2MaxVel

Freq2MinVel

FwdA0

FwdA1

FwdA2

FwdA3

FwdBaselineAvgFlow

FwdBaselineComment

FwdBaselineCrossFlow

FwdBaselineFlowPressure

FwdBaselineFlowTemperature

FwdBaselineProfileFactor

FwdBaselineSwirlAngle

FwdBaselineSymmetry

FwdBaselineTime

FwdBaselineTurbulenceA

FwdBaselineTurbulenceB

FwdBaselineTurbulenceC

FwdBaselineTurbulenceD

FwdC0

FwdC1

FwdC2

FwdC3
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Table E-1: Write-protected configuration parameters (continued)

Write-protected configuration parameters

FwdFlwRt<1..12>

FwdMtrFctr<1..12>

GasPropertiesSrcSel

GasPropertiesSrcSelGCAlarm

GCBaud

GCCommTimeout

GCDesiredStreamTimeout

GCHeatingValueType

GCHeatingValueUnit

GCModbusID

GCProtocol

GCSerialPort

GCStreamNumber

HCH_Method

HighPressureAlarm

HighTemperatureAlarm

InputPressureUnit

IsC6PlusAutoDetectionEnabled

IsDiagnosticChordEnabled

IsFreq1BZeroedOnErr

IsFreq2BZeroedOnErr

IsGasCompositionValidationEnabled

IsoButaneComponentIndex

IsoPentaneComponentIndex

LA

LB

LC

LD

LinearExpansionCoef

LiquidDetectionSDevCrossFlowLmt

LiquidDetectionSDevProfileFactorLmt

LiquidDetectionSDevSymmetryLmt

LiveFlowPressureGain
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Table E-1: Write-protected configuration parameters (continued)

Write-protected configuration parameters

LiveFlowPressureOffset

LiveFlowTemperatureGain

LiveFlowTemperatureOffset

LowFlowLmt

LowPressureAlarm

LowTemperatureAlarm

MaxHoldTm

MaxInputPressure

MaxInputTemperature

MaxNoDataBatches

MaxNoise

MeterHousingLength<A..D>

MeterMaxVel

MeterName

MeterSerialNumber

MinChord

MinHoldTime

MinInputPressure

MinInputTemperature

MinPctGood

MinSigQlty

N2ComponentIndex

NegSpan

NonNormalModeTimeout

NPentaneComponentIndex

NumVals

PBase

PipeDiam

PipeOutsideDiameter

Pk1Pct

Pk1Thrsh

Pk1Wdth

PoissonsRatio

Write-protected configuration Operations Manual
April 2022  00809-1100-3104

166 Emerson.com/Rosemount



Table E-1: Write-protected configuration parameters (continued)

Write-protected configuration parameters

PosSpan

RefPressExpCoef

RefPressureGr

RefPressureMolarDensity

RefTemperatureGr

RefTemperatureHV

RefTemperatureMolarDensity

RefTempLinearExpCoef

RevA0

RevA1

RevA2

RevA3

RevBaselineAvgFlow

RevBaselineComment

RevBaselineCrossFlow

RevBaselineFlowPressure

RevBaselineFlowTemperature

RevBaselineProfileFactor

RevBaselineSwirlAngle

RevBaselineSymmetry

RevBaselineTime

RevBaselineTurbulenceA

RevBaselineTurbulenceB

RevBaselineTurbulenceC

RevBaselineTurbulenceD

RevC0

RevC1

RevC2

RevC3

ReverseFlowDetectionZeroCut

ReverseFlowVolLmt

RevFlwRt<1..12>

RevMtrFctr<1..12>
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Table E-1: Write-protected configuration parameters (continued)

Write-protected configuration parameters

SampInterval

SampPerCycle

SndSpdChkMaxVel

SndSpdChkMinVel

SndVelCompErrLimit

SNRatio

SpecBatchUpdtPeriod

SSMax

SSMin

StackEmRateDesired

StateAndCountry

StationName

Tamp

TampHi

TampLo

TampSen

TampWt

TBase

TmDevFctr1

TmDevLow1

Tspe

TspeHi

TspeLmt

TspeLo

TspeSen

TspeWt

Tspf

TspfHi

TspfLo

TspfMatch

TspfSen

TspfWt

UnitsSystem
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Table E-1: Write-protected configuration parameters (continued)

Write-protected configuration parameters

VelHold

VolFlowRateTimeUnit

VolUnitMetric

VolUnitUS

WallRoughness

XA

XB

XC

XD

XdcrAssyComponent1Length<A1..D2>

XdcrAssyComponent1SerialNumber<A1..D2>

XdcrAssyComponent2Length<A1..D2>

XdcrAssyComponent2SerialNumber<A1..D2>

XdcrAssyComponent3Length<A1..D2>

XdcrAssyComponent3SerialNumber<A1..D2>

XdcrAssyComponent4Length<A1..D2>

XdcrAssyComponent4SerialNumber<A1..D2>

XdcrFiringSync

XdcrFreq

XdcrNumDriveCycles

YoungsModulus

ZeroCut
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F Engineering drawings

F.1 Rosemount™ 3410 Series engineering drawings
This appendix contains the following engineering drawing(s) for the ultrasonic meter.

DMC-005324 3410 Series Gas Ultrasonic Flow Meters System
Wiring Diagram
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